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1 Introduction

Decision Support System Extracts (DSS) Version 3.0 provides a means of exporting data from
selected Veterans Health Information Systems and Technology Architecture (VistA) modules to
a Decision Support System (DSS) resident in the Department of Veterans Affairs (VA) Austin
Information Technology Center (AITC).

This transfer is accomplished through a set of extract routines, intermediate files, audit reports, a
transmission routine, and a purge routine. Data from VistA packages is stored by the extract
routines in the intermediate files, where it is temporarily available for local use and auditing. The
data is then transmitted to the AITC where it is formatted and uploaded into commercial
software. After the data has been successfully uploaded into the commercial software, it is
purged from the intermediate files.

The DSS Extracts software includes the following functionalities:
e DSS Extract field additions and modifications
e DSS Menu additions, modifications and deletions
e New DSS reports and report modifications
e Implementation of the new and/or deleted extracts

1.1 Related DSS Manuals

Listed below are the following DSS Extract manuals that are available to view on the VA
Software Document Library at the following address
http://www.va.gov/vdl/application.asp?appid=35

File Name Manual Name Description
DSS 3 FY2014 DD DSS Extracts V3.0 Data Provides detailed information on formatting
Definitions Guide and defines the data terminology.
DSS 3 FY2014 TM DSS Extract FY2014 Technical Describes the DSS Extract technical (high
Manual level) terminology
DSS 3 FY2014 UM DSS Extracts V3.0 Extracts User | Provides an overview of the functionality
Manual and enhancements.

The DSS web site is located at the following address: http://vaww.dss.med.va.gov/.
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2 Orientation
2.1 Components of this User Manual

The “Using the Software -Extract Manager’s Menu” section of this manual is designed to serve
as reference to the user, covering vital aspects of this tool. It is broken into five components.

e Maintenance

e Package Extracts

e SAS Extract Audit Reports
e Extract Audit Reports

e Transmission Management

2.2 User Responses

In this manual, user responses are shown in bold type. In most cases, you need only enter the first
few letters to increase speed and accuracy. Press the Return or Enter key (which is indicated by
the symbol <RET>) after each response. This symbol is not shown, but is implied, following
bold type entries.

Enter a caret, indicated by the symbol (©), at almost any prompt to terminate the line of
questioning and return to the previous level in the routine. Continue entering up-arrows (carets)
to exit the system.

2.3 Online Help

Online help is available at almost any prompt in the software by entering a single question mark
(?). This will provide information to help the user answer the prompt. In some instances, entering
double (??) or triple (???) question marks will provide more detailed information.
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3 Before You Start Using the Software
3.1 Setup Required DSS Information

Use the options in the submenus of the Maintenance submenu of the Extract Manager's Options
menu listed below to setup information required for using the DSS Extracts software. Refer to
the section titled "Using the Software - Extract Manager's Options" for information about using
the options. Refer to the DSS Extracts Version 3.0 Installation Guide for information about
installing and implementing the software.

e Setup for DSS Clinic Information

e Setup for DSS Lab Results Information

e Setup for Inpatient Medications Information
e Setup for Inpatient Census Information

3.2 Setup QUASAR

If your facility uses the Quality: Audiology and Speech Pathology Audit & Review (QUASAR)
Version 2.0 software, and you wish to send Audiology and Speech Pathology data to DSS, take
the following steps:

1. The DSS Site Manager, in conjunction with the Event Capture and QUASAR ADPACS,
should use the Event Capture option DSS Units for Event Capture (Enter/Edit) to create
two entries in the DSS UNIT file (#724). These two entries are to be used exclusively for
the QUASAR/DSS extract. One entry should be created for Audiology (e.g., Audiology
DSS Extract), the other for Speech Pathology (e.g., Speech Pathology DSS Extract) as
shown in the following example.

Example: Entries Made for QUASAR

Select Event Capture Management Menu Option: DSS Units for Event
Capture (Enter/Edit)

Select DSS Unit: AUDIOLOGY DSS EXTRACT

Are you adding "AUDIOLOGY DSS EXTRACT®" as a new DSS UNIT
(the 54TH)? YES
DSS UNIT Service: AUDIOLOGY AND SPEECH PATHOLOGY
DSS UNIT Cost Center: 822800 Audiology & Speech Pathology
DSS UNIT Medical Specialty: AUDIOLOGY

DSS UNIT Number: <RET>

ASSOCIATED STOP CODE: 203

CATEGORY (Y/N): NO

DATA ENTRY DATE/TIME DEFAULT: <RET>

Select DSS Unit: SPEECH PATHOLOGY DSS EXTRACT

Are you adding "SPEECH PATHOLOGY DSS EXTRACT®" as a new DSS UNIT (the 55TH)? YES
DSS UNIT Service: AUDIOLOGY AND SPEECH PATHOLOGY
DSS UNIT Medical Specialty: SPEECH PATHOLOGY
DSS UNIT Number: <RET>

October 2013 Decision Support System V. 3.0 User Manual 3
Patch ECX*3.0%¥144



ASSOCIATED STOP CODE: 204
CATEGORY (Y/N): NO
DATA ENTRY DATE/TIME DEFAULT: <RET>

2. Inthe above process, the Event Capture software automatically answers YES to the USE
FOR EVENT CAPTURE field in the DSS UNIT file (#724). Use the VA FileMan Enter
or Edit File Entries option to change the answer to NO for the USE FOR EVENT
CAPTURE field for the two entries created in Step 1 above.

3. The QUASAR ADPAC, coordinating with the DSS Site Manager, should use the
QUASAR option A&SP Site Parameters [ACKQAS SITE PARAMS] to enter data for
the following two new fields in the A&SP SITE PARAMETER file (#509850.8) as
shown in the example below.

AUDIOLOGY DSS UNIT LINK field — Answer with the Audiology DSS Unit created in
Step 1 above.

SPEECH PATHOLOGY DSS UNIT LINK field — Answer with the Speech Pathology
DSS Unit created in Step 1 above.

Example: Setup/Maintenance on A&SP Supervisor Menu

Select A&SP Supervisor Menu Option: SET Up/Maintenance

Select Set Up/Maintenance Option: A&SP Site Parameters
This option allows you to configure the QUASAR package to meet
facility needs.

Select A&SP SITE PARAMETERS SITE NAME: [Select your site name.]
SITE NAME: [Your site name is here.]// <RET>
USE ASP CLINIC FILE NUMBER: NO// <RET>
USE MODIFIERS: NO// <RET>
USE C&P: YES// <RET>
BYPASS AUDIOMETRICS: YES// <RET>
Select CLINIC LOCATION: SPEECH PATHOLOGY // <RET>
CLINIC LOCATION: SPEECH PATHOLOGY // <RET>
Select CLINIC LOCATION: <RET>
AUDIOLOGY DSS UNIT LINK: ?
Enter the name of the DSS unit to be used for audiology.-
AUDIOLOGY DSS UNIT LINK: AUDIOLOGY DSS EXTRACT
SPEECH PATHOLOGY DSS UNIT LINK: ?
Enter the name of the DSS unit to be used for
speech pathology
SPEECH PATHOLOGY DSS UNIT LINK: SPEECH PATHOLOGY DSS EXTRACT
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4  Using the Software - Extract Manager’s Menu
4.1 The Security Keys Structure

This KEY functionality is a function of the Kernel's Key Management functions. These simple
adjustments make it possible to assign the [ECXMGR] Extract Manager's Options to a user so
that they can view all DSS reporting functionality with the assignment of a single option. The
security key then controls only those options that actually create/change data and as such should
not be available to all DSS employees.

The ECXMGR key has been removed from the following menus:
[ECX MAINTENANCE] Maintenance
[ECX TRANSMISSION] Transmission Management

The ECXMGR key has been assigned to the following menus:

[ECXSCLOAD] Create DSS Clinic Stop Code File

[ECXSCEDIT] Enter/Edit DSS Stop Codes for Clinics

[ECXSCAPPROV] Approve Reviewed DSS Clinic Worksheet

[ECX IV DIV EDIT] Enter/Edit IV Room Division

[ECX LAB RESULTS TRANS EDIT] Add/Edit Lab Results Translation Table

[ECXLABRS] Link DSS Selected Lab Tests to Local Lab
Tests

The ECXPVE key has been assigned to the following menu:
[ECX PHA VOL EDIT] Pharmacy Volume Edit

The ECX DSS TEST Security Key has been assigned for the following option:
[ECX FISCAL YEAR EXTRACT] Fiscal Year Logic — DSS Testing Only

4.2 Logon /Accessing DSS Options

Depending on your setup and permissions, you may have a short cut to the DSS menu.
This is one method for reaching the DSS Menu:

1. Logon to VistA.

2. On the Systems Manager Menu, select option: Core Applications

3. On the Core Applications Menu, select option: Administrative Services Menus

4. On the Administrative Services Menus, select option: Extract Manager's Options
View the choices that are on the Extract Manager’s Menu and select an option.
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4.3 Maintenance — Extract Manager’s Menu

The Extract Manager’s Menu [ECXMGR] is the main menu for the DSS. The options listed can
vary based on the user’s Security Keys settings, as described above.

Each option expands to a sub-menu giving detailed options for that area.

The remainder of this manual is organized according to the options shown on this menu and its
sub-menus.

Example: Extract Manager’s Menu

Maintenance

Package Extracts

SAS Extract Audit Reports
Extract Audit Reports Menu
Transmission Management

AmwnIT=z

4.3.1. Maintenance Menu

Choosing the Maintenance option from the Extract Managers Menu will display the following
menu and options. Many of these will then display sub-menus and additional options.

Example: Maintenance Menu Options

Select Extract Manager®s Options Option: M Maintenance

CBOC Activity Report
CPT Inquiry
DSS Department Management
Event capture
Laboratory
Nutrition Worksheets
Pharmacy
Print Feeder Keys
Print Feeder Locations
10 Prosthetics
11 Setup for DSS Clinic Information
12 Setup for DSS Lab Results Information
**> Out of Order: MENU OPTION NO LONGER USED
13 Setup for Inpatient Census Information
14 Setup for Inpatient Medications Information
15 Surgery

OCO~NOURWNE
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4.3.1.1. CBOC Activity Report

This report includes information from every Clinical (CLI) record (by extract #) which has a
Community Based Outpatient Clinic (CBOC) status of YES. The report is grouped by feeder key,
division, and clinic. It lists Patient Name, Social Security Number (SSN) and Date of Visit.
Totals for unique SSNs and Visits will be printed with each clinic, division, and feeder key with
an overall total for the station.

When purging a CLI extract, a check will be made to determine if the CBOC activity report has
been run. If the report has not been run, the user will be told that the report has not been run and
asked if they still wish to purge the data. If the report has been run, no additional prompts will be
seen.

Example: CBOC Activity Report

Selectable Clinic Extracts for CBOC Activity Report Page: 1

Extract # Run Date Rec Count Date Range of Extract Division
1863 03/20/2003 10065 01/01/2003 - 01/31/2003 442
1881 04/03/2003 9519 02/01/2003 - 02/28/2003 442
1899 04/23/2003 9444 03/01/2003 - 03/31/2003 442
1917 08/04/2003 9546 03/01/2003 - 03/31/2003 442

Generate the CBOC Activity Report for the following extract: (1863-2104): 2104

CBOC Activity Report Page: 001
MAR 01, 2002 — MAR 31, 2002 Run Date: NOV 26, 2002
Feeder Key: ##tHHt#tp##  Division: ###astt  Clinic: TR
Patient SSN VISIT DATE/TIME
DSSPATIENT,ONE 000456789 OCT 12, 2002 @ 10:30:01
DSSPATIENT, TWO 666456789 OCT 14, 2002 @ 10:30:01
DSSPATIENT, THREE 666543009 OCT 12, 2002 @ 10:30:01
DSSPATIENT, FOUR 000768777 OCT 14, 2002 @ 10:30:01
Total Unique for Clinic: 3 4

Total Unique for Division: ####Hs  #spss# <- When applicable
Total Unique for Feeder Key: ##HH##H#H###HE HiHHHHH#H##H <- When applicable
Total Unique (entire report): #H#HH#H#HHHIH  #HiHHH#H##HH  <- At end of report
<** Form feed on clinic, division, and feeder key **>
Use division number not name (ex: 528AB)
Truncate clinic name to 20 characters
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4.3.1.2. CPT Inquiry

This inquiry allows the user to select a CPT code. It then displays the Short Name, Category, and
Description for the selected code.

Example: CPT Inquiry
Select CPT: ??

Choose from:

10000 DRAINAGE OF SKIN LESION INACTIVE CODE
10001 DRAINAGE OF 2ND SKIN LESION INACTIVE CODE
10002 DRAINAGE OF SKIN LESIONS INACTIVE CODE
10003 DRAIN & TREAT SKIN LESION INACTIVE CODE
10020 DRAINAGE OF BOIL INACTIVE CODE
10021 FNA W/0 IMAGE
10022 FNA W/ IMAGE
10040 ACNE SURGERY
10060 DRAINAGE OF SKIN ABSCESS
10061 DRAINAGE OF SKIN ABSCESS
10080 DRAINAGE OF PILONIDAL CYST
10081 DRAINAGE OF PILONIDAL CYST
10100 DRAINAGE OF INFECTED NAIL INACTIVE CODE
10101 DRAINAGE OF INFECTED NAIL(S) INACTIVE CODE
10120 REMOVE FOREIGN BODY
10121 REMOVE FOREIGN BODY
10140 DRAINAGE OF HEMATOMA/FLUID
10141 DRAINAGE OF HEMATOMA INACTIVE CODE
10160 PUNCTURE DRAINAGE OF LESION
Select CPT: 10160 PUNCTURE DRAINAGE OF LESION
CPT Inquiry Date: OCT 07, 2003
CPT Code: 10160 Short Name: PUNCTURE DRAINAGE OF LESION

Category: INTEGUMENTARY SYSTEM
Description: PUNCTURE ASPIRATION OF ABSCESS, HEMATOMA, BULLA, OR CYST

4.3.1.3. DSS Department Management

Choosing the DSS Department Management option from the Maintenance Menu will display the
following sub-menu and options.

Example: DSS Department Management Menu

Select DSS Department Management Option: ?
Enter/Edit DSS Ward
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4.3.1.3.1 Enter/Edit DSS Ward

This option should only be used by the DSS Site Manager.

Use this option to enter or edit the DSS Department for Ward and suffix, if needed, associated
with each medical center ward within your division. If the ward you selected exists in the DSS
WARD file (#727.4), the DSS Department Code is displayed and the software asks if you want
to edit it. If the ward you selected does not exist in the DSS WARD file (#727.4), the software
prompts you to enter a DSS Department for Ward and suffix to complete the DSS Department
Code. The suffix must have at least one character, no more than three characters and must not
contain an embedded up-arrow. The hyphen character < - > should not be used unless this DSS
Department code was previously established in DSS/Austin. After you enter or edit information,
the new DSS Department code is displayed and you are asked to verify its accuracy.

Example: DSS Department Management

Select WARD LOCATION NAME: C MEDICINE
Ward: C MEDICINE

Ward Bedsection: MEDICINE

Ward Specialty: GENERAL (ACUTE MEDICINE)
Ward Service: MEDICINE

Division: CHEYENNE VAMROC/442
DSS Department for Ward:

43.1.4 Event Capture

43.1.4.1 Unusual Volume Report for Event Capture

The Unusual Volume Report for Event Capture is a tool used by managers to validate the EC
volume data similar to the use of the Surgery or Pharmacy Unusual VVolume Report. It can be
used to identify - volumes above a user selectable threshold, thus avoiding tedious work by the
user. The report should be run prior to information being sent to the DSS database.

The example listed below depicts an example of a report when run for all DSS Units:

Example: Unusual Volume Report for All DSS Units

Select Maintenance Option: Event Capture

Unusual Volume Report for Event Capture

Select Event Capture Option: Unusual Volume Report for Event Capture
ECS Extract Unusual Volume Report

This report prints a listing of unusual volumes that would be
generated by the Event Capture extract (ECS) as determined by

a user-defined threshold value. It should be run prior to

the generation of an actual extract to identify and fix, as
necessary, any volumes determined to be erroneous.

Unusual volumes are those in excess of the threshold value
defined by the user. The threshold value is 20 by default.
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Note: You may set a different threshold if you opt to continue.

Run times will vary depending upon the size of the EVENT CAPTURE
PATIENT file (#721) and the date range selected, but may be at
least several minutes. Queuing to a printer is recommended.

The running of this report has no effect on the actual extracts
and can be run as needed.

You may select one or all DSS Units. |If you select one unit,

the report is sorted by descending volume. If you select all DSS
Units, the report is sorted by DSS Unit, then by descending volume.
Enter RETURN to continue or "~ to exit: <RET>

The default threshold volume for unusual volumes in Event Capture is 20.
Would you like to change the threshold? NO// <RET>

Do you want ALL DSS UNITs? YES//<RET>

Enter the date range for which you would like to scan the
Event Capture records.

Starting with Date: 6/1/10 (JUN 01, 2010)
Ending with Date: 6/30/10 (JUN 30, 2010)

This report is formatted for 132-column line width.

Enter "Q" to queue report to TaskManager, then select printer.
DEVICE: HOME//

Example: CS Extract Unusual Volume Report

CS Extract Unusual Volume Report Page: 1
Start Date: JUN 01, 2010

Report Run Date: SEP 14, 2010

End Date: JUN 05, 2010

Threshold Value: 20

SSN FACILITY DSS UNIT DATE/TIME PROCEDURE =~ VOLUME PROVIDER
XXXXXXXXX 442  AU61 Chronic Hmls HCHV 6/5/2010@16:57 HMOO2N 28 Provider,One
XXXXXXXXX 442  AU61 Chronic Hmls HCHV 6/5/2010@16:57 HMOO2N 28 Provider,One
XXXXXXXXX 442  AU61 Chronic Hmls HCHV 6/5/2010@16:57 HMOO2N 28 Provider,One
XXXXXXXXX 442  AU61 Chronic Hmls HCHV 6/5/2010@16:57 HMOO2N 28 Provider,One
XXXXXXXXX 442  AU61 Chronic Hmls HCHV 6/5/2010@16:57 HMOO2N 28 Provider,One
XXXXXXXXX 442  AUB1 CHYSNH 6/28/2010@10:00 SNOOIN 28 Provider,Two
XXXXXXXXX 442  AUB1 CHYSNH 6/28/2010@10:00 SNOOIN 28 Provider,Two

The following example listed below depicts an example of a report when run for a single DSS
Units.
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Example: Event Capture Report for a Single DSS Unit

The default threshold volume for unusual volumes in Event Capture is 20.
Would you like to change the threshold? NO// <RET>

Do you want ALL DSS UNITs? NO

Select DSS UNIT NAME: AU

1 AuU41l Alc/Drug Halfway Au41

2 AU61 Chronic Hmls HCHV AU61

3  AUA1 CHYCNH AUAL

4  AUB1 CHYSNH AUB1

5 AUC1 CHYSD AUC1
CHOOSE 1-5: 4 AUB1 CHYSNH AUB1

Starting with Date: 6/1/2010 (JUN 01, 2010)
Ending with Date: 6/30/2010 (JUN 30, 2010)

Example: ECS Extract Unusual Volume Report

ECS Extract Unusual Volume Report Page: 1
Start Date: JUN 01, 2010

Report Run Date: SEP 14, 2010

End Date: JUN 30, 2010

Threshold Value: 20

SSN FACILITY DSS UNIT DATE/TIME PROCEDURE VOLUME PROVIDER

XXXXXXXXX 442 AUB1 CHYSNH 6/28/2010010:00 SNOO1IN 28 Provider,Two
XXXXXXXXX 442 AUB1 CHYSNH 6/28/2010010:00 SNOO1IN 28 Provider,Two
XXXXXXXXX 442 AUB1 CHYSNH 6/28/2010010:00 SNOOIN 28 Provider,Two
XXXXXXXXX 442 AUB1 CHYSNH 6/28/2010010:00 SNOO1IN 28 Provider,Two

4.3.1.5 Laboratory

Choosing the Laboratory option from the Maintenance Menu will display the following sub-
menu and options.

Example: Laboratory Menu Options

Select Laboratory Option: ?

1 Add/Edit Lab Results Translation Table

2 Lab Results Extract Untranslatable Results Report

3 Lab Results LOINC Code Report
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43.1.5.1 Add/Edit Lab Results Translation Table

This option allows the editing of existing entries or the addition of new entries in the LAB
RESULTS TRANSLATION file (#727.7). Free text results (non-numeric) are stored in this file
with their corresponding translation codes.

See Appendix B for further information, if necessary.

Example: Add/Edit Results Transition Table

Select Maintenance Option: Add/Edit Lab Results Translation Table
ADD/EDIT LAB RESULTS TRANSLATION TABLE

This option allows the editing of existing entries or the addition of new
entries in the LAB RESULTS TRANSLATION file (#727.7). Free text results(non-numeric)
are stored in this Ffile with their corresponding translation codes

Select LAB RESULTS TRANSLATION: ?

Answer with LAB RESULTS TRANSLATION, or NUMBER

Do you want the entire 65-Entry LAB RESULTS TRANSLATION List? Y (Yes)
Choose from:

1 NEG

2 POS

3 N

4 POSITIVE

5 NE

6 P

7 NEGATIV

8 NEGATIVE

9 NEG.

10 ND

11 NEG#

12 NONREACT

13 NR

14 NRE

15 NONREATIVE

16 NONREACTIVE

17 NON REAC

18 NOTDET

19 NON-REACT

20 POS#

21 POS.

22 WK.POS

23 R

24 REAC

25 REACT

26 REACTIVE

27 REACTIVE*

28 WK.POS.

29 WK POS

30 DETEC

31 DETECTED.

32 EQUIV

33 EQUIVOCAL

34 BDL

35 BRDLNE

36 BRDLINE

37 BORDERL INE

38 REPEAT

39 NRG
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FFT
**P0S
+/-=P0S
=+P0S
INCONC.
+

You may enter a new LAB RESULTS TRANSLATION, if you wish
Answer must be 1-30 characters in length

Select LAB RESULTS TRANSLATION: pend
...0OK? Yes// <RET> (Yes)

RESULT: PEND// <RET>
TRANSLATION CODE: Result cannot be translated// ??
Numeric Translation Code that the Result will be translated to.
Choose from:

0
1
2
3
5

Negative, Non-Reactive

Positive, Reactive

Borderline, Indeterminate

Test Not Performed, Qty not sufficient or other reason
Result cannot be translated

TRANSLATION CODE: Result cannot be translated// <RET>
Select LAB RESULTS TRANSLATION:
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4.3.1.5.2 Lab Results Extract Untranslatable Results Report

This report prints a listing of results that are not translatable (have no entry in the Lab Results

Translation file (#727.7)). It is a pre-extract type audit report and should be run prior to the

generation of the actual extract. Running this report has no effect on the actual extract.

You will be prompted for the date range for which you would like to scan the LAR Extract

records. Beginning and ending dates must be in the same month and year.

See Appendix B for further information, if necessary.

Example: Lab Results Extract Untranslatable Results Report
Select Maintenance Option: Lab Results Extract Untranslatable Results Report

This report prints a listing of results that are not translatable i.e. have
no entry in the Lab Results Translation File (#727.7).

This report is a pre-extract type audit report and should be run prior to the
generation of the actual extract. Running this report has no effect on the
actual extract.

**WARNING: This report can take a long time to process. You are encouraged
to queue this report for processing during the evening if possible_**

Enter the date range for which you would like to scan the LAR Extract records.

Starting with Date: 2/1/2011 (FEB 01, 2011)
Ending with Date: 2/28/2011 (FEB 29, 2011)

LAR Extract Untranslatable Results Audit Report Page: 1
Start Date: FEB 01, 2011

End Date: FEB 28, 2011

Report Run Date: FEB 02, 2012

Pat. SSN Date/Time Test Test Name Result
Name Collected Code

DSS1 666456789 2/24/11@19:50 32 MICROALBUMIN <0.3
DSS2 000456789 2/6/11@02:21 2 POTASSIUM (SERUM) canc
DSS3 666999999 2/7/11@08:04 27 LDLC comment
DSS4 000768777 2/13/11@04:58 25 FOLATE >20
DSS5 000123421 2/12/11@17:37 19 PSA (PROSTATIC SPECIFI >100
DSS6 666666333 2/26/11@00:11 25 FOLATE >20
DSS7 666555321 2/25/11@12:55 32 MICROALBUMIN <0.3
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4.3.1.5.3 Lab Results DSS LOINC® Code Report

This report prints a listing showing the DSS LOINC® Codes file (#727.29) and its definitions of
LAR Test Numbers and the local tests assigned to them. It also compares the LOINC Code
assigned by DSO for a LAR Test to the LOINC Codes found on the local database. The latter is
based on the linking of Workload Codes to LOINC Codes at the particular location. Differences
are marked with an asterisk following the Local LOINC Code column and must be resolved.
DSO can guide the location in this.

The report displays all workload codes associated with the DSS desired LOINC code. The report
prints the values in those columns even if there is no matching workload code found in file #60.
The intent of the modification is to identify inexact matches and to display all workload codes
associated with a DSS desired LOINC code.

The report process attempts to find a matching LOINC code between the DSS LOINC file
(#727.29) and the WKLD Code file (#64). If a match is not found, an “** (asterisk) displays in
the FLG column to indicate there is no local workload setup for the desired DSS LOINC code.
None of the “local’ fields (those fields coming from file #60 or #64) will be populated.

Select Laboratory Option: 3 Lab Results DSS LOINC Code Report

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns®
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;99999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported Lab Results DSS LOINC Report

T et SO MO g e oo oo loowmo

1 Hemoglobin G/DL 7157 NEWHGB  BLOOD 100727 83020.4452

2 Potassium [Serum) MEQL or MMOL/L 2823-3 POTASSIUM  PLASMA 499 54140.0000

4 BUN mg/dl 110643 *

5 BUN [Blood Urea Nitrogen) MG/DL 30940 UREANITROG PLASMA 543 84520.0000
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Example: Lab Results DSS LOINC Report Screen Print

LOC SPEC
TYPE
(#64)

BLOOD
BLOOD
PLASMA
SERUM
PLASMA
SERUM
BLOOD
SERUM
PLASMA
SERUM
SERUM
PLASMA
BLOOD
BLOOD

PLASMA
SERUM
PLASMA
SERUM
PLASMA
SERUM

SERUM
PLASMA
SERUM

Page: 1
VAMC

LOC WKLD LOC WKLD

1EN

#64)

3860
296
499
499
577
577
577

CODE
(#64)

85657.0000
83020.0000
84140.0000
84140.0000
84295.0000
84295.0000
84295.0000

1048
4471
4471
643
643
5274

81744.0000
82356.0000
82356.0000
84520.0000
84520.0000
88390.0000

666 85030.0000

890
890
1331
1331
101563
101563

81697 .0000
81697 .0000
81950.0000
81950.0000
84455 .5323
84455 .5323

101984
2587
2587

81633.5323
81352.0000
81352.0000

LAB RESULTS DSS LOINC CODE REPORT

Report Run Date/Time: JUN 29, 2009 DSS Site:

LAR TEST# LAR TEST NAME LAR UNITS LAR LOINC L LOCAL TEST NAME
(#727.29) (#727.29) (#727.29) #727.29) G (#64)

0001 Hemoglobin G/DL 718-7 FREE HGB
0001 Hemoglobin G/DL 718-7 HGB

0002 Potassium (Serum) MEQ/L or MMOL 2823-3 TT-POTASSIUM
0002 Potassium (Serum) MEQ/L or MMOL 2823-3 TT-POTASSIUM
0003 Sodium (Serum) MEQ/L or MMOL 2951-2 TT-SODIUM
0003 Sodium (Serum) MEQ/L or MMOL 2951-2 TT-SODIUM
0003 Sodium (Serum) MEQ/L or MMOL 2947-0 ZSODIUM MCAL
0004 Lithium (Serum) MMOL/L 14334-7 LITHIUM

0005 BUN (Blood Urea Nitrogen MG/DL 3094-0 TT-BUN

0005 BUN (Blood Urea Nitrogen MG/DL 3094-0 TT-BUN

0005 BUN (Blood Urea Nitrogen MG/DL 3094-0 UREA NITROGEN
0005 BUN (Blood Urea Nitrogen MG/DL 3094-0 ZZ BUN MCAL
0006 WBC (Total WBC Count) K/UL or K/MM3 6690-2 LEUKOCYTE COUNT
0006 WBC (Total WBC Count) K/UL or K/MM3 6690-2 WBC

0006 WBC (Total WBC Count) K/UL or K/MM3

0006 WBC (Total WBC Count) K/UL or K/MM3 804-5 *

0007 Digoxin NG/ML 10535-3 DIGOXIN

0007 Digoxin NG/ML 10535-3 DIGOXIN

0008 Theophylline UG/ML 4049-3 THEOPHYLLINE
0008 Theophylline UG/ML 4049-3 THEOPHYLL INE
0009 AST (Aspartate Transfera U/L 1920-8 SGOT

0009 AST (Aspartate Transfera U/L 1920-8 SGOT

0009 AST (Aspartate Transfera U/L 30239-8 *

0010 Glucose (Serum) MG/DL 1558-6 Fasting GTT
0010 Glucose (Serum) MG/DL 2345-7 GLU

0010 Glucose (Serum) MG/DL 2345-7 GLU

0017 Hemoglobin A1C (Glycohe % 17855-8 *

0017 Hemoglobin A1C (Glycohe % 17856-6 *

0017 Hemoglobin A1C (Glycohe % 4549-2 *
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4.3.1.6 Nutrition Worksheets

Choosing the Nutrition Worksheets option from the Maintenance Menu will display the
following sub-menu and options.

Example: Nutrition Worksheet Menu Options

Select Nutrition Worksheets Option: ?

Enter/Edit Nutrition Division Worksheet
Print Nutrition Division Worksheet
Enter/Edit Nutrition Product Worksheet
Print Nutrition Product Worksheet

A WNPE

4.3.1.6.1 Enter/Edit Nutrition Division Worksheet

The Nutrition Division Worksheet allows users to map divisions to Nutrition Locations. Use the
Print Nutrition Division Worksheet option to determine the missing information needed to be
entered.

Example: Nutrition Worksheet Example Using Production Location Option

Select Maintenance Option: Nutrition Worksheets
Select Nutrition Worksheets Option: Enter/Edit Nutrition Division Worksheet
Select one of the following:

PL PRODUCTION LOCATION
DL DELIVERY LOCATION

Select location to edit?: pl PRODUCTION LOCATION
Select Production Location to edit: w bldg

Searching for a PRODUCTION FACILITY, (pointed-to by LOCATION NAME)

Searching for a PRODUCTION FACILITY
W BLDG 202 (** Inactive **)
...0K? Yes// (Yes)
Are you adding "W BLDG 202" as
a new DSS NUTRITION DIVISION WORKSHEET (the 6TH)? No// y (Yes)

Select one of the following:

1 PALESTINE 674GA

2 BROWNWOOD 674GB

3 BRYAN 674GC

4 CEDAR PARK 674GD

5 AUSTIN 674BY

6 CENTRAL TEXAS HCS 674
7 WACO 674A4

8 TEMPLE NHC 6749AA

9 TEMPLE 674BU

10 STATE HOME TX 674DT
11 WAC-PRRTP 674PA

12 MARLIN CBOC 674GE

13 TEMPLE CWT/TR 674PB
14 LA GRANGE OUTREACH CLINIC 674HB

Select DSS Assigned Division: 674
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Enter a code from the list.
Select one of the following:

PALESTINE 674GA
BROWNWOOD 674GB

BRYAN 674GC

CEDAR PARK 674GD
AUSTIN 674BY

CENTRAL TEXAS HCS 674
WACO 674A4

TEMPLE NHC 6749AA
TEMPLE 674BU

10 STATE HOME TX 674DT
11 WAC-PRRTP 674PA

12 MARLIN CBOC 674GE

13 TEMPLE CWT/TR 674PB
14 LA GRANGE OUTREACH CLINIC 674HB

OCO~NOURAWNE

Select DSS Assigned Division: 6 CENTRAL TEXAS HCS 674
Select Production Location to edit:

Example: Nutrition Worksheet Example Using Delivery Location Option
Select Nutrition Worksheets Option: Enter/Edit Nutrition Division Worksheet

Select one of the following:

PL PRODUCTION LOCATION
DL DELIVERY LOCATION

Select location to edit?: DL DELIVERY LOCATION
Select Delivery Location to edit: m trayline

Searching for a SERVICE POINT, (pointed-to by LOCATION NAME)

Searching for a SERVICE POINT
M TRAYLINE (** Inactive **)
...0K? Yes// (Yes)
Are you adding "M TRAYLINE® as
a new DSS NUTRITION DIVISION WORKSHEET (the 7TH)? No// Y (Yes)

Select one of the following:

1 PALESTINE 674GA

2 BROWNWOOD 674GB

3 BRYAN 674GC

4 CEDAR PARK 674GD

5 AUSTIN 674BY

6 CENTRAL TEXAS HCS 674
7 WACO 674A4

8 TEMPLE NHC 6749AA

9 TEMPLE 674BU

10 STATE HOME TX 674DT
11 WAC-PRRTP 674PA

12 MARLIN CBOC 674GE

13 TEMPLE CWT/TR 674PB
14 LA GRANGE OUTREACH CLINIC 674HB

Select DSS Assigned Division: 6 CENTRAL TEXAS HCS 674
Select Delivery Location to edit:
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4.3.1.6.2 Print Nutrition Division Worksheet

The Nutrition Division Worksheet allows DSS to capture expensive special diets, capture patient
meals, and dietary orders. This worksheet is by division. This report contains file setup
information vital to extract performance. This report needs to be clean and complete with no
items left under the missing PRODUCTION or DELIVERY LOCATIONS sections. This report
can be run anytime and multiple times. The Nutrition Worksheets have to be correct PRIOR to
running the NUT EXTRACT EACH MONTH. Use the Enter/Edit Nutrition Division worksheet
option to correct items.

Example: Sample Nutrition Division Worksheet — Production Location Example

RUN DATE: 11/2/2009 PAGE 1
NUTRITION DIVISION WORKSHEET

PRODUCTION LOCATIONS

PRODUCTION PRODUCT ION ASSIGNED
LOCATION # LOCATIONS DIVISION
1 T MAIN KITCHEN 674

The following PRODUCTION are missing in the DSS Worksheets

PRODUCTION INACTIVE FLAG

W BLDG 202 YES
M KITCHEN YES

INSTITUTION
FILE/DIVISIONS

674BY
674GB
674GC
674GD
674HA
674A5
674GE
674GA
674DT
674

674PB
674PA
674A4

Example: Sample Nutrition Division Worksheet — Delivery Location Example

RUN DATE: 11/2/2009 PAGE 2
NUTRITION DIVISION WORKSHEET

DELIVERY LOCATIONS

DELIVERY DELIVERY ASSIGNED
LOCATION # LOCATIONS DIVISION
1 T B163 TL 674
6 T DOM CF 674BU
7 Z W BLDG 91 674
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8 W 202 TRAYLINE 674A4
The following DELIVERY LOCATIONS are missing in the DSS Worksheets

DELIVERY LOCATIONS INACTIVE FLAG

T NHCU-T YES
W CAFETERIA-202 YES
M TRAYLINE YES

INSTITUTION
FILE/DIVISIONS

674BY
674GB
674GC
674GD
674HA
674A5
674GE
674GA
674DT
674

674PB
674PA
674A4

4.3.1.6.3 Enter/Edit Nutrition Product Worksheet

The Enter/Edit Nutrition Product Worksheet option allows users to enter products into the
appropriate DSS worksheet PD, SF, SD, or SO. When updating DSS Product Worksheets, users
can either use Diet Name or "™ plus number in parenthesis in the missing diet section of the
Nutrition Product Worksheet Report. To obtain the missing diets, print the Nutrition Product
Worksheet.
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Example: DSS Nutrition Product Worksheet Names

PD PRODUCTION DIET

SF SUPPLEMENTAL FEEDING
TF TUBE FEEDING

SO STANDING ORDER

Example: Enter/Edit Nutrition Product Worksheet for Standing Order

Select Nutrition Worksheets Option: Enter/Edit Nutrition Product Worksheet
Select DSS NUTRITION PRODUCT WORKSHEET NAME: SO STANDING ORDER

IEN from file #118.3 can be used with ~ in front
instead of entering Name of Diet. Diet Name can also be entered.

Select STANDING ORDERS NAME: C-SUPP, M/S
Select one of the following:

1 ST ORDER
2 ST ORDER NC

Select DSS Assigned Product: 1 ST ORDER

IEN from file #118.3 can be used with ~ in front
instead of entering Name of Diet. Diet Name can also be entered.

Select STANDING ORDERS NAME: ~2 SUPP, AMIN-AID (** Inactive **)
Select one of the following:

1 ST ORDER
2 ST ORDER NC

Select DSS Assigned Product: 1 ST ORDER

IEN from file #118.3 can be used with ~ in front
instead of entering Name of Diet. Diet Name can also be entered.

Select STANDING ORDERS NAME:

4.3.1.6.4 Print Nutrition Product Worksheet

The Nutrition Product Worksheet allows DSS to capture expensive special diets, capture patient
meals and dietary orders. This worksheet is by product. For NUT EXTRACT to run accurately,
this report needs to be clean and complete with no items left under the missing diet section. This
report can be run anytime and multiple times. The Nutrition Worksheets have to be correct
PRIOR to running the NUT EXTRACT ----- EACH MONTH
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Example: Nutrition Product Worksheet

Select Nutrition Worksheets Option: 4 Print Nutrition Product Worksheet

DEVICE: HOME//
RUN DATE: 9/09/2008

NUTRITION PRODUCT WORKSHEET
PRODUCTION DIET

PRODUCTION
DIET

BLAND

CLEAR LIQUID

FULL LIQUID

PUREE

PUREE/TUBE

CALORIE 20z

CALORIE 20Z SODIUM 2 GM
CALORIE 20Z SODIUM 2 GM SOFT
CALORIE 30z

CALORIE 30Z SODIUM 2 GM
CALORIE 30Z SODIUM 2 GM SOFT
CALORIE 30Z SOFT

CARDIAC

RUN DATE: 9/09/2008

ASSIGNED
PRODUCT

REGULAR
CLEAR LIQS
FULL LIQS
PUREE DYSPH
FULL LIQS
REGULAR
REGULAR
REGULAR
REGULAR
REGULAR
REGULAR
REGULAR
REGULAR

NUTRITION PRODUCT WORKSHEET

PRODUCTION DIET

PRODUCTION
DIET

FLUID RESTRICTION
GLUTEN FREE

HIGH FIBER

LOW CHOLESTEROL

LOW FAT

LOW RESIDUE

PROT 20 GM 1 0Z SOFT
PROT 20 GM 10z

PROT 40 GM 10z

PROT 40 GM 10Z SOFT
PROT 60 GM 20z

PROT 60 GM 20Z SOFT

ASSIGNED

PRODUCT

REGULAR
REGULAR
REGULAR
REGULAR
REGULAR
REGULAR
REGULAR
REGULAR
REGULAR
REGULAR
REGULAR
REGULAR

THE FOLLOWING DIETS ARE MISSING FROM DSS WORKSHEETS

DIET

NOTHING TO REPORT FOR PD DIET.
NOTHING TO REPORT FOR SF DIET.

C-SUPP, M/S (1)

SUPP, AMIN-AID  (2)
FRUIT, APLSC, CC  (4)
C-FRUIT, APPLE  (5)
FRUIT, BANANA (7))
DESSERT, CAKE, BIRTHDAY
C-CAKE,POUND  (10)

NOTHING TO REPORT FOR TF DIET
October 2013
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4.3.1.7 Pharmacy

Choosing the Pharmacy option from the Maintenance Menu will display the following sub-menu
and options.

Example: Pharmacy Options Menu

Select Pharmacy Option: ?

Pharmacy Edit and Edit Log

Pharmacy Extracts Incomplete Feeder Key Report
Pharmacy Extracts Unusual Cost Report

Pharmacy Extracts Unusual Volume Report
UDP/IVP Source Audit Report

AR WNE

4.3.1.7.1 Pharmacy Edit and Edit Log

The option consists of Pharmacy Volume Edit and Pharmacy Volume Edit Log.

NOTE: The ECXPVE security key is required.

4.3.1.7.1.1 Pharmacy Volume Edit

This option allows authorized users to edit the Pharmacy Extracts (IVP, PRE and UDP).
Corrections may be made to the:

e Quantity field for IVP, PRE, UDP

e Unit of Issue field for PRE

e Total Doses per Day field for IVP

NOTE: Extract must be rerun if changes need to be made after the extract is transmitted. Please
contact the DSO CSHD.

Example: Pharmacy Volume Edit for PRE

1 Pharmacy Volume Edit
2 Pharmacy Volume Edit Log

Select Pharmacy Edit and Edit Log Option: 1 Pharmacy Volume Edit
Select one of the following:

P PRE
1 1VP
U UbP

Which extract do you need to edit?: PRE
Select PRE EXTRACT NUMBER: ?

Select from one of the following extract numbers:

ITf no numbers appear then there are no extracts that can

be edited.
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3741
3863
3882

Select PRE EXTRACT NUMBER: 3741
Enter patient"s SSN, if known, or press ENTER to continue: ??

Enter patient"s SSN, if known. The SSN will be used to find sequence numbers
associated with this patient. Enter 9 digits or 9 digits and P, no hyphens or spaces.
Entry is optional.

Select PRE EXTRACT SEQUENCE NUMBER:

This is a required response. Enter "~" to exit

Select PRE EXTRACT SEQUENCE NUMBER: ?

NOTE: If a patient’s SSN is entered and a question mark (?) is entered for the extract
sequence number, only records including that patient’s SSN will appear in the results.

Select from one of the following sequence numbers:

SEQUENCE # SSN FILL DT QUANTITY UNIT OF ISSUE
3938879 XXXXXXXXX FEB 01, 2012 90 TAB
3938880 XXXXXXXXX FEB 01, 2012 90 TAB
3938881 XXXXXXXXX FEB 01, 2012 15 TAB
3938882 XXXXXXXXX FEB 01, 2012 30 TAB
3938883 XXXXXXXXX FEB 01, 2012 90 CAP
3938884 XXXXXXXXX FEB 01, 2012 30 TAB
3938885 XXXXXXXXX FEB 01, 2012 270 TAB
3938886 XXXXXXXXX FEB 01, 2012 90 TAB
3938887 XXXXXXXXX FEB 01, 2012 120 TAB
3938888 XXXXXXXXX FEB 01, 2012 30 ML
3938889 XXXXXXXXX FEB 01, 2012 227 GM
3938890 XXXXXXXXX FEB 01, 2012 120 ML
3938891 XXXXXXXXX FEB 01, 2012 80 GM
3938892 XXXXXXXXX FEB 01, 2012 270 TAB

Example: Pharmacy Volume Edit for VP

Which extract do you need to edit?: IVP
Select 1VP EXTRACT NUMBER: ??

Select from one of the following extract numbers:
IT¥ no numbers appear then there are no extracts that can
be edited.

2908
3570

Select IVP EXTRACT NUMBER: 3570
Enter patient"s SSN, if known, or press ENTER to continue: ??

Enter patient"s SSN, if known. The SSN will be used to find sequence numbers
associated with this patient. Enter 9 digits or 9 digits and P, no
hyphens or spaces. Entry is optional.

Enter patient™s SSN, if known, or press ENTER to continue:
Select 1VP EXTRACT SEQUENCE NUMBER: ?

NOTE: If a patient’s SSN is entered and a question mark (?) is entered for the extract
sequence number, only records including that patient’s SSN will appear in the results.
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Select from one of the following sequence numbers:

SEQUENCE # SSN DISPENSE DT  QUANTITY TOTAL DOSES/DAY
202327 XXXXXXXXX  JUN 01, 2010 1 100 ML
202328 XXXXXXXXX  JUN 01, 2010 1 1 GM
202329 XXXXXXXXX  JUN 01, 2010 1 1000 ML
202330 XXXXXXXXX  JUN 01, 2010 1 100 ML
202331 XXXXXXXXX  JUN 01, 2010 1 3.375 GM
202332 XXXXXXXXX  JUN 01, 2010 1 250 ML
202333 XXXXXXXXX  JUN 01, 2010 1 1000 MG
202334 XXXXXXXXX  JUN 01, 2010 1 100 ML
202335 XXXXXXXXX  JUN 01, 2010 1 3.375 GM
202336 XXXXXXXXX  JUN 01, 2010 1 100 ML
202337 XXXXXXXXX  JUN 01, 2010 1 40 MG
202338 XXXXXXXXX  JUN 01, 2010 1 1000 ML
202339 XXXXXXXXX  JUN 01, 2010 1 250 ML
202340 XXXXXXXXX  JUN 01, 2010 1 1000 MG
202341 XXXXXXXXX  JUN 01, 2010 1 500 MG

Example: Pharmacy Volume Edit for UDP

Which extract do you need to edit?: UDP
Select UDP EXTRACT NUMBER: ?7?

Select from one of the following extract numbers:
IT no numbers appear then there are no extracts that can

be edited.

2024
2921
3581

Select UDP EXTRACT NUMBER: 3581
Enter patient"s SSN, if known, or press ENTER to continue: ??

Enter patient"s SSN, if known. The SSN will be used to find sequence numbers
associated with this patient. Enter 9 digits or 9 digits and P, no
hyphens or spaces. Entry is optional.

Enter patient®s SSN, if known, or press ENTER to continue:
Select UDP EXTRACT SEQUENCE NUMBER: ?

NOTE: If a patient’s SSN is entered and a question mark (?) is entered for the extract
sequence number, only records including that patient’s SSN will appear in the results.

Select from one of the following sequence numbers:

SEQUENCE # SSN DISPENSE DT QUANTITY
1364046 XXXXXXXXX JUN 01, 2010 1
1364047 XXXXXXXXX JUN 01, 2010 1
1364048 XXXXXXXXX JUN 01, 2010 1
1364049 XXXXXXXXX JUN 01, 2010 1
1364050 XXXXXXXXX JUN 01, 2010 1
1364051 XXXXXXXXX JUN 01, 2010 1
1364052 XXXXXXXXX JUN 01, 2010 4
1364053 XXXXXXXXX JUN 01, 2010 2
1364054 XXXXXXXXX JUN 01, 2010 1
1364055 XXXXXXXXX JUN 01, 2010 1
1364056 XXXXXXXXX JUN 01, 2010 2
1364057 XXXXXXXXX JUN 01, 2010 4
1364058 XXXXXXXXX JUN 01, 2010 4
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4.3.1.7.1.2 Pharmacy Volume Edit Log

The Pharmacy Volume Edit Log requires a 132-column output. (The sample report was modified
to fit into the space below)

Example: Pharmacy Volume Edit Log for IVP

PHARMACY VOLUME EDIT LOG FOR IVP Page 1
Printed on Oct 24, 2006@13:15:13 for 10/20/06 to 10/24/06
USER NAME DATE/TIME CHANGED SEQUENCE # EXTRACT # FIELD NAME OLD VALUE NEW VALUE

DSS,USER1 OCT 24,2006 13:11 120583 2609 QUANTITY 1 2
DSS,USER2 OCT 24,2006 13:11 120584 2609 QUANTITY 1 5
DSS,USER3 OCT 24,2006 13:11 120585 2609 QUANTITY 1 5
DSS,USER4 OCT 24,2006 13:11 120586 2609 QUANTITY 1 5
DSS,USERS OCT 24,2006 13:11 120587 2609 QUANTITY 1 5

4.3.1.7.2 Pharmacy Extracts Incomplete Feeder Key Report

This report prints listing of Drug file entries that have incomplete Feeder Key based on one of the
following conditions:

e No PSNDF VA Product Name Entry (first 5 digits are zero)
e No National Drug Code (NDC) (last 12 digits are zero)
e No PSNDF VA Product Name Entry or NDC (all 17 digits are zero)

This report is designed to be run before the extract for a specified date range and can be used as a
tool to identify and fix DRUG file (#50) entries that have incomplete Feeder Keys. Only those
drugs that would be included on the Extract for the specified date range are listed on the report
for the Pharmacy Extract selected (PRE, IVP or UDP). The following columns are included on
the report:

1. Drug Entry - INTERNAL ENTRY NUMBER (IEN) for the drug from the DRUG file
(#50).

2. Generic Name - The GENERIC NAME field (#.01) of the drug from the DRUG file
(#50).

3. Feeder Key - The Feeder Key for the drug, which is the first 5 characters of the PSNDF
VA PRODUCT NAME ENTRY field (#22) concatenated with the 12 characters NDC
field (#31) from the DRUG file (#50).

4. Number of Records - The number of Extract records that would contain this drug for the
date range specified if the extract were run.

5. Total Quantity - The sum of the quantities of the drug from all of the Extract records.
This is the same as the QUANTITY field for the PRE and UDP Extracts. For the IVP
Extract the Total Quantity is the sum of the values taken from the ADDITIVE
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STRENGTH field (#7) or SOLUTION VOLUME field (#9) of the IV EXTRACT DATA
file (#728.113).

6. Unit Price - The PRICE PER DISPENSE UNIT field (#16) from the DRUG file (#50) for
the PRE and UDP Extracts. For the IVP Extract Unit Price is the COST field (#12) of the
IV EXTRACT DATA file (#728.13).

7. Total Cost - The total cost of the drug for the Extract (Total Quantity x Unit Price). For
all three Pharmacy Extracts, the Total Cost is the same as the sum of the COST filed from
all Extract records containing the drug.

This report requires a 132-column output.

Select Maintenance Option: Pharmacy Extracts Incomplete Feeder Key Report

This report prints a listing of Drug File (#50) entries that will generate
incomplete Feeder keys in the three Pharmacy Extracts. This listing

can be used to identify and fix Drug File entries. The number of extract
records, total, quantity, unit price and total cost for each drug are
included to aid in determining the impact of the incomplete Feeder Keys.

This report is broken into 3 sections as follows:

Section 1: No PSNDF VA Product Name Entry (first 5 digits are zero).

Section 2: No National Drug Code (NDC) (last 12 digits are zero) or the NDC
is prefixed with an "S", indicating possible supply item number
or UPC.

Section 3: No PSNDF VA Product Name Entry, and
a. no NDC (all 17 digits are zero), or
b. The NDC is prefixed with an "S", indicating possible supply
item number or UPC.
Section 3: No PSNDF VA Product Name Entry or NDC.

Run times for this report will vary depending upon the size of the extract and

could take as long as 30 minutes or more to complete. This report has no effect
on the actual extracts and can be run as needed.

4.3.1.7.2.1 PRE Extracts Incomplete Feeder Key Report
Choose the report you would like to run.

Select one of the following:

1 PRE
2 1VP
3 UDP

Selection: 1// 1 PRE

Enter the date range for which you would like to scan the Prescription
Extract records.

Starting with Date: 2/1 (FEB 01, 2013)

Ending with Date: 2/28 (FEB 28, 2013)

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
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To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//
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Example: Exported PRE Extracts Incomplete Feeder Key Report

DRUG NUMBER OF TOTAL UNIT TOTAL
TYPE ENTRY GENERIC NAME FEEDER KEY RECORDS QT  PRICE COST  ERROR
Prescription 1341  TETANUS & DIPHTHERIA TOXOID .5ML 00000049281021510 1 1 12,5700 12.57 No PSNDF VA Product Name Entry (Five leadin)
Prescription 2823 PNEUMOCOCCAL VACCINE 00000000006473900 25 25 104.9200 2623.00 No PSNDF VA Product Name Entry (Five leading zeros)
Prescription 3967 DERMA CERIN TOP CREAM 00000072140000021 1 227 0.0223  5.06 Mo PSNDF VA Product Name Entry (Five leading zeros)

Example: PRE Extracts Incomplete Feeder Key Report Screen Print

Prescription Extract Incomplete Feeder Key Report Page: 1
Start Date: MAR 01, 2006

End Date: MAR 31, 2006 Report Run Date/Time: OCT 24, 2006
Drug Generic Name Feeder Key # of Total Unit Total
Entry Records Quantity Price Cost

No PSNDF VA Product Name Entry (Five leading zeros)

1796 VANCOMYCIN 50MG/ML ORAL SOL. (MLS) 00000000074433201 3 1,490 $0.0000 $0.00
1875 SODIUM CHLORIDE (NON-BACT) USP INJ 20ML 00000000074488820 3 126 $0.2736 $34._47
3741 RESTON PADS 00000000015006000 1 10 $3.0840 $30.84

4.3.1.7.2.2 VP Extracts Incomplete Feeder Key Report
Choose the report you would like to run.

Select one of the following:

1 PRE
2 1VP
3 UDP

Selection: 1// 2 1VP

Enter the date range for which you would like to scan the 1V Detail
Extract records.
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Starting with Date: 2/1 (FEB 01, 2013)
Ending with Date: 2/28 (FEB 28, 2013)

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen”™ tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where O is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported IVP Extracts Incomplete Feeder Key Report

DRUG NUMBER OF TOTAL UNIT  TOTAL
TYPE  ENTRY GENERIC NAME FEEDER KEY RECORDS  QTY PRICE COST ERROR
IV Detail 1686 DAUNORUBICIN 20MG INJ 00000000703523313 7 7 71200 49.84  No PSNDF VA Product Name Entry
IV Detail 4529 HYPERLYTE 25ML 00000000264300162 2 2 0.0440 0.09  NoPSNDF VA Product Name Entry
IV Detail 4835  SODIUM PHOSPHATE 3mM/ML INJ 15ML 00000000409739172 19 17 00713 121  NoPSNDF VA Product Name Entry
IV Detail 5134 ETOPOSIDE 100MG INJ 00000063323010405 12 12 0.0400 048  NoPSNDF VA Product Name Entry
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Example: VP Extracts Incomplete Feeder Key Report Screen Print

1V Detail Extract Incomplete Feeder Key Report Page: 1
Start Date: MAR 01, 2006

End Date: MAR 31, 2006 Report Run Date/Time: OCT 24, 2006
Drug Generic Name Feeder Key # of Total Unit Total
Entry Records Quantity Price Cost

No PSNDF VA Product Name Entry (Five leading zeros)

1706 NAFCILLIN 2 GM. INJ 00000000781312595 1 1 $2.4475 $2.45
TOTAL $2.4

1V Detail Extract Incomplete Feeder Key Report Page: 2

Start Date: MAR 01, 2006

End Date: MAR 31, 2006 Report Run Date/Time: OCT 24, 2006

Drug Generic Name Feeder Key # of Total unit Total

Entry Records Quantity Price Cost

No National Drug Code (NDC) (Last 12 zeros, "N/A", or "S" prefix)

2674 SODIUM CHLORIDE 0.9% (BRAUN) 50ML BAG 00451000000000000 6 6 $0.0285 $0.17
TOTAL $0.17

4.3.1.7.2.3 UDP Extracts Incomplete Feeder Key Report
Choose the report you would like to run.

Select one of the following:

1 PRE
2 1VP
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3 UDP
Selection: 1// 3 UDP

Enter the date range for which you would like to scan the Unit Dose Local
Extract records.

Starting with Date: 2/1 (FEB 01, 2013)
Ending with Date: 2/28 (FEB 28, 2013)

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns*
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g-. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: 1In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported UDP Extracts Incomplete Feeder Key Report

TYRE E'm GENERIC NAME FEEDER KEY ::C";:E;DF L'::r“' ﬁ:l';E lﬁ"
Unit Dose Local 6443 VALPROICACID 250MG/SML UD CUPS 000DO00E2004019362 | 10 56 04207 2356
Unit Dose Local 7741  APREPITANT 125MG CAP,UD 000D00000006046206 | 1 1 B0.6317 80.63
Unit Dose Local 8873  ALOH 200/MGOH 200/SIMTH 20/SML30MLCUP 000000000121176130 14 1186 11197 1327.96
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Example: UDP Extracts Incomplete Feeder Key Report Screen Print

Unit Dose Local Extract Incomplete Feeder Key Report Page: 1
Start Date: MAR 01, 2006

End Date: MAR 31, 2006 Report Run Date/Time: OCT 24, 2006
Drug Generic Name Feeder Key # of Total Unit Total
Entry Records Quantity Price Cost

No National Drug Code (NDC) (Last 12 zeros, "N/A", or *S" prefix)

3497 OXYBUTYNIN CHLORIDE 2.5MG (1/2X5MG) TAB 06141000000000000 33 86 $0.0600 $5.16
94362 ATENOLOL 12.5MG (1/2 X 25MG) TAB 04331000000000000 59 74 $0.0072 $0.53
94363 CITALOPRAM HBr 10MG (1/2 X 20MG) TAB 12926000000000000 29 37 $0.4370 $16.17
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4.3.1.7.3 Pharmacy Extracts Unusual Cost Report

Users with the ECXMGR security key can export the data for all reports on the Pharmacy
Extracts Unusual Cost Report option into an external spreadsheet. Users also have the option to
view the report on the screen.

This report prints a listing of unusual costs that would be

generated by the pharmacy extracts (PRE, IVP, UDP and BCM) as

determined by a user defined threshold value. It should be run

prior to the generation of the actual extract(s) to identify and

fix as necessary any costs determined to be erroneous.

Note: The threshold can be set after a report is selected.

Run times for this report will vary depending upon the size of

the extract and could take as long as 30 minutes or more to

complete. This report has no effect on the actual extracts and

can be run as needed.

The report is sorted by Feeder Key, Descending Cost, and SSN.

Enter RETURN to continue or *"~" to exit:

Example: Pharmacy Extracts Unusual Cost Report
Choose the report you would like to run.

Select one of the following:

1 PRE
2 1VP
3 UDP
4 BCM

Selection: 1//

4.3.1.7.3.1 PRE Unusual Cost Report

The default threshold cost for the Prescription extract is $50.
Would you like to change the threshold? NO// n NO

Enter the date range for which you would like to scan the Prescription
Extract records.

Starting with Date: 2/1/12 (FEB 01, 2012)

Ending with Date: 2/28/12 (FEB 28, 2012)

Do you want the output in exportable format? NO// YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.
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Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width
and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported PRE Unusual Cost Report

MNAME | 55N DAY GEMERIC NAME FEEDER KEY QUANTITY | TOTALCOST | DAYS SUPPLY

PATI1 KRENEENEE | 02/11 | CALCIPOTRIENED.005% TOP CREAM 11943066993087761 240 GM 5531.6450 30

PAT2 KRR | 02/15 | RILUZOLESOMG TAB 12473000075770060 180 TAB 51,752.1740 | S0

PAT3 WEEENEN | 02/12 | CAPECITABINE SO0MG TAB 12837000004110150 200 TAB 52,987 380 30

Example: PRE Unusual Cost Report Displayed on Screen

Prescription Extract Unusual Cost Eeport Page: 1
Start Date: FEB 01, 2013 Report Run Date/Time: MAY 17, 2013
End Date: FEE 15, 2013 Threshold Value = §500

Nate S5 Davy Generic Name Feeder Eey Quantity Total Cost Days Supply
FPAT1 HEEEEEZER 0z/11 CALCIFOTRIENE 0.005% TOF CREAM 11943066993087761 240 GH $531.6480 3o
PATZ HEEEEEEEE 0z/15 RILUZOLE S0MG TLALE 12473000075770060 180 TAE §1,752.1740 20
PAT3 HEEEEEEEX 0z/12 LAMIVUDINE 150MG/ZIDOVUDINE 300MG TLE 12790049702020218 &0 TALE $533.8620 30
PAT4 HEEEEXEXE oz/12 CAPECITAEINE S00MG TAE 12837000004110150 Z00 TAE $2,987.3800 30
PJ\.T5| HEEEEXEXE 0z/06 ENOXAPARIN 100MG/ML INJ SYRINGE 1ML 12933000545560500 60 SYRINGE §936.7200 30

4.3.1.7.3.2 IVP Unusual Cost Report

The default threshold cost for the IV Detail extract is $100.
Would you like to change the threshold? NO// n NO

Enter the date range for which you would like to scan the 1V Detail
Extract records.

Starting with Date: 2/1/13 (FEB 01, 2013)

Ending with Date: 2/28/13 (FEB 28, 2013)

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns*
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g- 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: [In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//
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Example: Exported IVP Unusual Cost Report

MAME | 55N DAY GEMERIC MAME FEEDIER KEY TOTAL DOSES PER DAY | TOTAL COST
PAT1 PR EEEE R 02/06 | GEMCITABINE 200MG 10ML VIAL 12548000002750101 2150 MG 5853.3350
PATZ AR AR, 02705 | RITUXIMAB 1OMG/ML INJ SOML 12847050242005206 900 MG 52,187.0000
Fﬁ.T3| FORE R 02/01 | SODIUMCHLORIDED. 9% N BAG 1000ML | 14566000335004904 2000 ML 51,9834000
Example: VP Unusual Cost Report Displayed on Screen
IV Detail Extract Unusual Cost Report Page: 1

Start Date: FEB 01, 2013 Report Bun Date/Time: MAY 17, 2013
End Date: FEE 10, 2013 Threshold Valus = §500

Name 33N Day Generic Name Feeder Key Total Doses Total Cost

Per Day

PAT1 EEEXEXEXE oz/08e GEMCITAEINE Z0OOMG 10ML VIAL 12545000002750101 2150 MG $853.3350
PATZ EEEXEXEXE 0z/08 GEMCITAEINE Z0OOMG 10ML VIAL 12545000002750101 1500 HG $595.3500
PAT3 EEEXEXEXE 0z/08 RITUXIMAE 10MG/ML INJ SOML 12847050242005306 Q00 MG §z2,187.0000
FPAT4 IEEEEEXNEE 0z/01 RITUXIMAE 10MG/ML INJ S0OML 12847050242005300 700 MG $1,701.0000

4.3.1.7.3.3 UDP Unusual Cost Report

The default threshold cost for the Unit Dose Local extract is $20.
Would you like to change the threshold? NO// n NO
Include SIG/Order Direction on line 2 of report? NO// n NO

Enter the date range for which you would like to scan the Unit Dose Local
Extract records.

Starting with Date: 5/1/13 (MAY 01, 2013)

Ending with Date: 5/31/13 (MAY 31, 2013)

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...

To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough

parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.
Example: DEVICE: 0;225;99999 *Where O is your screen, 225 is the margin width
and 99999 is the screen length.

NOTE: 1In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//
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Example: Exported UDP Unusual Cost Report

NAME | 55N DAy GEMERIC NAME FEEDER KEY QUANTITY | TOTAL COST
FATI LEE R 02/08 | PEGFILGRASTIM 6MIG,D.6ML 15477055512019001 135YR 51,854.7200
PATZ OO 02/08 | NITROGLYCERINO.4MG 5L TAB 25°% 20387000071041812 576 BT 51,249.9200
PATS OO 02/01 | NITROGLYCERINO.4MG SLTAB 25'5 20357000071041813 288 BT 5624.9600
Example: UDP Unusual Cost Report Displayed on Screen
Unit Dose Local Extract UTnusual Cost Report Page: 1

Start Date:
End Date:

FEE 01,
FEE 10,

2013
2013
Ed=1d)

Narme Day

Generic Name

Feeder Key

Report Run Date/Time:

AT 17,

Threshold Value = §500

Cuantity

2013

Total Cost

IEEEXEEEE
ELREEEEEEY
ELREEEEEEY

0z/08
nz/08
0z/01

PEGFILGRASTIM 6MG/0.6ML
MNITREOGLYCERIN O.4MG SL TAE 25'3
MNITREOGLYCERIN O.4MG SL TAE 25'3

15477055513019001
Z0387000071041513
Z0387000071041513

1 YR
576 BT
Z88 BT

$1,85
§1,24
$62

4.3.1.7.3.4 BCM Unusual Cost Report
Select one of the following:

1 1v
N NON-1V
Select type of BCM record: n NON-1V
The default threshold cost for the BCM-NON IV Entries extract is $20.

Would you like to change the threshold? NO//
Include S1G/0rder Direction on line 2 of report? NO// y YES

4.7200
9.9200
4.9600

NOTE: Users can choose to add the SIG/Order Directions on the second line of this report.

Enter the date range for which you would like to scan the BCM-NON 1V Entries
Extract records.

Starting with Date: 2/1 (FEB 01, 2013)

Ending with Date: 2/28 (FEB 28, 2013)

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...

To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough

parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.
Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width
and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//
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Example: Exported BCM Unusual Cost Report (Non- 1V)

NAME SSN DAY GENERIC NAME FEEDER KEY COMPONENT TOTAL COST SIG

DOSE GIVEN
PATL OOCOOCOMX 02/14 ENOXAPARIN 100MG/ ML INJ SYRINGE 1ML 12933000548560500 1 SYRINGE $1,211.9000 100 MG/1NML NOW
PATZ OOOOO0K0 02/19 ENOXAPARIN 30MG/0.3ML INJ SYRINGE 0.3ML 12935000548560100 1 SYRINGE $107.8500 30 MG/0.3ML NOW

PAT3 0O 02/01 INSULIN,GLARGINE,HUMAN 100 UNT/MLINJ  14476000083222033 1VI $366.0800 QHS

Example: BCM Unusual Cost Report Displayed on Screen (1V)

ECM-IV Entries Extract Unusual Cost Report Page: 1
Start Date: FEE 01, 2013 Report Run Date/Time: MAY 17, 2013
End Date: FEE 05, 2013 Threshold Value = $500

Narme SEN Day Generic Name Feeder Key Component Dose Given Total Cost

PAT1 IEXEEEEXY oz/01 SODIUM CHLORIDE 0.9% INJ EBAG 1000HML 14566000335004504 1000 ML $991.7000
PATZ IEXEEEEXY oz/01 SODIUM CHLORIDE 0.9% INJ EBAG 1000HML 14566000335004504 1000 ML $991.7000
PATZ IEHEEENNE oz/01 SODIUM CHLORIDE 0.9% INJ EAG 1000ML 14566000338004504 1000 ML $991.7000
PAT4 IEXEEEEXY oz/01 SODIUM CHLORIDE 0.9% INJ EBAG 1000HML 14566000335004504 1000 ML $991.7000

4.3.1.7.4 Pharmacy Extracts Unusual Volume Report

This report prints a listing of unusual volumes that would be generated by the
pharmacy extracts (PRE, IVP, UDP and BCM) as determined by a user defined threshold
value. It should be run prior to the generation of the actual extract(s) to identify
and fix as necessary any volumes determined to be erroneous.

Unusual volumes are defined as follows:
PRE Extract: Quantity field greater than the threshold value.
IVP Extract: Total Doses Per Day field greater than the threshold
or less than the negative of the threshold value.
UDP Extract: Quantity field greater than threshold value.
BCM Extract: Component Dose Given Ffield greater than threshold value.
Note: The threshold can be set after a report is selected.
Run times for this report will vary depending upon the size of the extract and could
take as long as 30 minutes or more to complete. This report has no effect on the
actual extracts and can be run as needed.
The report is sorted by Feeder Key, Descending Volume, and SSN.

Enter RETURN to continue or "~" to exit: <RET>

4.3.1.7.4.1 PRE Unusual Volume Report

Choose the report you would like to run.
Select one of the following:

PRE

1VP

UDP
BCM

A WNPE

Selection: 1// 1 PRE

The default threshold volume for the Prescription extract is 500.
Would you like to change the threshold?? NO//

Enter the date range for which you would like to scan the Prescription
Extract records.
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Starting with Date: 02012013 (FEB 01, 2013)

Ending with Date: 02282013 (FEB 28, 2013)

Do you want the output in exportable format? NO// Y

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...

To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen”™ tab and modify "columns”

setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough

parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.

You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be

displayed correctly in the spreadsheet, these fields must be formatted as Text

when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Export Prescription Extract Unusual VVolume Report

DAYS

MAME S5N DAY GEMERIC NAME FEEDER KEY QUANTITY TOTAL COST SUPPLY
MUTRITION SUPL

PATA X0 | 02/08 EMSURE/VAMILLA PWD 10222070074060750 16674 GM 51417290 20
NUTRITION SUPL

PATE KXKAO00 | 02/05 | ENSURE/VAMILLA PWD 1022 2070074060750 9528 GM 5580.9880 84
MUTRITION SUPL

PATC W00 | 0205 EMNSURE/VANILLA PWD 1022 2070074060750 7200 GM 561.2000 30

Example: Prescription Extract Unusual Volume Report Displayed on Screen

Prescription Extract Unusual Volume Report

Page: 1

Start Date: JAN 01, 2002

Report Run Date/Time: JAN 02, 2003

End Date: JAN 31, 2002

Threshold Value = 500

Name SSN Day Generic Name

Feeder Key Quantity Total Cost Days Supply

DSS1 000456789 03706 NUTRITION SUPL ENSURE/VANILLA PWD

10222070074607504 7560 $37.80 30

DSS2 666456789 03710 NUTRITION SUPL ENSURE/VANILLA PWD

10222070074607504 7140 $35.70 30

DSS3 000987655 03706 NUTRITION SUPL ENSURE/VANILLA PWD

10222070074607504 5460 $27.30 90
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4.3.1.7.4.2 IVP Unusual Volume Report

Choose the report you would like to run.
Select one of the following:

PRE
1VP
UDP
BCM

A WNPE

Selection: 1// 2 1VP

Use (C)urrent or (P)revious fiscal year logic for this report? C// ¢ Current
Fiscal Year Report Logic

The default threshold volume for the IV Detail extract is 1000.
Would you like to change the threshold? NO// n NO

Enter the date range for which you would like to scan the 1V Detail
Extract records.

Starting with Date: 02012013 (FEB 01, 2013)

Ending with Date: 02282013 (FEB 28, 2013)

Do you want the output in exportable format? NO// Y

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported 1V Detail Extract Unusual Volume Report

TOTAL DOSES
NAME | 55N DAY GENERIC NAME FEEDER KEY PER DAY TOTAL COST
PATA R 02/D6 GEMCITABINE 2000G 10ML VIAL 12548000002750101 2150 MG 5853.3350
PATE RO 02/01 DEXTROSE 5% IN) BAG 1000ML 14560000335001704 2000 ML 5134.0000
PATC OO 02/01 SODIUMCHLORIDED. 9% IN) BAG 1000NML 14566000335004904 2000 ML 51,983 4000

NOTE: The Total Cost Per Day column displays 4 decimal places and is calculated by
multiplying the Average Drug Cost per Unit times Total Doses per Day.
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Example: IV Detail Extract Unusual Volume Report

1V Detail Extract Unusual Volume Report
Page: 1
Start Date: FEB 01, 2012
Report Run Date/Time: MAY 29, 2012
End Date: FEB 29, 2012
Threshold Value = 20

Total Total
Name SSN Day Generic Name Feeder Key Doses Cost Per Day
DSS1 666551982 02/21  VINORELBINE 10MG/ML 12374000703418301 50 MG $6.0364
DSS2 000986514  02/28  VINORELBINE 10MG/ML 12374000703418301 50 MG $6.0364
DSS3 000762783 02/01  VINORELBINE 10MG/ML 12374000703418301 25 MG $6.0364
DSS4 666229182 02/08  VINORELBINE 10MG/ML 12374000703418301 25 MG $6.0364

4.3.1.7.4.3 UDP Unusual Volume Report

NOTE: Users can choose to add the SIG/Order Directions on the second line of this report.
SIG/Order Direction information is produced by combining Prescription Unit Dose and Schedule
information. This field will assist pharmacists that are responsible for audits to distinguish
dispensing errors.

Choose the report you would like to run.

Select one of the following:

1 PRE
2 1VP
3 UbP

Selection: 1// 3 UDP

The default threshold volume for the Unit Dose Local extract is 500.
Would you like to change the threshold? NO// Y YES

Quantity > threshold
Enter the new threshold volume: (0-100000): 20
Include SIG/Order Direction on line 2 of report? NO// YES

Enter the date range for which you would like to scan the Unit Dose Local
Extract records.

Starting with Date: February 1, 2012 (FEB 01, 2012)

Ending with Date: February 29, 2012 (FEB 29, 2012)

Do you want the output in exportable format? NO// Y

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.
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NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported UDP Detail Extract Unusual Volume Report with SIG/Order
Directions Added

NAME SSMN DAY GEMERIC NAME FEEDER KEY QUANTITY TOTALCOST SIG
D551 MO0 02/03 GABAPENTIN 100MG CAP 11800000228266550 24 CAP 50.0024 200H
D552 MO0 02/10 GABAPENTIN 100MG CAP 11800000228266550 24 CAP 50.0024 200H |
D553 XOOOOO0E 02/17 GABAPENTIN 100MG CAP 11800000228266550 24 CAP $0.0024 200H

Example: UDP Detail Extract Unusual Volume Report with SIG/Order Directions Added
Displayed on Screen

Unit Dose Local Extract Unusual Volume Report
Page: 1

Start Date: FEB 01, 2012

Report Run Date/Time: MAY 24, 2012

End Date: FEB 29, 2012

Threshold Value = 20

Name SSN Day Generic Name Feeder Key Quantity Total
Cost

DSS1 000118721  02/03 GABAPENTIN 300MG CAP  11801000228266650 36 CAP $2.6712
SI1G: 900 MG QID/FOOD

DSS2 000779855  02/01 GABAPENTIN 300MG CAP  11801000228266650 24 CAP $1.7808
SI1G: 900 MG QID/FOOD

DSS3 000912671  02/06 GABAPENTIN 300MG CAP  11801000228266650 24 CAP $1.9224
SI1G: 900 MG QID/FOOD

DSS4 000528727 02/24  TRAMADOL 50MG TAB 12380016714011106 24 TAB $0.4224
SIG: 100 MG QID

Example: Exported UDP Detail Extract Unusual Volume Report without SIG/Order
Directions Added

NAME 55N DAY GEMERIC NAME FEEDER KEY QUANTITY TOTAL COST
PATL OO0 0222 GABAPENTIN 300MG CAP 11301000228266600 864 BT 52.6712
PATZ OOKO(XXX 02/22 GABAPENTIN 300MG CAP 11801000228266600 804 BT 52.6712
PAT3 OOCOOOKKNK 02/08 GABAPENTIN 300MG CAP 11301000228266600 864 BT 52.6712

Example: UDP Detail Extract Unusual Volume Report without SIG/Order Directions
Added Displayed on Screen

Unit Dose Local Extract Unusual Volume Report
Page: 1

Start Date: FEB 01, 2012

Report Run Date/Time: MAY 24, 2012

End Date: FEB 29, 2012

Threshold Value = 20
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Name SSN Day Generic Name Feeder Key Quantity Total
Cost
DSS1 000118721  02/03 GABAPENTIN 300MG CAP  11801000228266650 36 CAP $2.6712
DSS2 000779855  02/01 GABAPENTIN 300MG CAP  11801000228266650 24 CAP $1.7808
DSS3 000912671  02/06 GABAPENTIN 300MG CAP  11801000228266650 24 CAP $1.9224
DSS4 000528727 02724 TRAMADOL 50MG TAB 12380016714011106 24 TAB $0.4224
4.3.1.7.4.4 BCM Unusual Volume Report
Choose the report you would like to run.
Select one of the following:
1 PRE
2 1VP
3 UDP
4 BCM
Selection: 1// 4 BCM
Select one of the following:
1 v
NON-1V
Select type of BCM record: N
The default threshold volume for the BCM-NON IV Entries extract is 5.
Would you like to change the threshold? NO// n NO
Include S1G/0rder Direction on line 2 of report? NO// y YES
Enter the date range for which you would like to scan the BCM-NON 1V Entries
Extract records.
Starting with Date: 02012013 (FEB 01, 2013)
Ending with Date: 02282013 (FEB 28, 2013)
Do you want the output in exportable format? NO// N
NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.
Example: Exported BCM Detail Extract Unusual Volume Report with SIG/Order
Directions Added (Non-1V)
MNAME S5M DAy GEMERIC MAME FEEDER KEY ;mpgﬂiw -Egl;:" SIG
PATA R 02701 CLOZAPIME [MYLAN) 100MHG TAB 153680003 78086001 & TAB 50.0000 600 MG QHE
PATE R e 02,10 METHADONE 100G TAB U/D 00136000406577 162 & TAB S0.0000 DAILY
PATC LR 02710 TRAFODOME HCL SOMG TAB 06132000602616032 | 6 TAB 50.0000 QHS
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Example: BCM Detail Extract Unusual Volume Report with SIG/Order Directions Added
Displayed on Screen (Non-1V)

BCM-NON 1V Entries Extract Unusual Volume Report
Page: 1
Start Date: FEB 01, 2013
Report Run Date/Time: JUL 11, 2013
End Date: FEB 28, 2013
Threshold Value = 5

Name SSN Day Generic Name Feeder Key Component Dose Given Total Cost

PAT1 XXXXXXXXX 02701 CLOZAPINE (MYLAN) 100MG TAB 15368000378086005 7 TAB $2.9281
SIG: 700 MG DAILY AT-1800

Example: Exported BCM Detail Extract Unusual Volume Report without SIG/Order
Directions Added (1V)

MNAME 55N DAY GEMERIC NAME FEEDER KEY COMPONENT DOSE GIVEN TOTAL COST
PATL O0OGGOM(K 02/01  SODIUM CHLORIDE 0.9% INJ BAG 1000ML  14566000338004300 2000 1933.4000
PATZ 00000000 02/03  SODIUM CHLORIDE 0.9% INJ BAG 1000ML  14566000338004300 2000 1583.4000

Example: BCM Detail Extract Unusual Volume Report without SIG/Order Directions
Added Displayed on Screen (1V)

BCM-NON IV Entries Extract Unusual Volume Report
Page: 1
Start Date: FEB 01, 2013
Report Run Date/Time: AUG 23, 2013
End Date: FEB 28, 2013
Threshold Value = 1000
Threshold Value = 1000

Name SSN Day Generic Name Feeder Key Component Dose Given Total

PAT1 XXXXXXXXX 02/28 SODIUM CHLORIDE 0.9% INJ BAG 1000ML 14566000338004904 2000 $1,983.4000

4.3.1.7.5 UDP/IVP Source Audit Report

The Source Audit Reports provide a record count for each Division and Date combination
chosen. The reports pull information from the UDP and I\VVP Intermediate source files within the
DSS name space: UNIT DOSE EXTRACT DATA file (#728.904) and the IV EXTRACT
DATA file (#728.113).

Example: UDP Source Audit Report

Select Maintenance Option: 22 UDP/IVP Source Audit Report
Select one of the following:
1 UbP
2 1VP

Select Source Audit Report: 1 UDP

Select division: ALL//

Enter Report Start Date: Oct 24, 2006// 04012006 (APR 01, 2006)
Enter Report End Date: Oct 24, 2006// 04302006 (APR 30, 2006)
DEVICE: HOME// ;132
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UDP Source Audit Report

PAGE: 1
Run Date: Oct 24, 2006
Start Date: Apr 01, 2006
End Date: Apr 30, 2006
Division Date Record Count
442 Apr 01, 2006 6
442 Apr 02, 2006 11
442 Apr 03, 2006 387
442 Apr 04, 2006 388
UNKNOWN Apr 04, 2006 1
442 Apr 05, 2006 418
442 Apr 06, 2006 423
442 Apr 07, 2006 434
442 Apr 08, 2006 247
UNKNOWN Apr 08, 2006 14

Example: 1VP Source Audit Report

Select Maintenance Option: 22 UDP/IVP Source Audit Report
Select one of the following:
1 UbP
2 1VP

Select Source Audit Report: 2 1VP

Select division: ALL//

Enter Report Start Date: Oct 24, 2006// 03012006 (MAR 01, 2006)

Enter Report End Date: Oct 24, 2006// 03302006 (MAR 30, 2006)

DEVICE: HOME// ;132

IVP Source Audit Report PAGE: 1
Run Date: Oct 24, 2006

Start Date: Mar 01, 2006

End Date: Mar 30, 2006

Division Date Record Count
442 Mar 01, 2006 47
UNKNOWN Mar 01, 2006 17

442 Mar 02, 2006 32

442 Mar 03, 2006 21

442 Mar 04, 2006 17

442 Mar 05, 2006 29

442 Mar 06, 2006 40

442 Mar 07, 2006 63
UNKNOWN Mar 07, 2006 1

442 Mar 08, 2006 48
UNKNOWN Mar 08, 2006 3
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4.3.1.8 Print Feeder Keys

Refer to Appendix A for information about feeder key transmission.

Use this option to print a list of feeder keys for a selected individual feeder system or a range of
feeder systems. For some feeder systems, you will be prompted to select the sort method (old or
new). All feeder systems prompt for a device. The output will vary slightly, depending on the
version of National Drug File (NDF) your site is running.

Example: Print Feeder Keys

Select Maintenance Option: Print Feeder Keys
Print list of Feeder Keys:

Select : 1. CLI
2. ECS
3. LAB
4. NUT
5. PHA
6. RAD
7. SUR
8. PRO

Enter a list or range of numbers (1-8): 8

Feeder Key List For Feeder System PRO Page: 1
Feeder Key Description
A4230NC INFUS INSULIN PUMP NON NEEDL/New/COM
A4265NC PARAFFIN/New/COM
A4301NC IMPLANTABLE ACCESS SYST PERC/New/COM
A4364NC ADHESIVE, LIQUID OR EQUAL/New/COM
A4465NC NON-ELASTIC EXTREMITY BINDER/New/COM
A4466NC ELASTIC GARMENT/COVERING/New/COM
A4500NC BELOW KNEE SURGICAL STOCKING/New/COM
A4556NC ELECTRODES, PAIR/New/COM
A4557NC LEAD WIRES, PAIR/New/COM
A4565NC SLINGS/New/COM
A4565NV SLINGS/New/VA

4.3.1.9 Print Feeder Locations

Use this option to print a list of feeder locations for all feeder systems. The output is sorted by
feeder location within each feeder system. This report could be lengthy, so you might want to
queue to print during non-peak hours. The only prompt is for a device.

Example: Print List of Feeder Locations

Select Maintenance Option: print
1 Print Feeder Keys
2 Print Feeder Locations

CHOOSE 1-2: 2 Print Feeder Locations
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Print list of feeder locations.
DEVICE: HOME//
Feeder Location List For Feeder System PRO Page: 7

FEEDER LOCATION DESCRIPTION

552H02 DAYTON Home Oxygen
552LAB DAYTON Prosthetics Lab
552NONL DAYTON Non Lab Location
5520RD DAYTON Ordering Location

(To save space, only a portion of the above report is shown)

4.3.2.0 Prosthetics

Choosing the Prosthetics option from the Maintenance Menu will display the following sub-
menu and options.

Example: Prosthetics Menu Options

Select Prosthetics Option: ?

Cost by PSAS HCPC Report

Prosthetic Extracts Unusual Cost Report
Prosthetics (PRO) YTD HCPCS Report
Prosthetics (PRO) YTD Laboratory Report

A WNPE

4.3.2.0.1 Cost by PSAS HCPC Report

This menu option creates a report named Cost by PSAS HCPC REPORT. The Cost by PSAS
HCPC is a prosthetics report that includes expenditures for a given time frame.

Option Name File New/Modified
Cost by PSAS HCPC Report 660 New

The Cost by PSAS HCPC Report consists of the following fields:
e PSAS HCPC - DSS Field (#30)/VistA Field (#32) on PRO extract
e Description (Free text field of 64 characters)

e HCPC

e QTY

e Unit of issue
o Cost

e Grand Total

Select Prosthetics Option: Cost by PSAS HCPC Report
Enter Report Start Date: 2/1/13 (FEB 01, 2013)
Enter Report Ending Date: (2/1/2013 - 8/26/2013): 2/28/13 (FEB 28, 2013)
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Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...

To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.
2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”

setting to at least 225 characters.
3. The DEVICE input for the columns should also contain a large enough

parameter (e.g. 225).

You may change it if need be.
Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width
and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999// HOME (CRT)

Example: Exported Cost by PSAS HCPC Report

PR AP D

The DEVICE prompt is defaulted to 0;225;99999 for you.

$ 19805.00

PSASHCPC | DESCRIPTION HCPC | QTY | UNIT OFISSUE | coOST
43501 DELIVER PO # M35565 43500 | 1 108 168.92
V2100 SINGLE VISION 43500 | 1 PAIR 33.50
V2020 FRAMES 23900 | 1 FAIR 21.00
V2735 TRANSITION 49500 | 1 PAIR 15.00
Example: Cost by PSAS HCPC Report Screen Print
Report for Jan 01, 2004 thru Jan 15, 2004
PSAS HCPC DESCRIPTION HCPC  QTY Unit of Issue
C1875 STENT L8699 1 EACH
C1875 STENT L8699 1 EACH
C1875 STENT L8699 1 EACH
C2621 PACEMAKER L8699 1 EACH
C2621 PACEMAKER L8699 1 EACH
L3060 FOOT ARCH SUPP LONGITUD/META L3060 1
L3060 FOOT ARCH SUPP LONGITUD/META L3060 1
EO0730 TENS FOUR LEAD EO0730 1
A4556 ELECTRODES A4556 5
L3700 ELBOW ORTHOSES ELAS W STAYS L3700 1
EO0730 TENS FOUR LEAD EO0730 1
A4556 ELECTRODES A4556 4
A9300 EXERCISE EQUIPMENT A9300 1
A4556 ELECTRODES A4556 5
A4556 ELECTRODES A4556 5
EO116 CRUTCH UNDERARM EACH NO WOOD EO116 1
EOl116 CRUTCH UNDERARM EACH NO WOOD EOl116 1
DL175 GLOVES, WHEELCHAIR K0108 1
A4670 AUTO BLOOD PRESSURE MONITOR A4670 1
Grand Total
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4.3.2.0.2 Prosthetic Extracts Unusual Cost Report

Select Prosthetics Option: Prosthetic Extract Unusual Cost Report

This report prints a listing of unusual costs that would be
generated by the Prosthetic extract (PRO) as determined by a
user-defined threshold value. It should be run prior to the
generation of the actual extract(s) to identify and fix, as
necessary, any costs determined to be erroneous.

Unusual costs are those where the Cost of Transaction is
greater than the threshold value.

Note: The threshold can be set after a report is selected.

Run times for this report will vary depending upon the size of
the extract and could take as long as 30 minutes or more to
complete. This report has no effect on the actual extracts and
can be run as needed.

The report is sorted by Feeder Key, then by descending Cost of
Transaction and SSN.

Enter RETURN to continue or "~" to exit:

The default threshold cost for the Prosthetic extract is $500.00.
Would you like to change the threshold?? NO// n NO

Enter the date range for which you would like to scan the Prosthetic
Extract records.

Starting with Date: 2/1 (FEB 01, 2013)
Ending with Date: 2/8 (FEB 08, 2013)

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;99999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999// HOME (CRT)
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Example: Export Prosthetic Extracts Unusual Cost Report
PCE CPT/HCPCS
CODES & CO5T OF
NAME S5M DATE OF SERVICE NMODIFIERS FEEDER KEY QUANTITY TRANSACTION
PATA OO 02/12/13 A990001 AY900NC 60 1,176.00
PATB OO 02/05/13 A990001 AY900NC & B78.00
PATC OO 02/14/13 AS90001 AYS00ONC 4 743.00

Example: Prosthetic Extracts Unusual Cost Report Screen Print

Page: 1
Report Run Date/Time: AUG 26, 2013
Threshold Value: 500

Prosthetic Extract Unusual Cost Report
Start Date: FEB 01, 2013
End Date: FEB 08, 2013

Date of PCE CPT/ Cost of
Name SSN Service HCPCS CODE & Modifiers Feeder Key Quantity Transaction
DSS1 XXXXXXXXX 02/05/13 A990001 A9900NC 00000006 $878.00
DSS2 XXXXXXXXX 02/05/13 A990001 A9900NC 00000004 $643.00
DSS3 XXXXXXXXX 02/05/13 A990001 A9900NC 00000004 $543.00

4.3.2.0.3 Prosthetics (PRO) YTD HCPCS Report

The Prosthetics YTD HCPCS Report displays data from Prosthetics extracts from the beginning
of the fiscal year to the ending data of the last extract. Data from current or previous fiscal year
may be selected for the report. The report is divided into three sections: New (i.e., Initial,
Replacement or Spare items), Repairs, and Rentals.

Sites that are multidivisional prosthetics sites must specify the Primary Prosthetics Division for
the report. The user may then choose to generate a specific report for one division or a combined
report for all divisions. The report is sorted by PSAS HCPCS Code. A print device capable of
displaying a 132-character line is needed for output.

Setup for PRO Extract YTD HCPCS Report --

ITf you belong to more than one Primary Division, you must
select a Primary Division for the report.
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NOTE: You will see the following prompt if you need to select a division:

Select Prosthetic Division: ?

Answer with INSTITUTION NAME, or *STATION NAME, or STATION NUMBER, or
OFFICIAL VA NAME, or CURRENT LOCATION

Do you want the entire INSTITUTION List? Y (Yes)

Choose from:

ALBANY ISC NY VAMC 11000
HINES 1SC 1L VAMC 14000
Select Prosthetic Division: ALBANY ISC VAMC 11000

You may select ONE or ALL of the following:

(1) 11000 ALBANY
(2) 110008  TROY

Select 0(ne) or A(ID): ALL// ONE

Which one?: 2

Select C(urrent) or P(revious) Fiscal Year: CURRENT// c CURRENT

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns*
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;99999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where O is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999// HOME (CRT)

Please note: The PRO Extract YTD HCPCS Report requires 132 columns.
Select an appropriate device for output.

Example: Exported PRO Extract YTD HCPCS Report

REPORT am TOTAL AVE any TOTAL AVE aTyr TOTAL | AVE ALL

TYPE PSAS HCPCS COmM COmM COmM VA VA VA LAB LAB LAB AVE

NEW A4301 IMPLANTABLE ACCESS 5YST | 7 3082 44029 |1 0 0 000 | 0 0 0.00 44029

NEW A4556 ELECTRODES, PAIR 17 64.16 3.77 a 0 000 | 0 0 0.00 3.77

MEW A4557 LEAD WIRES, PAIR 3 a 0.00 a 0 000 | O 0 0.00 0.00

MEW A4570 SPLINT 10 283.21 28.32 a 0 000 | 0 [1] 0.00 28.32
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Example: PRO Extract YTD HCPCS Report Screen Print

Prosthetics (PRO) Extract YTD HCPCS Report
FY Date Range: OCT 01, 2009 to JUN 30, 2010
Facility: CHEYENNE VAMC (442)
Run Date/Time: MAY 23, 2011@09:05

REPORT OF NEW PROSTHETICS ACTIVITIES (Initial, Replacement, or Spare)

Ave. $
-Comm-

Qty. Total $
PSAS HCPCS -Comm- -Comm-
A4230 INFUS INSULIN PUMP 16 659
A4258 LANCET DEVICE EACH 2 42
A4265 PARAFFIN 39 607

Prosthetics (PRO) Extract YTD HCPCS Report
FY Date Range: OCT 01, 2009 to JUN 30, 2010
Facility: CHEYENNE VAMC (442)
Run Date/Time: MAY 23, 2011@09:05

REPORT OF REPAIR PROSTHETICS ACTIVITIES

41.20
21.00
15.56

Qty. Total $
PSAS HCPCS -Comm- -Comm-
A9280 ALERT DEVICE, NOC 2 62
A9901 DELIVERY/SET UP/DISPEN 254 17234
BA212 (Unknown) 4 600
EO0250 HOSP BED FIXED HT W/ 1 0]

Prosthetics (PRO) Extract YTD HCPCS Report
FY Date Range: OCT 01, 2009 to JUN 30, 2010
Facility: CHEYENNE VAMC (442)
Run Date/Time: MAY 23, 2011@09:05

REPORT OF RENTAL PROSTHETICS ACTIVITIES

Qty. Total $
PSAS HCPCS -Comm- -Comm-
A9280 ALERT DEVICE, NOC 3494 109763
E0186 AIR PRESSURE MATTRESS 3644 36244
E0194 AIR FLUIDIZED BED 1330 99522

Qty. Total $
-VA- -VA-

0 0

0 0

0 0
Qty. Total $
-VA- -VA-

0 0

0 0

0 0

0 0
Qty. Total $
-VA- -VA-

0 0

0 0
434 32472
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Page 1
Ave. $ Ave. $
-Lab- -All-
0.00 41.20
0.00 21.00
0.00 15.56
Page 1
Ave. $ Ave. $
-Lab- -All-
0.00 31.00
0.00 67.85
0.00 150.00
0.00 0.00
Page 1
Ave. $ Ave. $
-Lab- -All-
0.00 31.41
0.00 9.95
0.00 74.83
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4.3.2.0.4 Prosthetics (PRO) YTD Laboratory Report

The Prosthetics YTD Laboratory Report displays data from Prosthetics extracts from the
beginning of the fiscal year to the ending data of the last extract. It is intended for use by

sites

that have on-site prosthetics laboratories. Data from current or previous fiscal year may be
selected for the report. The report is divided into three sections: New (i.e., Initial, Replacement,

or Spare items), Repairs and Rentals. Sites that are multidivisional prosthetics sites must
the Primary Prosthetics Division for the report.

specify

The report is sorted by PSAS HCPCS Code. It shows quantity and labor and material costs for
items within each PSAS HCPCS Code. Two sets of totals are displayed on each line: totals for
items produced for use at the local site and totals for items produced for other VA stations.

Select Prosthetics Option: Prosthetics (PRO) YTD Laboratory Report
Setup for PRO Extract YTD Laboratory Report --

I you belong to more than one Primary Division, you must
select a Primary Division for the report.

Select C(urrent) or P(revious) Fiscal Year: CURRENT// c CURRENT

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;99999 for you
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where O is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: 1In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported PRO Extract YTD Laboratory Report

REPORT PSAS HOPCS LOCAL LOCAL LOCAL MATERIAL LOCALAVE ALLOTHER  ALLOTHER  ALLOTHER

TYPE amy LABOR COST COST COST aTy LABOR COST MATERIAL COST

MNEW L1940 AFD MOLDED TO PATIENT PLAS 2 143.47 76.00 109.74 a 0.00 0.00

NEW L1560 AFD POS S0LID ANK PLASTIC 2 27.47 295.50 181.48 [1] 0.00 0.00

NEW L3000 FT INSERT UCE BERKELEY SHE 3 0.00 0.00 0.00 4} 0.00 0.00
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Example: PRO Extract YTD Laboratory Report Screen Print

Prosthetics (PRO) Extract YTD Laboratory Report Page 1
FY Date Range: OCT 01, 2008 to APR 30, 2009

Facility: BOSTON HCS VAMC (523)

Run Date/Time: MAY 23, 2011@16:43

REPORT OF NEW PROSTHETICS ACTIVITIES (Initial, Replacement, or Spare)

Produced for Station #523 Produced for all other stations
PSAS HCPCS Qty. Labor $ Mat®l $ Ave. $ Qty. Labor $ Mat®l $ Ave. $
A5105 URINARY SUSPENSORY 2 0 50 25.00 0 0 0 0.00
A5500 DIAB SHOE FOR DENSITY INSE 3 63 0 21.00 0 0 0 0.00
A5501 DIABETIC CUSTOM MOLDED SHO 2 55 0 27.73 0 0 0 0.00
Prosthetics (PRO) Extract YTD Laboratory Report Page 1
FY Date Range: OCT 01, 2008 to APR 30, 2009
Facility: BOSTON HCS VAMC (523)
Run Date/Time: MAY 23, 2011@16:43
REPORT OF REPAIR PROSTHETICS ACTIVITIES

Produced for Station #523 Produced for all other stations
PSAS HCPCS Qty. Labor $ Mat™l $ Ave. $ Qty. Labor $ Mat™l $ Ave. $
A5500 DIAB SHOE FOR DENSITY INSE 16 469 28 31.05 0 0 0 0.00
A5501 DIABETIC CUSTOM MOLDED SHO 3 112 10 40.67 0 0 0 0.00
E0144 ENCLOSED WALKER W REAR SEA 22 757 0 34.41 0 0 0 0.00
Prosthetics (PRO) Extract YTD Laboratory Report Page 1
FY Date Range: OCT 01, 2008 to APR 30, 2009

Facility: BOSTON HCS VAMC (523)
Run Date/Time: MAY 23, 2011@16:43

REPORT OF RENTAL PROSTHETICS ACTIVITIES
Produced for Station #523 Produced for all other stations
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4.3.2.1 Setup for DSS Clinic Information

Choosing the Setup for DSS Clinic Information option from the Maintenance Menu will display
the following sub-menu and options.

Example: DSS Clinic Information Menu Options

Select Setup for DSS Clinic Information Option: ?

NATIONAL CLINIC CODES FOR DSS LIST

CREATE DSS CLINIC STOP CODE FILE

CLINICS AND DSS STOP CODES PRINT

ENTER/EDIT DSS STOP CODES FOR CLINICS
APPROVE REVIEWED DSS CLINIC WORKSHEET

DSS IDENTIFIER NON-CONFORMING CLINICS REPORT
DSS CLINIC & STOP CODES VALIDITY REPORT
CLINIC EDIT LOG REPORT

O~NOUTAWNE

NOTE: The “CLINIC EDIT LOG REPORT” requires the use of the SD SUPERVISOR Security
key.

43.21.1 National Clinic Codes for DSS List

Use this option to print a list of the national clinic codes with short descriptions from the NATIONAL
CLINIC file (#728.441). The only prompt is for a device. You might want to use the output generated by
this option as a reference guide when using the following options:

o Approve Reviewed DSS Clinic Worksheet
e Enter/Edit DSS Stop Codes For Clinics

e Clinics And DSS Stop Codes Print

e Create DSS Clinic Stop Code File

Example: National Clinic List

NATIONAL CLINIC LIST NOV 18,1997 13:54 PAGE 1
CODE SHORT DESCRIPTION

AETC Ambulatory Evaluation and Treatment Center

AFCC AFC Clinic

AGTO Agent Orange

AOTH A Other

ASOR Ambulatory Surgery Performed in an OR

ASOT Ambulatory Surgery Performed in Area Other than OR
ATEM A Team

BARA Bar 203-450 Audio

BOTH B Other

[This output has been abbreviated to save space.]

4.3.2.1.2 Create DSS Clinic Stop Code File

e You can run this option at any time to add new clinics created by MAS.
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e Running this option does not affect existing data in the CLINICS AND STOP CODES
file (#728.44). This file includes the RECORD LAST SYNCHED field that holds the last
date that the Create DSS Clinic Stop Code File option was run.

e Itis recommended that this option be run on a recurrent monthly basis. The suggested
time is prior to generating the Clinic Visit Extract.

Use this option to create local entries in the CLINICS AND STOP CODES file (#728.44).

Select Setup for DSS Clinic Information Option: 2 Create DSS Clinic Stop Code File

This option creates local entries in the DSS CLINIC AND STOP CODES
file (#728.44).

The CREATE option last ran on 8/27/13.
Do you want to run the CREATE option? N// y YES

RUNNING CREATE . - . oottt e e e e et e e e e e eeccacccecaceeaec e e aaaaaaaanan

The CREATE option has completed on Aug 28, 2013@09:11:17.

Proceed to DSS Clinic and Stop Code Print menu? NO// y YES

This option produces a worksheet of (A) All Clinics, (C) Active, (1) Inactive,
or only the (U) Unreviewed Clinics that are awaiting approval.

Clinics that were defined as "inactive" by MAS the last time the option
"Create DSS Clinic Stop Code File"™ was run will be indicated with an "*".

Choose (X) for exporting the CLINICS AND STOP CODES FILE to a text file for
spreadsheet use.

**REMINDER - The CREATE option last ran on 8/28/13.
IT the most recent clinic changes from the HOSPITAL LOCATION file #44
are desired, run the CREATE option before running a report.**

Select one of the following:

ALL CLINICS

ALL ACTIVE CLINICS

ALL INACTIVE CLINICS

UNREVIEWED CLINICS

EXPORT TO TEXT FILE FOR SPREADSHEET USE

X CmOX>

Enter A", “C", "I', "U", or "X":

The software uses the following logic to create entries in the CLINICS AND STOP CODES file
(#728.44).

4.3.2.1.2.1 New Clinic Entries

The software searches the HOSPITAL LOCATION file (#44) for all clinics. It does not create
entries for clinics that are currently inactive.

New clinic entries are added to the CLINICS AND STOP CODES file (#728.44) with the
following field defaults.
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Field # Field Name Default value
1 STOP CODE STOP CODE NUMBER field (#8) in the HOSPITAL LOCATION file
(#44)
2 CREDIT STOP CODE CREDIT STOP CODE field (#2503) in HOSPITAL LOCATION file
(#44)
3 DSS STOP CODE STOP CODE NUMBER field (#8) in HOSPITAL LOCATION file (#44)
4 DSS CREDIT STOP CREDIT STOP CODE field (#2503) in HOSPITAL LOCATION file
CODE (#44)
5 ACTION TO SEND 1: SEND STOP CODE
4: SEND BOTH AS ONE RECORD WITH NATIONAL
CODE
5: SEND BOTH AS ONE RECORD WITHOUT NATIONAL
CODE
6: DO NOT SEND

4.3.2.1.2.2 Existing Clinic Entries

All preexisting clinics are checked against their counterparts in the HOSPITAL LOCATION file
(#44) to be sure that the STOP CODE field (#1) in the CLINICS AND STOP CODES file
(#728.44) matches the STOP CODE NUMBER field (#8) in the HOSPITAL LOCATION file
(#44). The same check is made on the CREDIT STOP CODE field (#2) to be sure that it matches
the CREDIT STOP CODE field (#2503) in the HOSPITAL LOCATION file (#44).

Any preexisting clinic that is currently marked as inactive in the HOSPITAL LOCATION file
(#44) is flagged as inactive in the CLINICS AND STOP CODES file (#728.44). This inactive
indicator will be displayed as an asterisk (*) beside the clinic name on the worksheet generated
by the Clinics and DSS Stop Codes Print option. Inactive clinics may still have valid past data for
DSS.

Any Stop Code changes to preexisting clinics will delete the “Last Approved” date in the
CLINICS AND STOP CODES file (#728.44). This will ensure that the edited clinics print out as
“unreviewed” the next time the clinic worksheet is generated using the Clinics and DSS Stop
Codes Print option.

4.3.2.1.3 Clinics and DSS Stop Codes Print

Use this option to produce the Worksheet for DSS Clinic Stops showing one of the following:
All DSS Clinic Stops

Active Clinic Stops

Inactive Clinic Stops

Unreviewed Clinic Stops

A clinic will be reported as “unreviewed” if it is newly established or if there is a change to stop
code/credit stop or count/non-count clinic status or active/inactive clinic status.

The columns included on the spreadsheet are:
e |EN e Clinic
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e Stop Code e Clinic Type

e Credit Stop Code e AppLen
e DSS Stop Code e Div
e DSS Credit Code e App Type
e Action e Non Cnt
e Last Review Date e QOccasion of Service (O0S)
e National Code e OOS Calling Pkg
e Inact Date e Variable Length Appt
e React Date e DSS Prod Dept
Columns listed in the Worksheet for DSS Clinic Stops printed from the screen include:
e Last approved date e DSS Stop Code
e Print Date e DSS Credit Code
e Clinic (followed by * if inactive) e Action
e Stop Code e National Code
e Credit Stop Code e C/N

Column C/ N, captures changes to a clinic’s Count / Non Count status. Values in the column
will be “C” for count or “N” for non-count on the printed report and “YES” and “NO” on the
exported report.

Only changes to the Stop Code and Credit Stop Code fields in the HOSPITAL LOCATION file
(#44) are noted.

The clinic name is truncated so that there is at least one space between the clinic name and stop
code columns.

Clinics that are inactive have an asterisk “*” after the clinic name on the printed reports only. On
the exported reports, the date the clinic was inactivated is shown. (Note: if an inactive clinic was
reactivated the reactivation date is shown.)

Select Setup for DSS Clinic Information Option: 3 Clinics and DSS Stop Codes Print

This option produces a worksheet of (A) All Clinics, (C) Active, (1) Inactive,
or only the (U) Unreviewed Clinics that are awaiting approval.

Clinics that were defined as "inactive" by MAS the last time the option
"Create DSS Clinic Stop Code File"™ was run will be indicated with an "*".

Choose (X) for exporting the CLINICS AND STOP CODES FILE to a text file for
spreadsheet use.

**REMINDER - The CREATE option last ran on 8/28/13.
IT the most recent clinic changes from the HOSPITAL LOCATION file #44
are desired, run the CREATE option before running a report.**

Select one of the following:

A ALL CLINICS
C ALL ACTIVE CLINICS
1 ALL INACTIVE CLINICS
U UNREVIEWED CLINICS
X EXPORT TO TEXT FILE FOR SPREADSHEET USE
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4.3.2.1.3.1 All Clinics Option

WORKSHEET FOR DSS CLINIC STOPS Page: 1
(last approved on 07/09/2013) Print Date:08/28/13
CLINIC STOP  CREDIT DSS DSS ACTION  NAT"L C/N

CODE  STOP STOP CREDIT CODE

( * - currently inactive) CODE CODE CODE

000 ADMIN SCHEDULING (NC) 674 674 1 N
OO0O-EYE NON TREATMENT-X 407 485 407 485 4 NONC N
000-MH NON TREATMENT-X 674 674 1 N
000-NON TREATMENT-X 301 485 301 485 4 NONC N
3S D/C CLINIC DAYS-X 674 674 4 NONC N
DAY MH PRRC GRP SST* 583 117 583 117 5 c

4.3.2.1.3.2 All Active Clinics Option

WORKSHEET FOR DSS CLINIC STOPS Page: 1
(last approved on 07/09/2013) Print Date:08/28/13
CLINIC STOP  CREDIT DSS DSS ACTION  NAT"L C/N

CODE  STOP STOP CREDIT CODE
( * - currently inactive) CODE CODE CODE
000 ADMIN SCHEDULING (NC) 674 674 1 N
OO0O-EYE NON TREATMENT-X 407 485 407 485 4 NONC N
3S D/C CLINIC DAYS-X 674 674 4 NONC N
3S D/C CLINIC EVE-X 674 674 4 NONC N

4.3.2.1.3.3 All Inactive Clinics Option

WORKSHEET FOR DSS CLINIC STOPS Page: 1
(last approved on 07/09/2013) Print Date:08/28/13
CLINIC STOP  CREDIT DSS DSS ACTION  NAT"L C/N

CODE  STOP STOP CREDIT CODE
( * - currently inactive) CODE CODE CODE
ZZ1ST TUES SLEEP SC -X* 315 470 315 470 5 C
7723 HOUR OBSERVATION-X* 291 291 1 N
77320 DR N&FS OPT-X* 123 123 4 NONC N
ZZ3N N&FS OPT-X* 123 123 4 NONC N
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4.3.2.1.3.4 Unreviewed Clinics Option

WORKSHEET FOR DSS CLINIC STOPS Page: 2
(last approved on 07/09/2013) Print Date:08/28/13
CLINIC STOP  CREDIT DSS DSS ACTION  NAT"L C/N

CODE  STOP STOP CREDIT CODE
( * - currently inactive) CODE CODE CODE
DAY MH PRP GROUP EDUCATIO 560 714 560 714 5 C
DAY PC XXXXXXXX 323 323 4 YYYYy C
DAY POLYTRAUMA/CHIROPRACT 197 436 197 436 5 C

4.3.2.1.3.5 Export Clinic Review Report Option

Select Setup for DSS Clinic Information Option: Clinics and DSS Stop Codes Print

Choose (X) for exporting the CLINICS AND STOP CODES FILE to a text file for
spreadsheet use.

Select one of the following:
A ALL CLINICS
C ALL ACTIVE CLINICS
1 ALL INACTIVE CLINICS
U UNREVIEWED CLINICS
X EXPORT TO TEXT FILE FOR SPREADSHEET USE
Enter “A", "C™, "I', "U", or "X": X

Select one of the following:

A ALL CLINICS

C ALL ACTIVE CLINICS

1 ALL INACTIVE CLINICS
U UNREVIEWED CLINICS

Enter "A™, "C", "I", or "U": U

Do you want the output in exportable format? NO// Y

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;99999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: 1In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.
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DEVICE: 0;225;99999//

Example: Exported All Clinics Spreadsheet

NOTE: For clinics that are inactive, the date that they were inactivated is listed. If an
Inactive Clinic was reactivated, the Reactivation Date has been listed.

Credit DSS DSS Last 00s  Variable DSS
Stop Stop Stop Credit Approved Nat  Inact React Clinic App App MNon Calling Length Prod
IEN Clinic Code Code Code Code Action Date Code Date Date Type Len Div Type Cnt 0O0S Pkg Appt Dept
4 DAY ORTHOPEDICS 409 409 1 03/29/13 08/27/87 11/29/89 cLI 15 1 REGULAR NO
5 HEMALOGY PRINCIPAL CLINIC-X 301 485 301 485 4 03/29/13 NONC 11/19/98 11/20/98 CLI 10 1 REGULAR YES A
8  MH CLINIC (GRP) PRINCIPAL-X 550 550 1 03/29/13 NONC 01/22/92 01/23/92 CLI 30 1 REGULAR YES v
13 OPHTHALMOLOGY PRINCIPAL-X 301 485 301 485 4 03/29/13 NONC cul 30 1 REGULAR YES A
18 CARDIOLOGY PRINCIPAL CLINIC-X 301 485 301 485 4 03/29/13 NONC 08/04/10 08/05/10 CLI 10 1 REGULAR YES
19 DERMATOLOGY PRINCIPALCLINIC 301 485 301 485 4 03/29/13 NONC 10/12/89 10/13/89 CLI 10 1 REGULAR YES
Example: Exported All Active Clinics Spreadsheet
Credit DSS DSS Last 00s  Variable DSS
Stop Stop Stop Credit Approved Nat  Inact React Clinic App App MNon Calling Length Prod
IEN Clinic Code Code Code Code Action Date Code Date Date Type Len Div Type Cnt OO0S Pkg Appt Dept
4 DAY ORTHOPEDICS 409 409 1 03/29/13 08/27/87 11/29/89 CLI 15 1 REGULAR NO
5 HEMALOGY PRINCIPAL CLINIC-X 301 485 301 485 4 03/29/13 NONC 11/19/98 11/20/98 CLI 10 1 REGULAR YES A
8 MH CLIMIC (GRP) PRINCIPAL-X 550 350 4 03/29/13 NONC 01/22/92 01/23/92 cLI 30 1 REGULAR YES A
13 OPHTHALMOLOGY PRINCIPAL-X 301 485 301 485 4 03/29/13 NONC CLI 30 1 REGULAR YES A
Example: Exported All Inactive Clinics Spreadsheet
Credit DSS D3S Last 005 Variable DSS
Stop Stop Stop Credit Approved Nat  Inact React Clinic App App MNon Calling Length Prod
IEN Clinic Code Code Code Code Action Date Code Date Date Type Len Div Type Cnt 0OS Pkg Appt Dept
28  ZZENDOCRINOLOGY-X 305 305 1 03/29/13 05/10/06 CL 15 1 REGULAR NO A
29 ZZRHEUMATOLOGY (FOLLOW) 314 314 314 314 6 03/29/13 12/27/90 CL 15 1 REGULAR NO
30 ZZADMIT/SPECIAL-X 102 301 102 301 6 03/29/13 06,/29/39 cu 10 1 NO
31 ZZMEDICAL DISCHARGE-X 1 03/29/13 03/10/99 cu 1
36 ZZDOM DISCHARGE-X 1 03/29/13 03/10/99 Ccu 1
Example: Exported Unreviewed Clinics Spreadsheet
Credit DSS  DSS Last Variable DSS
Stop Stop Stop Credit Approved Nat  Inact React Clinic App App Non 005 Calling Length Prod
IEN Clinic Code Code Code Code Action Date Code Date Date Type Len Div Type Cnt OOS Pkg Appt Dept
RADIOLOGY/
718 CT RADIOLOGY 150 150 4 4024 CLI 1 NO YES MNUCLEAR
RADIOLOGY/
2866 ANGIO 153 153 1 CLI 1 NO YES MNUCLEAR
3650 DAY MH PRP GROUP ED 560 714 560 714 5 CLI 60 1 REGULAR NO W
5756 CHITELE-DERM RT 304 690 304 69 4 AAAA CLI 30 1 REGULAR NO atzl
6818 ZZSPRMHTELEP-X 513 692 513 @92 5 03/29/13 CLI 60 2 REGULAR NO

4.3.2.1.4 Enter/Edit DSS Stop Codes for Clinics

Use this option to enter or edit the stop codes, credit stop codes and action to send codes
associated with each clinic for the DSS extract. Please note that these codes might be the same as
those associated with the clinic by MAS.
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Stop codes (also known as DSS Identifiers) are assigned a restriction type of primary, secondary
or either.

e Primary types can only be used in the primary stop code position
e Secondary types can only be used in the secondary stop code position
e Either can be used in the primary or secondary stop code position

Stop codes that have a restriction type of primary or secondary will also have a restriction date to
track when the stop code is designated as a restricted stop code. Validity checks are performed to
restrict data entry to valid values only.

The option to select how the stop codes and/or credit codes are sent can be changed. The default
is set to SEND BOTH AS ONE RECORD WITH NATIONAL CODE. The example below
shows the options that are available.

Example: Action to Send Description and Menu Choices

ACTION TO SEND: SEND BOTH AS ONE RECORD WITH NATIONAL CODE
/77
This determines how alternate stop code and alternate credit stop
codes are combined to form a feeder key for this clinic.

Choose from:

SEND STOP CODE

SEND BOTH AS ONE RECORD WITH NATIONAL CODE
SEND BOTH AS ONE RECORD WITHOUT NATIONAL CODE
DO NOT SEND

(o) 26 I

Through prompts, there is the option the option to add or edit the National Code, DSS Unit
Identifier and DSS Product Department.

Example: Enter/Edit DSS Stop Codes for a Clinic

Select Setup for DSS Clinic Information Option: Enter/Edit DSS Stop Codes for Clinics
Select CLINICS AND STOP CODES CLINIC NAME: Ambulatory Surgery
EXISTING CLINIC FILE DATA: EXISTING DSS CLINIC FILE DATA:

STOP CODE : 401 DSS STOP CODE : 401
CREDIT STOP CODE :117 DSS CREDIT STOP CODE :117

DSS STOP CODE (3-digit code only): 401// GENERAL SURGERY 401
DSS CREDIT STOP CODE (3-digit code only): 117//  NURSING (2ND ONLY) 117

...Validity Checker Complete.

ACTION TO SEND: SEND BOTH AS ONE RECORD WITH NATIONAL CODE
//

NATIONAL CODE: NONC//

DSS UNIT IDENTIFIER:

DSS PRODUCT DEPARTMENT: ??
The nationally defined DSS Intermediate Department Number designated to
the patient care product being provided.

DSS PRODUCT DEPARTMENT: 123
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4.3.2.1.5 Approve Reviewed DSS Clinic Worksheet

Use this option to approve all DSS Stop Codes and DSS Credit Stop Codes as defined in the
CLINICS AND STOP CODES file (#728.44) and to mark all currently existing entries in this file
as reviewed.

Example: Clinics and Stop Code File

This option allows you to mark the current clinic entries in the CLINICS AND
STOP CODES file (#728.44) as "reviewed". Those entries will then be omitted
from the list printed from the "Clinic and DSS Stop Codes Print" when you
choose to print only "unreviewed" clinics.

Are you ready to approve the reviewed information provided by the
"Clinic and DSS Stop Codes Print"”? NO// Y YES

Requested Start Time: NOW// <RET> (DEC 06, 1996@®10:28:25)

...approval queued
4.3.2.1.6 DSS ldentifier Non-Conforming Clinics Report

Stop codes (also known as DSS Identifiers) are assigned a restriction type of primary, secondary
or either. Primary types can only be used in the primary stop code position; secondary types can
only be used in the secondary stop code position; and those with a type of either can be used in
the primary or secondary stop code position. Stop codes that have a restriction type of primary or
secondary will also have a restriction date to track when the stop code is designated as a
restricted stop code. Clinics are validated to insure that stop codes are in compliance with
restriction types.

The DSS Identifier Non-Conforming Clinics Report option is used to print or export a listing of
the clinics that do not conform to the stop code and Four Character Code (4CHAR) restriction
types. Clinics in the CLINICS AND STOP CODE file (#728.44) are also included on the report
when they contain the following:

e A stop code is inactive or has an inactive date in the future.

e A credit stop code is inactive or has an inactive date in the future.

e A DSS stop code is inactive or has an inactive date in the future.

e A DSS credit stop code is inactive or has an inactive date in the future.
e National Code Four Character is inactive

NOTE: National Clinic Four Character code cannot be added, deleted, or modified by users.

You may choose to print or export the report for active clinics, inactive clinics, or both. The
report will list the IEN number, clinic name, primary stop code, secondary stop code, DSS
primary stop code, DSS secondary stop code, 4CHAR National Code, and the reason for non-
conformance.
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If all the selected clinics conform to the stop code and Four Character Codes restriction types,
"No problem clinics found™ is displayed on the report. If necessary, you may use the Enter/Edit
DSS Stop Codes for Clinics option to make corrections to the problem clinics.

This option reviews the Primary and Secondary Stop Codes and any existing Four
Character Codes in the Clinics and Stop Codes file #728.44.

It produces a report highlighting any nonconformance reasons that pertain

to the Primary and Secondary Codes, or the Four Character Codes if present.
Please contact the responsible party for corrective action.

4.3.2.1.6.1 DSS Identifier Non-Conforming Active Clinics

Select one of the following:

A Active Clinics
| Inactive Clinics
B Both

Select Report: a Active Clinics
Please be patient, this may take a few moments...

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;99999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported DSS Identifier Non-Conforming Clinics Report - Active

PRIMARY  SECONDARY DSSPRIMARY DSS SECONDARY 4CHAR REASOMN FOR NON-
IEN CLINIC NAME STOP CODE CREDIT CODE STOPCODE CREDIT CODE MNATIONAL CODE CONFORMAMNCE
1177 DAY FLU SHOT 323 710 323 710 BTEM 4CHAR National Code inactive
1921 PCT_G PRINCIPAL-X 323 323 BTEM ACHAR National Code inactive
20284 DAY PC GREEN RN COLE 323 117 323 117 BTEM ACHAR National Code inactive
2163 DAY PCT_G PRIME CARE PREOP 323 323 BTEM ACHAR National Code inactive

Example: Screen Print of DSS Identifier Non-Conforming Clinics Report - Active

AUG 27, 2013@14:57:18

DSS IDENTIFIER NON-CONFORMING CLINICS REPORT

Active Clinics

Page: 1

CLINICS AND STOP CODES File (#728.44) - (Use "Enter/Edit DSS Stop Codes for
Clinics®™ [ECXSCEDIT] menu option to make corrections)
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DSS DSS DSS
PRIM 2NDARY PRIM 2NDARY 4CHAR
STOP CREDIT STOP CREDIT NATIONAL REASON FOR NON-

IEN # CLINIC NAME CODE CODE CODE CODE CODE CONFORMANCE

1177 DAY FLU SHOT 323 710 323 710 BTEM 4CHAR National Code inactive
1921 PCT_G PRINCIPAL-X 323 323 BTEM 4CHAR National Code inactive
2084 DAY PC GREEN RN COLE 323 117 323 117 BTEM 4CHAR National Code inactive
2163 DAY PCT_G PRIME CARE 323 323 BTEM 4CHAR National Code inactive

4.3.2.1.6.2 DSS Identifier Non-Conforming Inactive Clinics

Select one of the following:

A Active Clinics
1 Inactive Clinics
B Both

Select Report: 1 [Inactive Clinics
Please be patient, this may take a few moments...

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns*
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;99999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: 1In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported DSS Identifier Non-Conforming Clinics Report — Inactive

PRIMARY SECOMDARY D55 PRIMARY DSS SECONDARY 4CHAR REASON FOR NON-
IEN CUMIC NAME STOP CODE CREDIT CODE STOP CODE CREDIT CODE NATIONAL CODE COMFORMANCE
257 *ZZCAMCER SUPPORT CHEMO GP-X 510 504 510 504 904 code is inactive
277 *ZZPSY JOB FINDING CLUB-X 559 558 559 558 559 code is inactive
296 *ZZARU TUES AFTERCARE-X 556 556 556 code is inactive
317 *ZZSPECIAL HEMATOLOGY-X 906 308 306 308 906 code is inactive
342 *ZZARU GR&STRESS MANAGE-X 556 556 556 code is inactive

NOTE: The Asterisk (*) before the clinic name denotes an Inactive Clinic.
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Example: Screen Print of DSS Identifier Non-Conforming Clinics Report - Inactive

AUG 27, 2013@16:27:04

DSS IDENTIFIER NON-CONFORMING CLINICS REPORT
Inactive Clinics

Page: 1

CLINICS AND STOP CODES File (#728.44) - (Use "Enter/Edit DSS Stop Codes for
Clinics®™ [ECXSCEDIT] menu option to make corrections)

DSS DSS DSS

PRIM 2NDARY PRIM 2NDARY 4CHAR

STOP CREDIT STOP CREDIT NATIONAL REASON FOR NON-
IEN # CLINIC NAME CODE CODE  CODE CODE  CODE CONFORMANCE
36 *ZZDOM DISCHARGE-X Missing primary code
36 *ZZDOM DISCHARGE-X No DSS primary code
104 *ZZAMBULATORY SURG-X 905 416 905 416 905 code is inactive
138 *ZZSUE OWEN-X 117 117 117 117 117 cannot be primary
175 *ZZCT RADIOLOGY-X 902 902 902 code is inactive
190 *ZZADMISSIONS-X Missing primary code
190 *ZZADMISSIONS-X No DSS primary code
219 *ZZDENT OPT SURGERY-X 180 429 180 429 429 cannot be secondary

NOTE: The Asterisk (*) before the clinic name denotes an Inactive Clinic.

4.3.2.1.6.3 DSS Identifier Non-Conforming Both Active and Inactive Clinics

Select one of the following:

A Active Clinics
| Inactive Clinics
B Both

Select Report: b Both
Please be patient, this may take a few moments...

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;99999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported DSS Identifier Non-Conforming Clinics Report — Both Active and Inactive

October 2013 Decision Support System V. 3.0 User Manual
Patch ECX*3.0*%144



PRIMARY SECOMDARY DSSPRIMARY DSSSECOMDARY 4CHAR NATIONAL REASOM FOR NOM-

IEN CLIMIC NAME STOP CODE CREDIT CODE STOP CODE  CREDIT CODE CODE CONFORMANCE

3066 *ZZPCT_G SIDDIQL,Z-X 323 323 BTEM ACHAR National Code inactive
3067 *ZZPCT_G POLASA,S-X 323 323 BTEM ACHAR National Code inactive
3075 DAY PCGOLD RN CORNETTE 323 117 323 117 BTEM ACHAR National Code inactive
3076 DAY PCWH-PURPLE RN COLVIN-G 323 117 323 117 BTEM 4CHAR National Code inactive
3079  *ZZIMH PSR THOMAS-X 332 125 332 125 332 code is inactive

NOTE: The Asterisk (*) before the clinic name denotes an Inactive Clinic.

Example: Screen Print of DSS Identifier Non-Conforming Clinics Report - Both Active and
Inactive

AUG 27, 2013@16:46:19 Page: 1
DSS IDENTIFIER NON-CONFORMING CLINICS REPORT
All Clinics

CLINICS AND STOP CODES File (#728.44) - (Use "Enter/Edit DSS Stop Codes for
Clinics®™ [ECXSCEDIT] menu option to make corrections)

DSS DSS DSS
PRIM 2NDARY PRIM 2NDARY 4CHAR

CLINIC NAME STOP CREDIT STOP CREDIT NATIONAL REASON FOR NON-
IEN # (*currently inactive) CODE CODE CODE CODE CODE CONFORMANCE
31 *ZZMEDICAL DISCHARGE-X Missing primary code
31 *ZZMEDICAL DISCHARGE-X No DSS primary code
32 *ZZSURGERY DISCHARGE-X Missing primary code
3930 DAY PCT_W INJECTION CLIN 323 188 323 188 BTEM 4CHAR National Code inactive
394 *ZZOPHTHALMOGOY/DEL INGER 407 No DSS primary code

NOTE: The Asterisk (*) before the clinic name denotes an Inactive Clinic.

4.3.2.1.7 DSS Clinic & Stop Codes Validity Report

The DSS Clinic & Stop Codes Validity Report is used to identify clinic setups that have become
invalid due changes that have occurred with stop codes or credit stop codes subsequent to initial
clinic setup.

The clinic’s stop codes must be active, valid, and conform to the restriction types. If any of the
following six conditions are not met, the clinic will be listed on the report with a descriptive
message explaining what needs to be updated.

e Must be active

e Must be three numeric characters in length and be valid
e Must be in the correct position for the restriction type

e Must not have matching codes

e Must not have an inactive date in the future

e Must not have an inactive 4CHAR National Code

NOTE: National Clinic Four-Character cannot be added, deleted, or modified by users.
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Example: Exported DSS Clinic and Stop Codes Validity Report

Select Setup for DSS Clinic Information Option: DSS Clinic & Stop Codes Validity
Report

This report will display stop code information of the ACTIVE
clinics in the Clinics and Stop Code file (#728.44). It will
display stop codes that do not conform to the Business Rules for
Valid Stop Codes.

Do you want the output in exportable format? NO// y YES
Gathering data for export...

To ensure all data is captured during the export:

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Dss
PRIMARY | SECONDARY | D55 SECONDARY | 4CHAR
STOP CREDIT PRIMARY CREDIT MNATIONAL REASON FOR MNON-
CODE CODE STOP CODE CODE CODE CONFORMAMNCE
323 710 323 710 BTEM ACHAR Mational Code inactive
323 323 BTEM 4CHAR Mational Code inactive
323 117 323 117 BTEM ACHAR Mational Code inactive

Example: DSS Clinic and Stop Codes Validity Report

Select Setup for DSS Clinic Information Option: DSS Clinic & Stop Codes Validity
Report

This report will display stop code information of the ACTIVE

clinics in the Clinics and Stop Code file (#728.44). It will

display stop codes that do not conform to the Business Rules for

Valid Stop Codes.

DEVICE: HOME//

DSS CLINIC & STOP CODES VALIDITY REPORT Page: 1

IEN# CLINIC NAME PRIM 2NDARY DSS DSS DSS
STOP CREDIT PRIM 2NDARY 4CHAR
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CODE STOP STOP CREDIT NATL
CODE CODE CODE  CODE

1177 DAY FLU SHOT 323 710 323 710 BTEM
ERRORS:

BTEM DSS 4CHAR National Code is inactive, please change to an active code.
1921 PCT_G PRINCIPAL-X 323 323 BTEM
ERRORS:

BTEM DSS 4CHAR National Code is inactive, please change to an active code.
64 AUDIOLOGY 203 211 110
ERRORS:

110 is an Inactive DSS Credit Stop Code
9999 DSS 4CHAR National Code is invalid, please change to a legal value.

3 PROBLEM CLINICS FOUND.

4.3.2.1.8 Clinic Edit Log Report

This option prints a log of changes made to Clinic Locations. The user will select one of the following:

1 USER NAME
2 DATE CHANGED

Example: Clinic Edit log Report

CLINIC EDIT LOG

Page 1
Printed on Apr 17, 2010@08:28:56 for 3/1/10 to 3/30/10
USER NAME DATE/TIME CHANGED CLINIC IEN CLINIC NAME Fl
ELD NAME
OLD VALUE
NEW VALUE
DSSUSER, ONE MAR 1,2010 08:41 XXXX ZZDAY C&P MARSHALL
IN
ACTIVATE
MAR 01, 2010
DSSUSER, ONE MAR 1,2010 08:44 XXXX ZZC&P MUNSEE-X
IN
ACTIVATE

MAR 01, 2010

4.3.2.2  Setup for Inpatient Census Information

Choosing the Setup for Inpatient Census Information option from the Maintenance Menu will
display the following sub-menu and options.

Example: Patient Census Information Menu Options

Select Setup for Patient Census Information Option: ?

1 Trial for Setup Extract

2 Generate the Inpatient Setup Extract

3 Active MAS Wards for Fiscal Year Print

4 Primary Care Team Print
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4.3.2.2.1 Trial for Setup Extract

Use this option to generate a printed report of the inpatient population on a selected date. The
report is sorted by inpatient ward. Within each ward, the data is sorted by patient name, SSN and
admit date. You can compare this report to reports from MAS to eliminate any problems in the
ADMISSION SETUP EXTRACT file (#727.82).

Example: Inpatient Population Report on a Selected Date

WARNING:
This is very resource intensive and should be queued to run at slack time.

This option will print the admission data and data for the last

transfer and treating specialty change for all patients who

were in the hospital on the day you select.

NOTE - This will generate a report of your inpatient population on the
BEGINNING of the day you select, not the end of the day as MAS reports do.
For example, for this report, if you choose October 1, 1994, the report will
start at midnight at the beginning of the day. For the MAS report, you would
choose September 30, 1994. The MAS report begins at midnight at the end

of the day.

Select the date : Dec 02, 1997// <RET>

This report must be queued to a 132-column printer.

DEVICE: HOME// QUEUE TO PRINT ON

Requested Start Time: NOW// <RET> (DEC 03, 1997@13:12:55)

INPATIENT WARD LIST (DSS) FOR Dec 02, 1997 FOR WARD 3E NORTH

PATIENT SSN ADMIT DATE

DSSPATIENT,ONE 000456789 Sep 02, 1997
DSSPATIENT, TWO 666456789 Apr 18, 1995
DSSPATIENT, THREE 666987654 Nov 01, 1997

4.3.2.2.2 Generate the Inpatient Setup Extract

Your site should run this option only if your site has never sent any DSS Extract data to AITC to
initialize the setup extract files listed below. Once this is accomplished, the option should not be
used again.

Use this option to generate the Inpatient Setup Extract, which creates the hospital population for
the selected DSS start date. This data is stored in the following files until it is transmitted to
AITC.

ADMISSION SETUP EXTRACT file (#727.82)

PHYSICAL MOVEMENT SETUP EXTRACT file (#727.821)
TREATING SPECIALTY CHANGE SETUP EXTRACT file (#727.822)

Example: Inpatient Setup Extract

WARNING
This is very resource intensive and should be queued to run at slack time.
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This option will extract the admission data and data for the last

transfer and treating specialty change for all patients who

were in the hospital on the day you select.

NOTE - This will generate a snapshot of your inpatient population on the

BEGINNING of the day you select, not the end of the day as MAS reports do. For
example, for the inpatient setup extract if you choose October 1, 1994, the report

will start at midnight at the beginning of the day. For the MAS report, you would
choose September 30, 1994. The MAS report begins at midnight at the end of the day.

Select the starting date : Oct 01, 1996// <RET> (OCT 01, 1996)
Requested Start Time: NOW// <RET> (DEC 17, 1996@®09:43:16)

4.3.2.2.3 Active MAS Wards for Fiscal Year Print

This option is intended to provide help for building wards in the commercial database at AITC.

Use this option to print a list of all MAS wards that were active at any time during the current
fiscal year. The only prompt is for a device. The output is formatted for 132 columns. It is sorted
by Medical Center Division and displays the following information:

e Pointer to the HOSPITAL LOCATION file (#44)
e Service and specialty associated with the ward in the WARD LOCATION file (#42)
e DSS Department code associated with the ward in the DSS WARD file (#727.4)

Example: Active MAS Inpatient Census Information

Abbreviated Sample Output

Active Wards for FY1998
Printed on SEP 28,1998@14:42

DSS Pointer Ward Ward
WARD Department to File #44 Service Specialty
DIVISION: ALBANY
2 WEST 192 MEDICINE GENERAL(ACUTE MEDICINE)
3E NORTH 129 INTERMEDIATE MED INTERMEDIATE MEDICIN
3E SOUTH 219 SURGERY SURGICAL ICU
5 WEST PS 66 PSYCHIATRY LONG TERM PSYCHIATRY(>45 DAYS)
7A GEN MED UEK1 158 MEDICINE GENERAL(ACUTE MEDICINE)
[Svc: NURSING Prod. Unit: WARD GENERAL MEDICINE/ACUTE
MEDICINE 1
DOMICILLARY 16 DOMICILIARY DOMICILIARY
NHCU 14 NHCU NHCU
OBSERVATION 234 NON-COUNT NON-DOD BEDS IN VA FACILITY
DIVISION: TROY
3 NORTH GU 6 MEDICINE GASTROENTEROLOGY
3 NORTH SURG  UF12 5 SURGERY ORTHOPEDIC

[Svc: NURSING Prod. Unit: WARDS - SURGERY 1 Div: TROY/5008B]

7B MED UEK2 81 MEDICINE CARDIOLOGY
[Svc: NURSING Prod. Unit: WARD GENERAL MEDICINE/ACUTE MEDICINE 1 Div: TROY/500B]
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4.3.2.2.4 Primary Care Team Print

Use this option to print a list of all primary care teams. The list is sorted alphabetically by team
name and displays the pointer to the TEAM file (#404.51). The intent of this option is to provide
help for building primary care teams on the commercial DSS system.

Example: Primary Care Team Print

This option prints a list of all Primary Care Teams. The list is sorted
alphabetically by TEAM name and displays the pointer to the TEAM file (#404.51).

The right margin for this report is 80.

DEVICE: HOME//
DEVICE: HOME// RIGHT MARGIN 80// <RET>

Requested Start Time: NOW// <RET> (DEC 08, 1997@13:16:22)

Primary Care Teams NOV 25,1997 10:22 PAGE 1
TEAM FILE

TEAM NAME POINTER

SAMPLE TEAM 1

4.3.2.3 Setup for Inpatient Medications Information

Choosing the Setup for Inpatient Medications Information option from the Maintenance Menu
will display the following sub-menu and options.

Example: Inpatient Medications Information Option

Select Setup for Inpatient Medications Information Option: ?

1 Print 1V Room Worksheet
2 Enter/Edit 1V Room Division
3 Pharmacy NDC Lookup

4.3.2.3.1 Print IV Room Worksheet

Use this option to print a worksheet listing all the entries in the IV ROOM file (#59.5) of the
Inpatient Medications package. This worksheet is intended to be used by the DSS Manager to
define the DIVISION (as a pointer to the MEDICAL CENTER DIVISION file [#40.8]) for each
IV room for DSS purposes.

Example: IV Room Worksheet

This option will produce a worksheet listing all entries in the IV Room file
(#59.5). It should be used to help DSS and Pharmacy services define and
review the DIVISION assignments for each 1V Room.

DEVICE: HOME// QUEUE TO PRINT ON
DEVICE: HOME// A700 RIGHT MARGIN 80// <RET>
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Requested Start Time: NOW// <RET> (DEC 03, 1997@15:53:04)

1V Room Worksheet Page: 1
Printed Dec 03, 1997

1V ROOM DIVISION INACTIVE DATE
ALBANY 1V ROOM ALBANY

TST 1SC ROOM

4.3.2.3.2 Enter/Edit IV Room Division

Use this option to create or edit entries in the DIVISION field (#.02) of the IV ROOM file
(#59.5). The purpose of the DIVISION field is to provide a way to tie outpatient IV data to a
medical center division for DSS purposes.

Example: Option for Editing Room Division

This option allows editing of the DIVISION field for IV Rooms.

Select 1V ROOM NAME: 1WEST
DIVISION: ALBANY 500

Select 1V ROOM NAME: <RET>

4.3.2.3.3 Pharmacy NDC Lookup

Refer to Appendix A for information about feeder key transmission.

Use this option to perform lookups on the local DRUG file (#50) for NDCs from DSS Pharmacy
Feeder Keys that have rejected because the first seven characters are zeros (e.g.,
"0000000051079014120™). This would occur when a pharmacy item has not been matched to the
National Drug File (NDF).

The software prompts you to enter the NDC (last twelve characters) from a rejected feeder key to
display the following information from the local DRUG file (#50) for any drug which has that
NDC.

e Local Generic Name

[ ] NDC

e Dispense Unit

e VA Classification

e Price Per Dispense Unit

The output will vary slightly, depending on the version of NDF running at your site, as indicated

in the following example:
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Example: Pharmacy NDC Lookup

Your site is running NATIONAL DRUG FILE (NDF) v4.0.
I Pharmacy data is dated after September 30, 1998,
then PHA Feeder Keys are composed of 17 numeric characters.

Ex. "12006000003073531" where characters:
1-5 (12006) pointer to VA PRODUCT NAME file (#50.68)
6-17 (000003073531) NDC from the local DRUG file (#50)

I Pharmacy data is dated prior to October 1, 1998,
then PHA Feeder Keys are composed of 19 numeric characters.

Ex. "0016006000003073531" where characters:

1-4 (0016)
5-7 (006)

pointer to the NATIONAL DRUG file (#50.6)
pointer to VA PRODUCT NAME subfile (#50.68)
of the NATIONAL DRUG file (#50.6)

NDC from the local DRUG file (#50)

8-19 (000003073531)

Enter RETURN to continue or "~" to exit: <RET>

This option will allow lookups on the local DRUG file (#50) using NDCs from DSS Pharmacy
Feeder Keys that have been rejected because the first five characters are zeros in a 17 character
Feeder Key. (Ex. "00000051079014120™) OR the first seven characters are zeros ina 19
character Feeder Key. (Ex. "0000000051079014120™)

This would occur when a pharmacy item has not been matched to the National Drug File (NDF).

Enter the NDC (last twelve characters) from a rejected feeder key to display information from the
local DRUG file for any drug which has that NDC.

Example: Selectinga NDC

Enter 12 numeric characters at the prompt or <cr> to exit. <RET>

Select NDC: 000469065771 TACROLIMUS 5MG CAP IM600  (PROGRAF) DU=CAP

TACROLIMUS 5MG CAP

NDC: 00469-0657-71 VA Classification: 1M600
Dispense Unit: CAP Price per Dispense Unit: 6.809

Enter 12 numeric characters at the prompt or <cr> to exit. <RET>

Select NDC: <RET>
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4.3.2.4 Surgery

Choosing the Surgery option from the Maintenance Menu will display the following sub-menu
and options.

Example: Surgery Menu Options

Select Surgery Option: ?
1 SUR Volume Report
2 Surgery Extracts Unusual Volume Report

4.3.2.4.1 SUR Volume Report

This menu option creates a report that lists all surgical cases that would be generated to the
Surgery Extract for transmission to the AITC for review.

Example: SUR Volume Report

SUR Volume Report Page: 1
Start Date: JAN 01, 2004 Report Run Date/Time: DEC 15, 2004
End Date: JAN 15, 2004

Case Encounter Pt. Operation Anesthesia PACU OR Clean
Name SSN Day Number Number Time Time Time Time Time
Pt Holding Principal Procedure
Time

DSS1 666755516 01/14/04 45175 50401571 41.0 37 42.0 H#it H#it
2.0 SMALL BOWEL RES

DSS2 666023326 01/08/04 45318 02384601 28.0 23 31.0 H#i H#i
4.0 AVR

DSS3 000204422 01/07/04 45420 22042011 26.0 19 27.0 H#i H#i
i 14-5 PLIF63047

DSS4 000299215 01/09/04 46333 52199211 25.0 19 26.0 H#it H#i
4.0 AAA REPAIR

DSS5 666295035 01/05/04 45776 92903561 24.0 19 26.0 6.0 H#it
4.0 MITRAL VALVE RE

DSS6 000206081 01/13/04 47182 60809101 24.0 20 25.0 H# H#
12.0 TOTAL LEFT PNEU

DSS7 666641607 01/14/04 36137 16090411 23.0 19 24.0 H# H#
4.0 RADICAL PANCREA

4.3.2.4.2 Surgery Extracts Unusual Volume Report

Surgery Extract Unusual Volume Report prints a listing of high hourly volume surgery cases.

The report prints a listing of unusual volumes that would be generated by the Surgery Extract that
is determined by a user-defined threshold value. This report shall have the capability to be run
prior to running the Surgery extract. The unusual volumes to be provided in the report are
defined by the Operation Time field, Patient Time field, or Anesthesia Time field, whichever
fields have a value greater than the defined threshold hold value. The default threshold volume
shall be 25. The default threshold volume of 25 equates to 6 hours. The report is sorted by
descending Volume and Case Number.

The Surgery Extract Unusual VVolume Report will now print records if a time segment is missing.
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Example: Surgery Extracts Unusual VVolume Report

This report prints a listing of unusual volumes that would be
generated by the Surgery extract (SUR) as determined by a
user-defined threshold value. It should be run prior to the
generation of the actual extract(s) to identify and fix, as
necessary, any volumes determined to be erroneous.

Unusual volumes are those where either the Operation Time,
Patient Time, Anesthesia Time, Recovery Room Time, OR Clean Time
or Pt Holding Time field is greater than the threshold value.
Note: The threshold can be set after a report is selected.

Run times for this report will vary depending upon the size of
the extract and could take as long as 30 minutes or more to
complete. This report has no effect on the actual extracts and
can be run as needed.

The report is sorted by descending Volume and Case Number.

Enter RETURN to continue or "~" to exit:

A print device capable of displaying a 132-character line is needed for output.
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Example: Surgery Unusual VVolume Report

The default threshold volume for the Surgery extract is 25.
The default threshold volume (25) equates to 6 hours.
Would you like to change the threshold?? NO// YES

Volume > threshold

Enter the new threshold volume: (0-99): 5

Enter the date range for which you would like to scan the
Surgery Extract records.

Starting with Date: 070107 (JUL 01, 2007)
Ending with Date: 073007 (JUL 30, 2007)
This report requires 132-column format.
DEVICE: HOME// ;132;

Surgery Extract Unusual Volume Report Page: 1
Start Date: JUL 01, 2007 Report Run Date/Time: SEP 25, 2007
End Date: JUL 30, 2007 Threshold Value: 5
Case Encounter Pt Holding Anesthesia Patient Operation PACU OR Clean Canc/ Principal
Name SSN Day Number Number Time Time Time Time Time Time Abort Procedure

No unusual volumes to report for this extract
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4.4 Package Extracts

Please refer to the current DSS Extracts v3.0 Data Definitions Guide and Extract File Formats

Manual for more information about the record layout for the extracted fields.

The Package Extracts Option was modified so that users with the Security Key ECXMGR may

rerun an extract without Information Resources Management (IRM) assistance. The user can
reschedule an extract to run again when it has already been scheduled to run, rerun an extract
was previously run, or cancel an extract that is (already) currently running and set it up to run

that

again. Use caution (and read the information being provided to you) when rerunning an extract as

it would be possible to have multiples of the same extract running simultaneously.

Example: Prompt for Rerunning an Extract
Select Package Extracts Option: PRO Prosthetics Extract

Starting with Date: 02012013 (FEB 01, 2013)
Ending with Date: 02282013 (FEB 28, 2013)

The Prosthetics information has already been extracted through Feb 28, 2013.
Do you want to continue processing the PRO extract? NO// YES

Make sure you have checked that your selected dates are correct
before answering yes to the next question.

Are you SURE you want to run the PRO extract? N// YES
Requested Start Time: NOW// (JUN 12, 2013@12:02:16)

Request queued as Task #12804.

Choosing the Package Extracts option from the Extract Managers Menu will display the
following menu and options.

NOTE: The DSS application will remove tildes (~) from extract record data prior to
transmitting them in order to avoid sending extract record data that would be recognized as
an end-of-record indicator to the AITC, except where the end-of-record is intended.

Example: Package Extracts Options on Extract Managers Menu

Select Extract Manager®s Options Option: P Package Extracts

ADM Admissions Extract
BCM BCMA Extract

LBB Blood Bank Extract
cL1 Clinic Visit Extract
ECS Event Capture Extract
1VP 1V Extract

LAB Lab Extract

LAR Lab Results Extract
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NUT Nutrition Extract
PRE Prescription Extract
ECQ QUASAR Extract
PRO Prosthetics Extract
RAD Radiology Extract
SUR Surgery Extract
MOV Transfer and Discharge Extract
TRT Treating Specialty Change Extract
UDP Unit Dose Extract
Fiscal Year Logic — DSS Testing Only

Select Package Extracts Option: Lab Extract

Extract Laboratory Information for DSS

Starting with Date: 7/1/08 (JUL 01, 2008)

Ending with Date: 7/31/08 (JUL 31, 2008)

Requested Start Time: NOW//<RET>(AUG 01, 2008@13:26:18)
Request queued as Task #300.

4.4.1. Admissions Extract (ADM)

Use this option to extract the patient admissions data for a selected date range. This data is stored
in the ADMISSION EXTRACT file (#727.802) until it is transmitted to AITC.

The mail group for this extract is DSS-ADMS. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.2. BCMA Extract (BCM)

Use this option to extract data for a selected date range. This data is stored in the BCMA
EXTRACT file (#727.833) until it is transmitted to AITC.

The mail group for this extract is DSS-BCM. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.3. Clinic Visit Extract (CLI)

Use this option to extract data for all scheduled clinic visits, add/edits and walk-ins for the
selected date range, with the following exceptions.

Non-count clinics are excluded unless specifically assigned a DSS Action Code other than 6.
Canceled clinic appointments are excluded. Clinics with an ACTION TO SEND code of 6 in
CLINICS AND STOP CODES file (#728.44) are excluded.

This data is stored in the CLINIC EXTRACT file (#727.827) until it is transmitted to AITC.
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The mail group for this extract is DSS-SCX. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.4. Event Capture Extract (ECS)

Use this option to extract the event capture data for a selected date range. This data is stored in
the EVENT CAPTURE LOCAL EXTRACT file (#727.815) until it is transmitted to AITC.

The mail group for this extract is DSS-EC. The purpose of this mail group is to receive messages
when extract is complete and when the data is transmitted to the AITC.

4.45. IV Extract (IVP)

Use this option to extract the pharmacy IV data for a selected date range. This data is stored in
the IV DETAIL EXTRACT file (#727.819) until it is transmitted to AITC.

The mail group for this extract is DSS-IV. The purpose of this mail group is to receive messages
when extract is complete and when the data is transmitted to the AITC.

4.4.6. Lab Extract (LAB)

Use this option to extract the laboratory data, including referrals and research tests, for a selected
date range. This data is stored in the LABORATORY EXTRACT file (#727.813) until it is
transmitted to AITC.

All inpatient, outpatient, and referral lab tests accessioned within the selected date range are
extracted. Lab tests can be performed on a patient in the PATIENT file (#2) or a referral patient
in the REFERRAL PATIENT file (#67). The identifying number is the SSN for in-house patients
or a selected non-SSN ID constant for referrals and research.

The mail group for this extract is DSS-LAB. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.7. Lab Results Extract (LAR)

Use this option to extract the laboratory results data for a selected date range. This data is stored
in the LAB RESULTS EXTRACT file (#727.824) until it is transmitted to AITC.

The mail group for this extract is DSS-LAB. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.8. Nutrition Extract (NUT)

Use this option to extract nutrition data for a selected date range. This data is stored in the
NUTRITION (NUT) EXTRACT file (#727.832) until it is transmitted to AITC. This extract and
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related worksheets allow DSS to capture expensive special diets, capture patient meals and
capture dietary orders. Currently only the Outpatient Meals will be transmitted in the Nutrition
Extract.

The mail group for this extract is DSS-NUT. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.9. Prescription Extract (PRE)

Use this option to extract the prescription (pharmacy outpatient) data for a selected date range.
This data is stored in the PRESCRIPTION EXTRACT file (#727.81) until it is transmitted to
AITC.

The mail group for this extract is DSS-PRES. The purpose of this mail group is to receive
messages When extract is complete and when the data is transmitted to the AITC.

4.4.10. QUASAR Extract (ECQ)

Use this option to extract audiology and speech pathology clinic visit data for a selected date
range. This data is stored in the QUASAR EXTRACT (#727.825) file until it is transmitted to
AITC.

The mail group for this extract is DSS-QSR. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.11. Prosthetics Extract (PRO)

Use this option to extract the prosthetics data for a selected date range. The data is stored in the
PROSTHETICS EXTRACT file (#727.826) until it is transmitted to AITC.

The following information is required to extract a prosthetics record.
e Station Requesting Station
e Patient Name (in Prosthetics)
e SSN
e Receiving Station
e Name (in PATIENT file (#2))
e Type of Transaction
e Delivery Date

e Source
e HCPS
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For prosthetics records that could not be extracted, you will receive a Prosthetics DSS Exception
message indicating the record IEN in the RECORD OF PROS APPLIANCE/REPAIR file (#660)
and the critical information that is missing.

The records identified in this message were not extracted and should be reviewed to determine if
they must be corrected and the extract regenerated to assure proper DSS credit is received.

If you are extracting data for a division, you can only select a primary division (as defined for
your entries in the PROSTHETICS SITE PARAMETERS file (#669.9) and the NEW PERSON
file (#200)).

The mail group for this extract is DSS-PRO. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.12. Radiology Extract (RAD)

Use this option to extract the radiology data for a selected date range. This data is stored in the
RADIOLOGY EXTRACT file (#727.814) until it is transmitted to AITC.

The mail group for this extract is DSS-RAD. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.13. Surgery Extract (SUR)

Use this option to extract the surgery data for a selected date range. This data is stored in the
SURGERY EXTRACT file (#727.811) until it is transmitted to AITC. Secondary procedures and
prostheses are also extracted.

The mail group for this extract is DSS-SURG. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.14. Transfer and Discharge Extract (MOV)

Use this option to extract all patient movement (transfers and discharge) data for the selected date
range. This data is stored in the PHYSICAL MOVEMENT EXTRACT file (#727.808) until it is
transmitted to AITC.

The mail group for this extract is DSS-MOVS. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.15. Treating Specialty Change Extract (TRT)

Use this option to extract treating specialty change data for a selected date range. This data is
stored in the TREATING SPECIALTY CHANGE EXTRACT file (#727.817) until it is
transmitted to AITC.
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The mail group for this extract is DSS-TREAT. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.16. Unit Dose Extract (UDP)

Use this option to extract all unit dose orders for the selected date range. Data is extracted from
UNIT DOSE EXTRACT DATA file (#728.904) which is populated by the Inpatient Medications
package when a pick list is filed. This data is stored in the UNIT DOSE LOCAL EXTRACT file
(#727.809) until it is transmitted to AITC.

The mail group for this extract is DSS-UD. The purpose of this mail group is to receive messages
when extract is complete and when the data is transmitted to the AITC.

4.4.17. Blood Bank Extract (LBB)

Use this option to extract blood bank data for a selected date range. This data is stored in the
BLOOD BANK EXTRACT file (#727.829) until the data is transmitted to AITC. This extract
enables DSS staff to see and manage the true economic costs of blood product use in Veterans
Health Administration (VHA).

The mail group for this extract is DSS-LBB. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.18. Fiscal Year Logic — DSS Testing Only

The Fiscal Year Logic - DSS Testing Only option allows selection of a fiscal year that may not
have the DSS logic implemented for that year. If a future year (e.g. 2015) is entered and the user
does not have the ECX DSS TEST security key, the software does not allow selection of a future
fiscal year.

ELE R R e S e S S e E R R R e R R R e e R R e e e

Use this option with caution since it will allow you to
run any supported DSS extract using specific fiscal year
logic. By running this option you may negatively impact
your extract data.

DO NOT USE this option unless you are an official test site
for the DSS Fiscal Year Conversion.

Note that this option does not update the last date used for
the given extraction. It also does not verify that the time
frame selected is after the last date used for the extract.

ook ok % X X X X Ok ok Ok ok % ¥
ook ok % X X X X ok ok ok ok % ¥

AEEAAAAAAAAAAAAAXAAAXAAAAAAXAXAAAAAAXAAAAAAAAAAXAAAAAAAXAAAA LA AAAAhhdx

Enter RETURN to continue or /" to exit:
Select DSS Extract to queue: CIINIC 1 (CLID)
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Starting with Date: 3/1 (MAR 01, 2013)
Ending with Date: 3/31/2013// (MAR 31, 2013)

Select one of the following:

2011 Fiscal Year 2011
2012 Fiscal Year 2012
2013 Fiscal Year 2013
2014 Fiscal Year 2014

Select fiscal year logic to use for extract: 2014 Fiscal Year 2014

WARNING: Logic has not been released for this year. Do not use unless directed
by DSO. Do you want to continue? YES//
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4.5 SAS Extract Audit Reports

This section contains a brief description followed by a sample output for each SAS Extract Audit
Reports option. To execute any of the SAS Extract Audit Reports options, enter the DSS Extract
Log Record Number and a printer device. Please note that in an effort to streamline the
documentation, only a portion of the output might be provided for some reports.

Please refer to the Current DSS Extracts Data Definitions Guide and Extract File Formats
Manual for more information about the record layout for the extracted fields.

45.1  SAS Extracts Audit Reports Menu

Choosing the SAS Extracts Audit Reports option from the Extract Managers Menu will display
the following menu and options.

Example: SAS Extract Audit Reports Menu on Extract Managers Menu

Select Extract Manager®s Options Option: s SAS Extract Audit Reports
PRE SAS Prescription Audit Report
RAD SAS Radiology Audit Report
SUR SAS Surgery Audit Report
Select SAS Extract Audit Reports Option:
All of the SAS Extract Audit Reports options can be executed in the following manner:
Select SAS Extract Audit Reports Option: PRE SAS Prescription Audit Report
Prescription Extract SAS Report
Select DSS EXTRACT LOG RECORD NUMBER: 187 10-06-97 Prescription
Extract: Prescription #187
Start date: JAN 01, 1997

End date: JAN 31, 1997
# of Records: 6

DEVICE: HOME//
DEVICE: HOME// RIGHT MARGIN: 80// <RET>

Requested Start Time: NOW// <RET> (DEC 02, 1997@10:48:25)
Request queued as Task #188047.
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45.2  SAS Prescription Audit Report

This option emulates the SAS routine at the AITC, which creates new records from the
Prescription (pharmacy outpatient) Extract. You can use it to print a summary report for all
records sorted by feeder location and feeder key.

Refer to Appendix A for information about feeder key transmission.

Example: SAS Audit Report for Prescription (PRE) Extract

SAS Audit Report for Prescription (PRE) Extract
DSS Extract Log #: 187

Date Range of Audit: JAN 01, 1997 to JAN 31, 1997
Report Run Date/Time: NOV 25, 1997@11:27

Division/Site: ALBANY (2) Page: 1
Feeder Location Feeder Key Quantity
PRE2 0000000000000000000 14
0038009000527100910 60
0079004000839508706 30
0151028000527109505 20
0226011000069541073 60
BASIC 6
NEWWIN 2
PREDEASP 2
VAMAIL 3

45.3 SAS Radiology Audit Report

This option emulates the SAS routine at the AITC, which creates new records from the radiology
extract. You may use it to print a summary report for all records sorted by feeder location and
feeder key. Note that bilateral modifiers will increase volumes.

Refer to Appendix A for information about feeder key transmission.

Example: SAS Audit Report for Radiology (RAD) Extract

SAS Audit Report for Radiology (RAD) Extract

DSS Extract Log #: 197

Date Range of Audit: JAN 01, 1990 to JAN 31, 1990
Report Run Date/Time: NOV 25, 1997@11:32

Division/Site: TOGUS, ME (402) Page: 1
Feeder Location Feeder Key Quantity
402-1 70100 1
402-1 70470 1
402-1 71020 5
402-1 73120 1
402-1 73620 3
402-1 73660 1
402-1 74000 1
402-1 75712 1
402-1 888888 2
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402-1 999999 2

Total for Feeder Location 402-GENERAL RADIOLOGY (402-1): 18

Grand Total for Division 402: 18

45.4  SAS Surgery Audit Report

This option emulates the SAS routine at the AITC, which creates new records from the surgery
extract. You can use it to print a summary report for all records sorted by feeder location and
feeder key.

Refer to Appendix A for information about feeder key transmission.

Example: SAS Audit Report for Surgery (SUR) Extract

SAS Audit Report for Surgery (SUR) Extract

DSS Extract Log #: 255

Date Range of Audit: MAY 01, 1997 to MAY 31, 1997
Report Run Date/Time: NOV 25, 1997@11:35

Division/Site: ALBANY (500) Page: 1
Feeder Location Feeder Key Quantity
5000RCN CARDIAC/NEURO OR 062-10 5
062-30 2
5000RCNA CARDIAC/NEURO OR - ANESTHESIA 062-23 7
5000RCNS CARDIAC/NEURO OR - SURGERY 062-40 3
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4.6 Extract Audit Reports

This section contains a brief description followed by a sample output for each Extract Audit
Reports option. To execute any of the Extract Audit Reports options, enter the DSS Extract Log
Record Number, starting and ending dates, divisions, locations, or accession areas (as
appropriate), and a printer device. There is also a narrative portion of each report that prints only
if the report is sent to a printer device. The format of the narrative is the same for all extract audit
reports, but the content will vary for each report. Please note that in an effort to streamline the
documentation, only a portion of the output might be provided for some reports.

Please refer to the current DSS Extracts Version 3.0 Data Definitions Guide for more
information about the record layout for the extracted fields.

4.6.1  Extract Audit Reports Menu

Choosing the Extract Audit Reports option from the Extract Managers Menu will display the following
menu and options.

Example: Extract Audit Reports Menu on Extract Managers Menu

Select Extract Manager®s Options Option: E Extract Audit Reports Menu

ADM Admission (ADM) Extract Audit

ECQ QUASAR (ECQ) Extract Audit

ECS Event Capture (ECS) Extract Audit

LAB Laboratory (LAB) Extract Audit

LAR Laboratory Results (LAR) Extract Audit
LBB Laboratory Blood Bank (LBB) Audit Reports..
MoV Physical Movement (MOV) Extract Audit

NUT Nutrition (NUT) Extract Audit

PRO Prosthetics (PRO) Extract Audit

RAD Radiology (RAD) Extract Audit

SUR Surgery (SUR) Extract Audit

TRT Treating Specialty Change (TRT) Extract Audit
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The following dialog for the Admission (ADM) Extract Audit Report is typical of all the audit reports and
is provided as an example.
Example: Setup for ADM Extract Audit Report
Select DSS EXTRACT LOG RECORD NUMBER: 193 10-06-97 Admission
Extract: Admission #193
Start date: DEC 01, 1996
End date: DEC 31, 1996
# of Records: 3

You can narrow the date range, if you wish.

The Start Date can"t be earlier than DEC 01, 1996,
or later than DEC 31, 1996.

Select Start Date: DEC 01, 1996// <RET> (DEC 01, 1996)

The End Date can"t be earlier than DEC 01, 1996
(the Start Date you selected), or later than DEC 31, 1996.

Select End Date: DEC 31, 1996// <RET> (DEC 31, 1996)
Do you want the ADM extract audit report for all divisions? NO// Y YES

DEVICE: HOME// QUEUE TO PRINT ON
DEVICE: HOME// A700 RIGHT MARGIN: 133// <RET>

Requested Start Time: NOW// <RET> (NOV 25, 1997@13:40:18)
Request queued as Task #186962.

Example: Admission (ADM) Extract Audit Report

DSS Extract Log #: 193
Date Range of Audit: DEC 01, 1996 to DEC 31, 1996
Report Run Date/Time: NOV 25, 1997@13:34 Page 3

AUDIT DESCRIPTION:

Verify against: Gains and Losses Sheet/Bed Status Report
Menu Option: Gains and Losses (G&L) Sheet [DG G&L SHEET]

The Gains and Losses Sheet is the primary VistA report against which ADM
extract data should be verified. However, if starting the verification
process at the beginning of the fiscal year, the Bed Status Report can also
be used. Copies of these reports are readily available from patient
administration services at most medical centers.

The G&L Sheet shows admissions by ward for a specific day. To verify the
data on the extract audit report, the verifier must accumulate the data
given on the G&L Sheet either manually or through use of a spreadsheet
application. For example, if the Admission Extract Audit Report covers

the period July 1 to July 15, then accumulate the admission data from the
G&L Sheet for each day from July 1 through July 15. The accumulated data
for a given ward (e.g., total number of admissions for Ward A during the
period) should match the figure reported on the extract audit for the same
ward and date range.

IT verification is done through the Bed Status Report, simply use the

October 2013 Decision Support System V. 3.0 User Manual 89
Patch ECX*3.0%*144



"Cumulative Totals" table which displays fiscal year-to-date totals of
interward losses and discharges by ward group. The Admission (ADM) Extract
Audit also displays totals by ward group. Some arithmetic manipulation is
needed here in order to compare the figures on the two reports. For
example, to verify data for the month of July, the user must first develop
a "Cumulative Totals"™ table for the month of July. This is done by
subtracting the figures contained in the "Cumulative Totals" table of
June 30 from the figures contained in the "Cumulative Totals" table of
July 31. (Again, this can be accomplished manually, or with the aid of a
spreadsheet application.) The resulting month of July table can then be
compared directly to the ward group totals shown on the extract audit
report generated for the period July 1 to July 31.

4.6.2 Admission (ADM) Extract Audit

Use this option to print a summary report from the ADMISSION EXTRACT file (#727.802) that
displays the number of patient admissions by ward and ward group.

Example: Admission Extract Audit Report

Admission (ADM) Extract Audit Report

DSS Extract Log #: 193

Date Range of Audit: DEC 01, 1996 to DEC 31, 1996

Report Run Date/Time: NOV 25, 1997@13:34

Medical Center Division: TROY (500B) Page: 1
Ward # of Admissions
SURGERY 0

Ward group SURGERY TOTALS subtotal: 0
3 NORTH SURG 0

Ward group NHCU TOTALS subtotal: 0
ICU/CCU 0
GEN MED 2

Ward group MEDICINE TOTALS subtotal: 2

Division TROY Grand Total: 2

4.6.3 QUASAR (ECQ) Extract Audit

Use this option to print a report from the QUASAR EXTRACT file (#727.825) file. The report
displays the number of procedures performed for patient visits to Audiology and Speech
Pathology.

Example: QUASAR Extract Audit Report

QUASAR (ECQ) Extract Audit Report

DSS Extract Log #: 192

Date Range of Audit: MAY 01, 1997 to MAY 31, 1997
Report Run Date/Time: NOV 26, 1997@10:39
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QUASAR Site: ALBANY (500) Page: 1

DSS Unit Procedure Volume
Audiology

92506 SPEECH & HEARING EVALUATION 1

92508 SPEECH/HEARING THERAPY 2
Total Volume for Audiology: 3
DSS Unit Procedure Volume
Speech Pathology

92520 LARYNGEAL FUNCTION STUDIES 1

92531 SPONTANEOUS NYSTAGMUS STUDY 1
Total Volume for Speech Pathology: 2
Grand Total for Site ALBANY (500): 5

4.6.4 Event Capture (ECS) Extract Audit

Use this option to print a summary report from the EVENT CAPTURE LOCAL EXTRACT file
(#727.815) that displays the number of procedures performed within each DSS Unit.

Select Extract Audit Reports Menu Option: ECS Event Capture (ECS) Extract Audit
Setup for ECS Extract Audit Report --
Select DSS EXTRACT LOG RECORD NUMBER: 3846 04-24-13 Event Capture
Extract: Event Capture #3846
Start date: MAR 01, 2013
End date: MAR 31, 2013
# of Records: 25554

The extract which you have chosen to audit
was transmitted to Austin/DSS on MAY 07, 2013.

Do you want to continue with this audit report? NO// y YES
You can narrow the date range, if you wish.

The Start Date can"t be earlier than MAR 01, 2013,
or later than MAR 31, 2013.

Select Start Date: MAR 01, 2013// <RET> (MAR 01, 2013)

The End Date can"t be earlier than MAR 01, 2013
(the Start Date you selected), or later than MAR 31, 2013.

Select End Date: MAR 31, 2013// <RET> (MAR 31, 2013)
Do you want the ECS extract audit report for all Locations? NO// y YES

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...

To ensure all data is captured during the export:
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1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported ECS Extract Audit Report

LOCATION  EXTRACT LOMG & DSS5UNIT CATEGORY PROCEDURE VOLUME
DAYTON (552 3794 AUDIOLOGY ECS [76) 1 Audiclogy Exam 92550 TYMPAMOMETRY & REFLEX THRESH 92
DAYTON (552 3734 AUDIOLOGY ECS [76) 1 Audiclogy Exam SPO72 PURETOME AUDICMETRY, AIRCNLY 10
DAYTON (552 3734 AUDIOLOGY ECS [76) 1 Audiclogy Exam 5PO74 SPEECH THRESHOLD TESTING 1

Example: ECS Extract Audit Report Screen Print

Event Capture (ECS) Extract Audit Report

DSS Extract Log #: 182
Date Range of Audit: JUN 01, 1997 to JUN 30, 1997
Report Run Date/Time: NOV 26, 1997@08:46
Event Capture Location: TROY (515.6) Page: 1
DSS Unit

Category Procedure Volume
DSS TEST UNIT (3)

DSS TEST ASSIGNMENT SWOO1IN CASE MANAGEMENT, 15 MIN 250
Total Volume for Unit DSS TEST UNIT (3): 250
Grand Total for Location TROY (515.6): 250

4.6.5 Laboratory (LAB) Extract Audit

Use this option to print a summary report from the LABORATORY EXTRACT file (#727.813)
that displays the volume of tests performed within each laboratory accession area.

Example: Laboratory Extract Audit Report

Laboratory (LAB) Extract Audit Report

DSS Extract Log #: 273

Date Range of Audit: APR 01, 1996 to APR 30, 1996
Report Run Date/Time: NOV 26, 1997@09:04

DSS Site: ALBANY (500) Page: 1

Accession Area (Feeder Location) LMIP LOINC # of Tests # of Tests
Procedure Code Code (Patients) (Referrals)
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SURGICAL PATHOLOGY (SP)
SP Specimen 88000.0000 1234-5 1 0

Total for SURGICAL PATHOLOGY: 1 0

4.6.6 Laboratory Results (LAR) Extract Audit

DSS collects 75 unique LAR tests. The DSS LAR Test Number range from 0001 to 0076
(NOTE: 0012 is missing). Not in extract will display in the Total Count column if there has been
no workload for a particular DSS LAR test.

Example: Laboratory Results Extract Audit Report (report abbreviated to save space)

Lab Results (LAR) Extract Audit Report

DSS Extract Log #: 4071

Date Range of Audit: AUG 01, 2011 to AUG 31, 2011

Report Run Date/Time: JUN 13, 2012@04:57

Division: CHEYENNE VAMC (442) Page: 1
Test Code DSS TEST NAME Month Year Total Count
0001 Hemoglobin AUG 2011 1842
0002 Potassium (Serum) AUG 2011 2232
0003 Sodium (Serum) AUG 2011 2174
0004 Lithium (Serum) AUG 2011 9
0005 BUN (Blood Urea Nitrogen) AUG 2011 2125
0006 WBC (Total WBC Count) AUG 2011 1751
0007 Digoxin AUG 2011 15
0008 Theophylline AUG 2011 5
0009 AST (Aspartate Transferase) AUG 2011 1494
0010 Glucose (Serum) AUG 2011 2214
0011 Creatinine Clearance AUG 2011 7
0013 GGTP (Gamma GT) AUG 2011 576
0014 Dilantin (Phenytoin) AUG 2011 23
0015 Valproic Acid AUG 2011 8
0016 Carbamazepine (Tegretol) AUG 2011 6

4.6.7 Laboratory Blood Bank (LBB) Audit Reports

There are two reports to choose from under the LBB Audit Reports. The LBB Comparative
Report can be run after the extract has run. The LBB Pre-Extract Audit Report, however, can
only be run prior to the extract which causes some sites to bypass this audit. If a discrepancy
exists, sites can correct the data and run the extract again prior to transmitting the data to AITC.

Example: LBB Audit Reports

Select Extract Audit Reports Menu Option: Laboratory Blood Bank (LBB) Audit Reports

1 Laboratory Blood Bank (LBB) Comparative Report
2 Laboratory Blood Bank (LBB) Pre-Extract Audit

4.6.7.1 Laboratory Blood Bank (LBB) Comparative Report

Select Laboratory Blood Bank (LBB) Audit Reports Option: Laboratory Blood Bank (LBB)
Comparative Report

Setup for LBB Extract Audit Comparative Report..
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Select DSS EXTRACT LOG RECORD NUMBER: 2587 06-15-09 Blood Bank
Extract: Blood Bank #2587

Start date: MAR 01, 2009

End date: MAR 31, 2009

# of Records: 139

You can narrow the date range, if you wish.

The Start Date can"t be earlier than MAR 01, 2009,
or later than MAR 31, 2009.

Select Start Date: MAR 01, 2009// (MAR 01, 2009)

The End Date can"t be earlier than MAR 01, 2009
(the Start Date you selected), or later than MAR 31, 2009.

Select End Date: MAR 31, 2009// (MAR 31, 2009)
Do you want the LBB extract comparative report to sort by COMP? NO// YES

This report requires a print width of 132 characters.
DEVICE: HOME//
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Example: LBB Extract Comparative Audit Report

Retrieving records....

LBB Extract Comparative Audit Report

01 Mar 2009 - 31 Mar 2009

—————————————————— LOCAL BLOOD BANK SOURCE

Page 1

Run Date: 29
LBB EXTRACT (#2587)

Jun 2009

Transf Number Transf Number
Name SSN FDR LOC Date COMP of Units SSN Date COMP of Units
DSS2 666201445 BB623 3/13/09 APHP 1 666201445 3/13/09  APHP 1
DSS2 666201445 BB623 3/13/09 APHP 1 666201445 3/13/09  APHP 1
DSS2 666201445 BB623 3/15/09 APHP 1 666201445 3/15/09 APHP 1
APHP TOTAL 3 APHP TOTAL 3
DSS3 000441759 BB623 3/24/09 LPC 1 000441759 3/24/09 LPC 1
DSS3 000441759 BB623 3/25/09 LPC 1 000441759 3/25/09 LPC 1
DSS4 000923659 BB623 3/5/09 LPC 1 000923659 3/5/09 LPC 1
DSS4 000923659 BB623 3/25/09 LPC 1 000923659 3/25/09 LPC 1
LPC TOTAL 4 APHP TOTAL 4
TOTAL 7 7
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4.6.7.2 Laboratory Blood Bank (LBB) Pre-Extract Audit

This report provides DSS on-site support staff with a list of unmatched blood products. The
report will contain those records that do not have a value in either the DSS Product Dept or DSS
IP # fields. The resulting report will enable the DSS on-site support team to correct the
unmatched blood products prior to running the LBB Extract.

Example: LBB Pre-Extract Audit Report

Select Extract Audit Reports Menu Option: LBB Laboratory Blood Bank (LBB) Audit
Reports

Laboratory Blood Bank (LBB) Comparative Report
Laboratory Blood Bank (LBB) Pre-Extract Audit

Select Laboratory Blood Bank (LBB) Audit Reports Option: 2 Laboratory Blood Bank
(LBB) Pre-Extract Audit

LBB Pre-Extract Audit Report Information for DSS

**NOTE: This audit can only be run prior to the LBB Extract being generated.
IT you have already generated your LBB Extract, refer to the Processing
Guide Chapter 4 section on Regenerating.**

Starting with Date: 2/1/2012 (FEB 01, 2012)
Ending with Date: 2/29/2012 (FEB 29, 2012)

Previously, you have selected queuing.
Do you STILL want your output QUEUED? Yes// N (No)
DEVICE: HOME// Right Margin: 80//

Retrieving records...

LBB Extract Audit Report Page 1

01 Feb 2012 - 29 Feb 2012 Run Date: 07 Jan 2012
Transf Number

Name SSN FDR LOC Date COMP of Units

DSSA 000054102 BB523A4 2/6/12 LRB3 1

DSSA 000054102 BB523A4 2/6/12 LRB3 1

DSSB 000224430 BB523A4 2/21/12 LRB3 1

DSSC 000403825 BB523A4 2/16/12 LRB3 1

DSSC 000403825 BB523A4 2/13/12 LPAX 1

DSSC 000403825 BB523A4 2/12/12 LPAX 1

DSSC 000403825 BB523A4 2/12/12 CR-P 10

4.6.8 Physical Movement (MOV) Extract Audit

Use this option to print a summary report from the PHYSICAL MOVEMENT EXTRACT file
(#727.808). The report displays the total count of each MAS movement type (transfers and
discharges) by ward and ward group.
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Example: Movement Extract Audit Report

Movement (MOV) Extract Audit Report
DSS Extract Log #: 184
Date Range of Audit: OCT 01, 1996 to OCT 31, 1996
Report Run Date/Time: NOV 26, 1997@09:08
Medical Center Division: ALBANY (500) Page: 1
Ward MAS Movement (Transfer) Types
1 2 3 4 13 14 22 23 24 25 26 43 44 45 Total

No Transfer data extracted for this medical center division.

Movement (MOV) Extract Audit Report

DSS Extract Log #: 184
Date Range of Audit: OCT 01, 1996 to OCT 31, 1996
Report Run Date/Time: DEC 02, 1997@11:30
Medical Center Division: ALBANY (500) Page: 2
Ward MAS Movement (Discharge) Types

10 11 12 16 17 21 27 31 32 33 34 35 37 Total
DOMICILLARY 0] 0] 0] 1 0] 0] 0] 0] 0] 0] 0] 0] 0] 0 1
2 WEST 0] 0] 0] 0] 0] 0] 0] 0] 0] 0] 0] 0] 0] 0O O
Ward group NHCU subtotals:

0] 0] 0] 1 0] 0] 0] 0] 0] 0] 0] 0] 0] 0 1
3E SOUTH 0] 0] 0] 1 0] 0] 0] 0 0] 0 0] 0] 0] 0 1
3E NORTH 0] 0] 0] 0] 0 0] 0 0 0] 0 0] 0] 0] 0 O

Ward group NHCU subtotals:

0 0 0 1 0 0 0 0 0 0 0 0 0 0 1
5 WEST PSYCH 0 0 0 0 0 0 0 0 0 0 0 0 0 0 O
NHCU 0 0 0 0 0 0 0 0 0 0 0 0 0 0 O
7A SURG 0 0 0 0 0 0 0 0 0 0 0 0 0 0 O
7A GEN MED 0 0 0 0 0 0 0 0 0 0 0 0 0 0 O
OBSERVATION 0 0 0 0 0 0 0 0 0 0 0 0 0 0 O
Division ALBANY Grand Totals:

0 0 0 2 0 0 0 0 0 0 0 0 0 0
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4.6.9  Nutrition (NUT) Extract Audit

Example: Setup for NUT Extract Audit Report

Select Extract Audit Reports Menu Option: NUT Nutrition (NUT) Extract Audit
Setup for NUT Extract Audit Report --
Select DSS EXTRACT LOG RECORD NUMBER: 2901 08-14-07 Nutrition
Extract: Nutrition #2901
Start date: JAN 01, 2007
End date: JAN 31, 2007
# of Records: 23818

The extract which you have chosen to audit
was transmitted to AUSTIN/DSS on AUG 14, 2007.

Do you want to continue with this audit report? NO// YES
You can narrow the date range, if you wish.

The Start Date can"t be earlier than JAN 01, 2007,
or later than JAN 31, 2007.

Select Start Date: JAN 01, 2007// (JAN 01, 2007)

The End Date can"t be earlier than JAN 01, 2007
(the Start Date you selected), or later than JAN 31, 2007.

Select End Date: JAN 31, 2007// (JAN 31, 2007)

Select PATIENT DIVISION: ALL//
Select one of the following:

S SUMMARY
D DETAIL

Select type of report: SUMMARY
DEVICE: HOME//

Nutrition (NUT) Extract Audit Report(Summary)

DSS Extract Log #: 2901

Date Range of Audit: JAN 01, 2007 to JAN 31, 2007

Report Run Date/Time: SEP 10, 2007@13:21

Patient Division: CHEYENNE VAMC (442) Page: 1

FEEDER KEY: T

1/0 OBS TOTAL
0 NO 274

FEEDER KEY: REGULAR

1/0 0BS TOTAL
0 NO 274
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Nutrition (NUT) Extract Audit Report (Summary)

DSS Extract Log #:
Date Range of Audit:
Report Run Date/Time:
Patient Division:

FEEDER KEY:

170
1
0]
0]

FEEDER KEY: UNKNOWN

170
1
0]

FEEDER KEY: CLEAR LIQS

170

T

OBS
NO
NO

0BS

JAN 01, 2007 to JAN 31, 2007
SEP 10, 2007@13:21

TOTAL
5638
13696
10

TOTAL
1979
2221

TOTAL

Nutrition (NUT) Extract Audit Report (Summary)

DSS Extract Log #:
Date Range of Audit:
Report Run Date/Time:
Patient Division:

FEEDER KEY: CLEAR LIQS

170
1
0

FEEDER KEY:
170

1

0
FEEDER KEY:

170
|

0BS
NO
NO

FULL LIQS

0BS
NO
NO

PUREE DYSPH

0BS
NO

JAN 01, 2007 to JAN 31, 2007
SEP 10, 2007@13:21

TOTAL
549
1590

TOTAL
589
1085

TOTAL
1345

Nutrition (NUT) Extract Audit Report(Summary)

DSS Extract Log #:
Date Range of Audit:
Report Run Date/Time:
Patient Division:

FEEDER KEY: PUREE DYSPH

1/0

0

0
FEEDER KEY:
170

1

0
0

October 2013

OBS
NO
YES

REGULAR

JAN 01, 2007 to JAN 31, 2007
SEP 10, 2007@13:21

TOTAL
1908

TOTAL
3155
9113
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FEEDER KEY: SUPP FEED
170 OBS TOTAL

Nutrition (NUT) Extract Audit Report (Summary)

DSS Extract Log #: 2901
Date Range of Audit: JAN 01, 2007 to JAN 31, 2007
Report Run Date/Time: SEP 10, 2007@13:21

Patient Division: UNKNOWN

FEEDER KEY: SUPP FEED

170 OBS TOTAL
1 NO 982
0] NO 1130

FEEDER KEY: SUPP FEED NC

170 0BS TOTAL
1 NO 917
0 NO 1091

FEEDER KEY: TF MORE 1

170 0BS TOTAL
1 NO 80

Example: NUT Nutrition Extract Audit Detailed Report

Select Extract Audit Reports Menu Option: NUT Nutrition (NUT) Extract Audit

Setup for NUT Extract Audit Report --

Page: 5

Select DSS EXTRACT LOG RECORD NUMBER: 2901 08-14-07 Nutrition

Extract: Nutrition #2901
Start date: JAN 01, 2007
End date: JAN 31, 2007

# of Records: 23818

The extract which you have chosen to audit
was transmitted to AUSTIN/DSS on AUG 14, 2007.

Do you want to continue with this audit report? NO// YES
You can narrow the date range, if you wish.

The Start Date can"t be earlier than JAN 01, 2007,
or later than JAN 31, 2007.

Select Start Date: JAN 01, 2007// (JAN 01, 2007)

The End Date can"t be earlier than JAN 01, 2007
(the Start Date you selected), or later than JAN 31, 2007.

Select End Date: JAN 31, 2007// (JAN 31, 2007)

Select PATIENT DIVISION: ALL//
Select one of the following:

S SUMMARY
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D DETAIL
Select type of report: DETAIL
Select one of the following:
1 INPATIENT
0 OUTPATIENT
B BOTH
Select patient status for report: OUTPATIENT
DEVICE: HOME//

Nutrition (NUT) Extract Audit Report (Detail)

DSS Extract Log #: 2901
Date Range of Audit: JAN 01, 2007 to JAN 31, 2007
Report Run Date/Time: SEP 10, 2007@16:14

Patient Division: CHEYENNE VAMC (442)
Patient Status: Outpatient

Prod Div: 442 Prod Fac: MAIN KITCH Prod FK: REGULAR OBS: NO

Encounter Number Del Div Del Feed Loc
10101381107003NUT 442 350
10101381107004NUT 442 350
10101381107005NUT 442 350
10101381107008NUT 442 350

Enter RETURN to continue or "~" to exit:

Nutrition (NUT) Extract Audit Report (Detail)

DSS Extract Log #: 2901
Date Range of Audit: JAN 01, 2007 to JAN 31, 2007
Report Run Date/Time: SEP 10, 2007@16:14

Patient Division: UNKNOWN
Patient Status: Outpatient

Prod Div: UNKNOWN Prod Fac: UNKNOWN Prod FK: CLEAR LIQS OBS:

Encounter Number Del Div Del Feed Loc
10101094207001INUT UNK UNK
10101094207002NUT UNK UNK
10101094207003NUT UNK UNK
10101094207004NUT UNK UNK
10101094207005NUT UNK UNK

Enter RETURN to continue or *"~" to exit:

Nutrition (NUT) Extract Audit Report (Detail)

DSS Extract Log #: 2901
Date Range of Audit: JAN 01, 2007 to JAN 31, 2007
Report Run Date/Time: SEP 10, 2007@16:14

Patient Division: UNKNOWN
Patient Status: Outpatient

Prod Div: UNKNOWN Prod Fac: UNKNOWN Prod FK: FULL LIQS OBS:

Page: 1

TOTAL: 274
Loc Type Count

-
NNNDN

Page: 16

NO TOTAL: 1590
Loc Type Count

— ===
WWwWwww

Page: 56

NO TOTAL: 1085

Encounter Number Del Div Del Feed Loc Loc Type Count
10101094207024NUT UNK UNK T 3
10101094207025NUT UNK UNK T 3
10101094207026NUT UNK UNK T 3
Enter RETURN to continue or "~" to exit:

Nutrition (NUT) Extract Audit Report (Detail)

DSS Extract Log #: 2901

Date Range of Audit: JAN 01, 2007 to JAN 31, 2007

Report Run Date/Time: SEP 10, 2007@16:14

Patient Division: UNKNOWN

Patient Status: Outpatient Page: 82
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Prod Div: UNKNOWN Prod Fac: UNKNOWN Prod FK: PUREE DYSPH OBS: NO TOTAL: 1908

Encounter Number Del Div Del Feed Loc
10101294107001INUT UNK UNK
10101294107002NUT UNK UNK
10101294107003NUT UNK UNK
10101294107004NUT UNK UNK

Enter RETURN to continue or *"~" to exit:

Nutrition (NUT) Extract Audit Report (Detail)

DSS Extract Log #: 2901

Date Range of Audit: JAN 01, 2007 to JAN 31, 2007
Report Run Date/Time: SEP 10, 2007@16:14

Patient Division: UNKNOWN

Patient Status: Outpatient

Prod Div: UNKNOWN Prod Fac: UNKNOWN Prod FK: REGULAR OBS:

Encounter Number Del Div Del Feed Loc
10101071907001NUT UNK UNK
10101071907002NUT UNK UNK
10101071907003NUT UNK UNK
10101071907005NUT UNK UNK

Enter RETURN to continue or "~" to exit:

Nutrition (NUT) Extract Audit Report (Detail)

DSS Extract Log #: 2901

Date Range of Audit: JAN 01, 2007 to JAN 31, 2007
Report Run Date/Time: SEP 10, 2007@16:14

Patient Division: UNKNOWN

Patient Status: Outpatient

Prod Div: UNKNOWN Prod Fac: UNKNOWN Prod FK: SUPP FEED OBS:

Encounter Number Del Div Del Feed Loc
10101276207001NUT UNK UNK
10101276207002NUT UNK UNK
10101276207003NUT UNK UNK

Enter RETURN to continue or "~" to exit:

Nutrition (NUT) Extract Audit Report (Detail)

DSS Extract Log #: 2901

Date Range of Audit: JAN 01, 2007 to JAN 31, 2007
Report Run Date/Time: SEP 10, 2007@16:14

Patient Division: UNKNOWN

Patient Status: Outpatient

Prod Div: UNKNOWN Prod Fac: UNKNOWN Prod FK: SUPP FEED NC OBS: NO TOTAL: 1091

Encounter Number Del Div Del Feed Loc
10101094207001INUT UNK UNK
10101094207002NUT UNK UNK
10101094207003NUT UNK UNK
10101094207004NUT UNK UNK

Enter RETURN to continue or *"~" to exit:

4.6.10 Prosthetics (PRO) Extract Audit

Loc Type Count

T 12

T 12

T 12

T 12
Page: 112

NO TOTAL: 9113

Loc Type Count

T 3

T 3

T 1

T 1
Page: 282

NO TOTAL: 1130

Loc Type Count

UNK 2

UNK 2

UNK 2
Page: 320

Loc Type Count

UNK 2

UNK 2

UNK 2

UNK 2

Use this option to print the PSAS HCPCS Cost Report from the PROSTHETICS EXTRACT file
(#727.826). Sites that are multidivisional prosthetics sites may choose to generate a specific

report for one division or a combined report for all divisions.

The report is divided into two parts and includes the following:
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Summary Detail

NPPD group summary. Individual patient detail within an NPPD Line
Data is reported in two sections: New and Repair Item.
VA, Commercial, and Total quantities. HCPCS code and description.
Total Cost and Average Commercial Cost. Delivery Date, Quantity, and Cost.
Type (i.e., VA or Commercial, Initial or
Repair).

Station Number is also displayed for
multidivisional Prosthetics sites.

Within each NPPD Group, the summary data for each | Sort order is by Delivery Date.
NPPD Line Item is displayed, followed by the group
totals. Summary totals are also provided for New and
Repair sections.

Example: Exported Summary Report for PRO Extract Audit
Select Extract Audit Reports Menu Option: PRO Prosthetics (PRO)Extract Audit

Setup for PRO Extract Audit Report --

Select DSS EXTRACT LOG RECORD NUMBER: 3897 05-22-13 Prosthetics
Extract: Prosthetics #3897
Start date: FEB 01, 2013
End date: FEB 28, 2013
# of Records: 5748
Station: DAYTON

The extract which you have chosen to audit
was transmitted to Austin/DSS on MAY 22, 2013.

Do you want to continue with this audit report? NO// y YES
You can narrow the date range, if you wish.

The Start Date can"t be earlier than FEB 01, 2013,
or later than FEB 28, 2013.

Select Start Date: FEB 01, 2013// (FEB 01, 2013)

The End Date can"t be earlier than FEB 01, 2013
(the Start Date you selected), or later than FEB 28, 2013.

Select End Date: FEB 28, 2013// (FEB 28, 2013)
Select one of the following:

D DETAIL
S SUMMARY

Type of Report: SUMMARY// s SUMMARY

Do you want the output in exportable format? NO// YES
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NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

STATIOM # EXTRACT LOG # TYPE NPPD GROUP NPPD LINE VA COM TOTAL COST AVECOM
552 3897 NEW WHEELCHAIRS AND ACCESSORIES 100 A 1 12 13 20912 1743

552 3897 NEW WHEELCHAIRS AND ACCESSORIES 100 A1 o0 2 2 0 0

252 3897 NEW WHEELCHAIRS AND ACCESSORIES 100 B o 13 13 1804 139

Example: Summary Report Screen Print for PRO Extract Audit

Prosthetics (PRO) Extract Audit Report Page 1
DSS Extract Log #: 3897

Date Range of Audit: FEB 01, 2013 to FEB 28, 2013

Station (#): 552 (DAYTON)

Report Run Date/Time: AUG 19, 2013@16:25

REPORT OF NEW PROSTHETICS ACTIVITIES
Line Item VA Com Total Cost ($) Ave Com (%)

WHEELCHAIRS AND ACCESSORIES

100 A 1 12 13 20912 1743
100 Al 0 2 2 0 0
100 B 0 13 13 1804 139

Example: Exported Detail Report for PRO Extract Audit
Select Extract Audit Reports Menu Option: Prosthetics (PRO) Extract Audit
Setup for ECS Extract Audit Report --
Select DSS EXTRACT LOG RECORD NUMBER: 3969 06-20-13 Prosthetics
Extract: Event Capture #3969
Start date: FEB 01, 2013
End date: FEB 28, 2013
# of Records: 17419

The extract which you have chosen to audit
was transmitted to Austin/DSS on JUN 20, 2013.

Do you want to continue with this audit report? NO// YES

October 2013 Decision Support System V. 3.0 User Manual 104
Patch ECX*3.0%*144



You can narrow the date range, if you wish.

The Start Date can"t be earlier than FEB 01, 2013,
or later than FEB 28, 2013.

Select Start Date: FEB 01, 2013// (FEB 01, 2013)

The End Date can"t be earlier than FEB 01, 2013
(the Start Date you selected), or later than FEB 28, 2013.

Select End Date: FEB 28, 2013//02102013 (FEB 10, 2013)
Do you want the ECS extract audit report for all Locations? NO// YES

Select one of the following:
D DETAIL
S SUMMARY
Type of Report: SUMMARY// DETAIL

1. WHEELCHAIRS AND ACCESSORIES

2. ARTIFICAL LEGS

3. ARTIFICAL ARMS AND TERMINAL DEVICES

4. BRACES AND ORTHOTICS

5. SHOES/ORTHOTICS

6. NEUROSENSORY AIDS

7. RESTORATIONS

8. OXYGEN AND RESPIRATIORY

9. MEDICAL EQUIPMENT, MISC., ALL OTHER NEW
10. REPAIR

Select NPPD Group : (1-10): 1

1. 100 A MOTORIZED
2. 100 A1 SCOOTERS

3. 100 B MANUAL CUSTOM

4. 100 C MANUAL A/0

5. 100 D  ACCESSORIES

6. 100 E CUSHION FOAM

7. 100 F CUSHION SPEC

8. 100 G CARRIERS

9. 100 H NSC VAN MODS

10. 100 1 SCOOTER ACCESSORIES

Select NPPD Line : (1-10): 1

Do you want the output in exportable format? NO// Y

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.
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DEVICE: 0;225;99999//

NFPPD
EXTRACT | MPPD STATIOM | EMTRY
LOG & GROUP | NPPDLINE NAME 55N HCPCS | OTY | TYPE | COST DATE HCPCS DESC # DATE
3801 100 A MOTORIZED | PATL wooe | KOB4E 1 1C 1600 01/03 | PWC,GP3,5T0,5LNG/SOL | 552 20121211
3801 100 A MOTORIZED | PAT2 wxx | KDB22 1 1C 1200.00 | 01/04 | PWC,GP2,5TDSLNG/S0L | 552 20121204
3801 100 A MOTORIZED | PATZ oo | KOB22 1 I1C 1200.00 | 01/07 | PWC,GP2,5TDSLNG/SOL | 552 20121130

Example: Detail Report Screen Print for PRO Extract Audit

Prosthetics (PRO) Extract Audit Report Detail Page 1
DSS Extract Log #: 3969

Date Range of Audit: FEB 01, 2013 to FEB 28, 2013

Station: 552 (DAYTON)

Report Run Date/Time: AUG 23, 2013@14:40

100 A -- MOTORIZED NPPD
NAME SSN HCPCS QTY TYP COST DATE HCPCS DESC STN# ENTRY DT
PAT5 XXXX K0848 1 1 C 1600 02/01 PWC,GP3,STD,SLNG/SOL 552 20130108
PAT6 XXXX KO0856 1 1 C 4057 02/01 PWC,GP3,STD,SNGL PWR 552 20130117
PAT7 XXXX K0856 1 1 C 2038.1502/05 PWC,GP3,STD,SNGL PWR 552 20130114

4.6.11 Radiology (RAD) Extract Audit

Use this option to print a summary report from the RADIOLOGY EXTRACT file (#727.814)
which displays the total count of each radiological procedure within a Feeder Location.

Example: Radiology Extract Audit Report

Radiology (RAD) Extract Audit Report

DSS Extract Log #: 195

Date Range of Audit: JAN 01, 1990 to JAN 31, 1990
Report Run Date/Time: NOV 26, 1997@10:47

Radiology Division: TOGUS, ME (402) Page: 1
Imaging Type (Feeder Location) # of Procedures
CPT Code Procedure Inpt. Outpt.

GENERAL RADIOLOGY (402-1)

70470 CT HEAD W&WO CONT 1 0]
71020 CHEST 2 VIEWS PA&LAT 1 2
73120 HAND 1 OR 2 VIEWS 0] 1

Sub-totals for GENERAL RADIOLOGY (402-1):
Grand Total for Division TOGUS, ME (402):

4.6.12 Surgery (SUR) Extract Audit

Use this option to print a summary report from the SURGERY EXTRACT file (#727.811). The
report displays the number of surgical procedures and surgical cases performed in O.R. and Non-
O.R. locations.
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Example: Surgery Extract Audit Report

Surgery (SUR) Extract Audit Report

DSS Extract Log #: 255

Date Range of Audit: MAY 01, 1997 to MAY 31, 1997
Report Run Date/Time: NOV 26, 1997@10:50

Surgery Division: ALBANY (500) Page: 1
0.R. Surgical Procedures
CPT Code Procedure # of Procedures
11041 DEBRIDE SKIN FULL 1
00100 ANESTH, SKIN SURGERY 1
00103 ANESTH, BLEPHAROPLASTY 1

For Division ALBANY (500)--
Total O0.R. Surgical Procedures: 3
Total O.R. Surgical Cases: 1

For Division ALBANY (500)--
Total Non-O.R. Surgical Procedures: 0
Total Non-O.R. Surgical Cases: 0

4.6.13 Treating Specialty Change (TRT) Extract Audit

Use this option to print a summary report from the TREATING SPECIALTY CHANGE
EXTRACT file (#727.817) which displays the total number of losses within each treating
specialty of a medical center service.

Example: Treating Specialty Change Extract Audit Report

Treating Specialty Change (TRT) Extract Audit Report

DSS Extract Log #: 247

Date Range of Audit: NOV 01, 1996 to NOV 30, 1996

Report Run Date/Time: NOV 26, 1997@11:09

DSS Site: ALBANY (500) Page: 1

Service Facility Treating Specialty # of Losses
Specialty (DSS Code)

DOMICILIARY DOMICILIARY PTSD
DOMICILIARY PTSD (88) 0
DOMICILLARY
DOMICILIARY (85) 0
Total for DOMICILIARY: 0
INTERMEDIATE MED GEM INTERMEDIATE
GEM INTERMEDIATE CARE (32) 0
INTERMEDIATE MED
INTERMEDIATE MEDICINE (40) 0
Total for INTERMEDIATE MED: 0
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4.7 Transmission Management

This section initiates and controls the transmission of data from the extract files to AITC. This
menu provides users with the functionality to purge the IVP, UDP, or VBECS holding files. It
also provides users with the functionality to delete an individual or range of DSS extract files.

Choosing the Transmission Management option from the Extract Managers Menu will display
the following menu and options.

Example: Transmission Management Options on Extract Managers Menu
Select Extract Manager®s Options Option: T Transmission Management

Review a Particular Extract for Transmission
Transmit Data from Extract Files

Summary Report of Extract Logs

Delete Extract Files

Purge Extract Holding Files

Recreate Extract Holding Files ...

4.7.1. Review a Particular Extract for Transmission

Use this option to review a particular extract to verify the transmission of messages to the AITC.
The only prompts are for the extract log record number and a print device. The output includes
the following information:

e Extract log record number e Transmission message numbers
e Extract name e Whether or not the extract was
e Run date purged

e Division e Message status

Example: Extract for Transmission

Select DSS EXTRACT LOG RECORD NUMBER: 465 08-13-98 Admission ALBANY
ADM Extract (#465) Records: 2

Generated: AUG 13, 1998 Start date: APR 01, 1998

Division: ALBANY End date: APR 30, 1998

DEVICE: HOME//

Status Report for DSS Extract #465 (Admission)

ADM Extract (#465) Records: 2

Generated: AUG 13, 1998 Start date: APR 01, 1998
Division: ALBANY End date: APR 30, 1998
Purged: (Not purged)

Transmitted: AUG 17, 1998
Unconfirmed transmission message numbers --

202 208 209

200100 200101 200102

200103 200104 200105

200106 200107 200108
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200109 200110 200111

200112 200113 200114
200115 200116 200117
200118 200119 200120
200121 200122 200123
200124 200125 200126
200127 200128 200129
200130 200131 200132
200133 200134 200135

4.7.2. Transmit Data from Extract Files

To receive mail messages confirming transmission of extract data, you must be enrolled in the
DSS mail group associated with the extract being transmitted.

Use this option to transmit a series of mail messages containing data from an individual extract
to the AITC. Members of the associated mail group(s) will receive confirmation messages
indicating that an extract was completed, transmitted, and received in Austin. You can only
transmit extracts for your division.

Example: Transmit Data from Extract Files

Select Transmission Management Option: T Transmit Data from Extract Files

Your user setup will only allow you to transmit extracts from the following divisions:
SITE LOCATION NAME

ITf you can"t select an extract, it is probably from another division.

Transmit which extract: 2604 08-09-06 Admission
ADM Extract (#2604) Records: 117
Generated on: AUG 09, 2006 Start date: MAR 01, 2006
Division: DIVISION NAMR End date: MAR 31, 2006

The data was extracted using fiscal year 2006 logic.
Mai IMan transmission of the Admission extract is set to a
Limit of 131,000 bytes per message. Each extract record ends with a "~.

** This extract is being sent from a field office domain. **
** Extract message(s) will only be delivered to you and *x
** will be placed into your "DSSXMIT" mail basket. *x

Requested Start Time: NOW// (OCT 24, 2006@15:09:49)
Request queued as Task #33798.

Example: Sample Mail Message - Completed Extracted Data

Subj: 444 - Admission EXTRACT FOR DSS [#7058653] 14 Sep 99 19:03 8 lines
From: DSS SYSTEM In "IN" basket. Page 1

The DSS-Admission extract (#759) for Jul 01, 1999
through Jul 31, 1999 was begun on Sep 14, 1999 at 19:02
and completed on Sep 14, 1999 at 19:03.
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A total of 489 records were written.

Extract time was [HH:MM:SS] 0:00:48

Enter message action (in IN basket): IGNORE//

Sample Mail Message - Transmission of Extracted Data

Subj: 444 - QUASAR EXTRACT FOR DSS [#7058779] 05 Oct 99 03:16 10 lines
From: DSS SYSTEM In "IN" basket. Page 1

The DSS QUASAR (ECQ) extract, #786,
was transmitted on Oct 05, 1999 at 03:15.

Maximum number of lines (records) per message: 200

A total of 861 records were written.
A total of 5 messages were sent.
Message numbers :
7058774 7058775 7058776 7058777
7058778

Enter message action (in IN basket): IGNORE//
Sample Mail Message - Confirmation of Extracted Data

Subj: DRS1928 DMS Confirmation [#415417] 03 Dec 97 20:10 CST 2 Lines
From: <XXXXXXXX@XXXXXXXX.VA.GOV> in "IN" basket. Page 1

Ref: Your DMS message #841928 with Austin 1D #80378631,is assigned confirmation
number 942512003079972.

Enter message action (in IN basket): IGNORE//

4.7.3. Summary Report of Extract Logs

Use this option to print a summary report from the EXTRACT LOG file (#727). The only
prompts are for starting and ending dates and a print device. The output includes the following
information:

e Extract number e Date purged

e VistA Package e Date Extracted

e Data set dates (date range) e Data Month

e Record count e Msg Unconf (Message Number)
e Date transmitted e Requestor

The report prints properly to a 132-column output

Example: Summary Report Extract Logs

Select Transmission Management Option: s Summary Report of Extract Logs
Enter Report Start Date: 030106 (MAR 01, 2006)
Enter Report Ending Date: (3/1/2006 - 10/26/2006): 060106 (JUN 01, 2006)

** REPORT REQUIRES 132 COLUMNS TO PRINT CORRECTLY **

DEVICE: HOME// ;132;
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DSS EXTRACT LOG STATISTICS

Page: 1

EXTRACT NUMBER VISTA PACKAGE DATA SET DATES RECORD COUNT DATE DATE PURGED
DATE EXTRACTED DATA MONTH MSG UNCONF REQUESTOR TRANSMITTED
2179 Admission 060301-060331 O

Jul 26, 2006 Mar 2006 0 USER,ONE
2186 Prescription 060601-060630 0

Jul 27, 2006 Jun 2006 0 USER, TWO
2185 Unit Dose 060601-060630 O

Jul 27, 2006 Jun 2006 0 USER, TWO

4.7.4. Delete Extract Files

This option can be used to delete individual extracts residing in files (#727.802) through
(#727.833) or a range of extracts. Also, holders of the ECXMGR Security Key may only delete
extracts that are associated with a division assigned in the NEW PERSON file (#200).

Any existing extract may be deleted (including transmitted and untransmitted) and extracts that
did not run to completion due to errors or system problems.

Choosing a range of extracts could mean an excessively large number of records to be deleted
and it may be very resource intensive. Please be sure to queue this for non-peak hours and limit
the number of extracts to be deleted in a single queued session.

Example: Delete Extract File Option

This option will allow you to delete an
individual or a range of DSS extracts files.

Care must be taken for several reasons:

- You can delete ANY existing extract. This includes transmitted and non-
transmitted extracts as well as extracts that did not run to completion
due to errors or system problems.

- Choosing a range of extracts could mean an excessively large number
of records and be very CPU intensive.

Please be sure to queue this deletion for off-hours and
limit the number of extracts to be deleted per a single queued session.

Delete Extract Files?? NO// y YES

...one moment please

Do you want to print a list of extracts that can be deleted? NO//

You will not be able to select an extract that is not from your division.

Select extracts to be deleted: (3794-4071): 3794

I will delete the following extract(s):
#3794 - Event Capture 01/01/2013 to 01/31/2013

Is this OK? NO// YES
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4.7.5.Purge Extract Holding Files

Use this option to purge the data that resides in the holding files for the IVP, UDP, or VBECS
extracts. A prompt will appear for the start and end dates. Dates can be entered as 10 15 08,
10/15/08, or 10/15/2008.

The IV EXTRACT DATA file (#728.113) and UNIT DOSE EXTRACT DATA file (#728.904)
can become quite large if appropriate purging is not performed. This option will purge the data
from these files by date range. It is recommended that records over two fiscal years old be purged
from IV EXTRACT DATA file (#728.113) and UNIT DOSE EXTRACT DATA file (#728.904).

VBECS holding files can also be purged. Once purged, these files cannot be recreated for that
time period.

Purging of any local VistA extract data or VistA source of extract data (i.e., lab data, etc.) is not
recommended until your facility has successfully created extracts, transmitted them to the AITC,
audited the counts, loaded the data into DSS, and is content with the results.

When the Purge ends, a confirmation message will be created on MailMan.

Example: Purge Holding Files

Select Transmission Management Option: Purge Extract Holding Files

This option will allow you to purge:
1. data that resides in the "holding files" for the IVP and UDP extracts.
2. data that resides in the "holding file"™ for the VBECS extract

Care must be taken for several reasons:

- The 1VP, UDP and VBECS "holding"™ files are intermediate files that
are populated "realtime"™ by inpatient pharmacy and VBECS activity.
These files are then used to generate the IVP, UDP and VBECS extracts.
NOTE: The VBECS files CANNOT be regenerated.

Once it is purged for a date range, extracts can no longer be
generated for that time period.

Purge (1)VP data, (U)DP data or (V)BECS data? IVP Holding File

This file currently holds IVP data from <Oct 13, 1999> to <Apr 01, 2013>.

Beginning date for purge: 1/1/13 (JAN 01, 2013)
Ending date for purge: 1/31/13 (JAN 31, 2013)

I will purge the 1VP holding file from <Jan 01, 2013> to <Jan 31, 2013>.

Is this OK? NO// y YES

Example: Confirmation Message
Select Transmission Management Option: MailMan Menu
VA MailMan 8.0 service for XXXXXXX@XXXXX.PRE-PROD.VISTA.MED.VA.GOV

You last used MailMan: 10/28/08@11:57
You have 1 new message.-
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NML New Messages and Responses
RML Read/Manage Messages
SML Send a Message
Query/Search for Messages
AML Become a Surrogate (SHARED,MAIL or Other)
Personal Preferences ...
Other MailMan Functions ...
Help (User/Group Info., etc.) ...
Super Search Message File

You have 1 new message. (Last arrival: 10/28/08@15:01)
Select MailMan Menu Option: n New Messages and Responses

Subj: DSS - Purge of 1VP Holding File [#560578] 10/28/08@15:01 3 lines
From: DSS SYSTEM In "IN" basket. Page 1 *New*

The information has been successfully PURGED
from Feb 01, 2007 to Feb 02, 2007

Enter message action (in IN basket): lIgnore// <RET>

Select Transmission Management Option: ?
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4.7.6. Recreate Extract Holding Files

Use this option to recreate an IVP or UDP Extract holding file which has been purged at the
AITC. You will be prompted for the start and end dates. A background task will be launched.
When that task ends, it will create a confirmation message on MailMan.

It is unusual to purge and recreate these files. They normally are NOT purged.
The Recreate applies to the entire parent station.

To recreate an IVP or UDP extract,
1. Run the Purge for the desired date range.
e Dates can be entered as 10 15 08 or 10/15/08 or 10/15/2008.

2. Check MailMan for a confirmation message that the Purge has completed
successfully.

3. Run the Recreate for the same date range.
e If you did not run the Purge and data exists for the requested time period, you will
be prompted to do so.

4. Check MailMan for a confirmation message that the Recreate has completed
successfully.

5. Run the IVP or UDP Extract.

6. Compare the record count from the recreated extract to the record count of the
original extract. The counts should be close but may be slightly different due to
timing issues.

Example: Example of Recreate

Select Transmission Management Option: Q Recreate Extract Holding Files
Select File to Recreate: ?

| Recreate IVP Extract Holding File (#728.113)
U Recreate UDP Extract Holding File (#728.904)

Select Recreate Extract Holding Files Option: 1 Recreate IVP Extract Holding File
(#728.113)

Enter Start Date: 2 1 07

Enter Stop Date: 2 1 07

Requested Start Time: NOW//<RET> (SEP 09, 2008@13:31:43)

Request queued as Task #155353.

Requested Start Time: NOW//<RET> (OCT 28, 2008®15:04:37)

Request queued as Task #2607.

When the Recreate is complete, a MailMan message will be sent to you. To view the message,
type “MailMan Menu” at the prompt. You will see the following lines.
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Example of Confirmation Message for Recreate
Select Transmission Management Option: MailMan Menu

VA MaillMan 8.0 service for XXXXX.XXXXX@XXXXX.XXXXXX.VISTA.MED.VA.GOV
You last used MailMan: 10/28/08@11:57
You have 1 new message.

NML New Messages and Responses
RML Read/Manage Messages
SML Send a Message
Query/Search for Messages
AML Become a Surrogate (SHARED,MAIL or Other)
Personal Preferences ...
Other MailMan Functions ...
Help (User/Group Info., etc.) ...
Super Search Message File

You have 1 new message. (Last arrival: 10/28/08@15:01)
Select MailMan Menu Option: n New Messages and Responses

Subj: 1V INTERMEDIATE DATA FOR DSS [#560579] 10/28/08@15:05 5 lines
From: DSS SYSTEM In "IN" basket. Page 1 *New*

The 1V information has been successfully regenerated
from Feb 01, 2007 to Feb 01, 2007@99:99

A total of 151 records were written.
Enter message action (in IN basket): Ignore// <RET>

Select Transmission Management Option: ?
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5 Glossary

Term

Definition

Action to Send Code

Indicates which code should be sent to the DSS commercial software
(e.g., stop code, credit stop code, or both).

ADPAC Acronym for Automated Data Processing Application Coordinator
ADM Abbreviation for Admission Extract

AITC Acronym for Austin Information Technology Center

BCM Abbreviation for BCMA Extract

BCMA Acronym for Bar Code Medication Administration

CBOC Acronym for community Based Outpatient Clinic

CLI Abbreviation for Clinic Extract

CPT Acronym for Common Procedure Terminology

Credit Stop Code

The credit stop code (from the HOSPITAL LOCATION file [#44]) as
determined by Medical Administration Service (MAS).

CSHD Acronym for Customer Support Help Desk
DSO Acronym for Decision Support Office
DSS Acronym for Decision Support System

DSS Credit Stop Code

The credit stop code as determined by DSS.

DSS Department Code

A code associated with products or services, which assists in the
categorization and costing of those products. At this time, only
medical center wards are being associated with a DSS Department
code in the DSS WARD file (#727.4). The DSS Department code
consists of a minimum of 4 characters as:

ABBCxxx

A =DSS CODE in NATIONAL SERVICE file (#730)

BB = DSS PRODUCTION UNIT CODE in DSS PRODUCTION
UNIT file (#729)

C =DSS DIVISION IDENTIFIER in DSS DIVISION IDENTIFIER
file (#727.3)

xxx = A suffix of not more than three characters which must be
numeric digits or uppercase alpha characters. The first character of the
string may be "-", but that is not recommended.

DSS Division Identifier

A single character code, either numeric (but not zero) or an uppercase
alpha character. The character used in VistA file #727.3 (DSS
DIVISION IDENTIFIER) as division identifier should exactly match
the identifier associated with a medical center division in DSS/Austin.

DSS Production Unit

A two character code which may contain both numeric and uppercase
alpha characters. These DSS-compatible codes are based on the FMS
sub-cost center scheme to categorize production unit output. The DSS
PRODUCTION UNIT file (#729) holds the production unit codes
approved for use by DSS.

DSS Stop Code The stop code as determined by DSS.

ECS Abbreviation for Event Capture Extract

ECQ Abbreviation for QUASAR Extract

October 2013 Decision Support System V. 3.0 User Manual 116

Patch ECX*3.0%144




Term

Definition

Extract

Management tool used to track and account for procedures and
delivered services, which are not handled in any existing VistA
package.

Extract Files

The files that hold the data that has been extracted via the DSS Extract
software.

Feeder Key The product for workload extracted.

Feeder Location The site location of data extracted.

IVP Abbreviation for IV Detail Extract

LAB Abbreviation for Laboratory Extract

LAR Abbreviation for Lab Results Extract

LBB Abbreviation for Blood Bank Extract

MAS Acronym for Medical Administration Service

MOV Abbreviation for Transfer and Discharge Extract

NDC Acronym for National Drug Code

NDF Acronym for National Drug File

NUT Abbreviation for Nutrition Extract

PRE Abbreviation for Prescription Extract

PRO Abbreviation for Prosthetics Extract

Provider The actual provider of care performing the procedure. This provider
can be a doctor, nurse, technician, or any designated team of medical
professionals.

QUASAR Acronym for Quality: Audiology and Speech Pathology Audit &
Review

RAD Abbreviation for Radiology Extract

SSN Acronym for Social Security Number

Stop Code The stop code (from the HOSPITAL LOCATION file [#44])as
determined by Medical Administration Service (MAS).

SUR Abbreviation for Surgery Extract

TRT Abbreviation for Treating Specialty Change Extract

UDP Abbreviation for Unit Dose Local Extract

VA Acronym for Department of Veterans Affairs

VHA Acronym for Veterans Health Administration

VistA Acronym for Veterans Health Information Systems and Technology
Architecture

Volume Volume is associated with the number of procedures performed or the
length of time actually spent performing the procedures.

YTD Acronym for Year-to-Date
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Appendix A - Feeder Key Transmission

The Feeder Key for the Clinic Extract is transmitted in the following format.
SSSCCCTTTPPPP

These characters are determined by the Action To Send code as indicated in the following table.

Action to Send Code Description

1 SSS is the stop code.
CCC=000.
TTT is the length of appointment.
PPPP=0000.

2 SSS is the credit stop code.
CCC=000.
TTT is the length of appointment.
PPPP=0000.

3 Two records are sent:
For the first: For the second:
SSS is the stop code. SSS is the credit stop code.
CCC=000. CCC=000.
TTT is the length of TTT is the length of the appointment.
appointment. PPPP=0000.
PPPP=0000.

4 SSS is the larger of the stop code or the credit stop code.
CCC is the smaller of the stop code or the credit stop code.
TTT is the length of appointment.
PPPP is the pointer to the HOSPITAL LOCATION file.

5 SSS is the larger of the stop code or the credit stop code.
CCC is the smaller of the stop code or the credit stop code.
TTT is the length of appointment.
PPPP=0000.
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Appendix B - Create a LAR Translation Table

A translation table is required to convert entries in the results field of the LAR extract from a free
text to a numeric value for all types of lab tests. The translation table is a new table for the DSS
VistA Extract Package. LAR TRANSLATION TABLE will convert free text results to a numeric
value for all lab tests.

The translated numeric values are:

0- Negative, Non-Reactive.

1- Positive, Reactive.

2- Borderline, Indeterminate.

3- Test not Performed, Qty not sufficient or other reason.
5- Result cannot be translated.

The Lab results free text field contains many different coding schemes to indicate whether the
results are negative or positive. The list of text with the translated values is as follows:

RAW Translation RAW Translation
Negative 0 EQUIV 2
Positive 1 NRG 5
NEGATIVE 0 N 0
POSITIVE 1 R 1
Neg 0 Borderline 2
Pos 1 NEG. 0
nonreactive O POS. 1
NONREATIVE 0 ND 0
reactive 1 Reactive 1
REACTIVE 1 Detected. 1
NEG 0 React 1
POS 1 Nonreact 0
NOTDET 0 WK POS 1
DETEC 1 +/-=pos 2
NON REAC 0 LSG 5
REAC 1 Reactive* 1
WK .POS 1 =+pos 1
WK.POS. 1 NEGATIV 0
NEG# 0 ND 0
POS# 1 INCONC. 2
BRDLINE 2 DONE 5
NR 0 NEH 5
Non-react 0 MEG 5
BRDLNE 2 P 1
**pos 1 NRG 5
***pos 1 Repeat 2
BDL 2 NE 5
EQUIVOCAL 2 NGE 5
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RAW Translation
REM

NRE

See com
See rpt
Reac
NREACT
Type 1
2b

3a

BAS

N-1
Pend
RPC

QNS

FFT

ORUIFPWUIOOOOIUTUIORFR,UIUIO1O 01

Note:

Any value not in the table should return a “5”.

The sites will be responsible for maintaining/updating the table.
Translations cannot change the meaning of the free text field.

Non-numeric reported values for all tests would be stored in the translation field and available to
Ad Hoc and SQL.

In many cases, it may take a long time to run this report (possibly more than an hour or two).
Your screen may be tied up for some time once you set the report to run.
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Appendix C — Exporting a Report to a Spreadsheet

1. Select Display from the Setup menu.

File Edit Connection [Setup| Macro Window Help
D& | & Temnol s BPEE N

Display...
Ewvents...

File Transfer...
Hotspot...
Keyboard Map...
Menu...

Mouse Map...
Safequards...

Toolbar...
View Settings...

Defaults

2. On the Screen tab, modify the number of Columns to at least 225. Click OK.

2 x
| Colors | Fonts | Soreen | Options |
Rows: 24 ::. Columns: (7 80 Shape: [V Binks
© 132 ] visble
I Auto Resize Sor @ 25 3]
g Conftrol characters
Display memory @ Interpret ) Display
vemery s 9 [5] (B sl
@ @ Jump Jump scroll speed:
") Smooth
g X | Cocd || Hebo |
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3. Select Logging... on the File menu.

File | Edit Connecticn Setup Macre Window Help

MNew Session... [ ] ‘ e | B | h?

Open...

Save vista.dss.dayton.preprod.med.va.gov

Save As..

Import and Export 3
Layout 3

Save Display As...
Properties...
Transfer...
Loegging...
Print...

Print Setup...

Page Setup...

Close Printer
Send...

Exit

Exit All

| Log text from a host to a printer or a file

m

4

4. On the Logging popup, click to select Logging on. Then, select the Disk option and name

the file. Click Browse...

e

/| Logging on
Log output to

| B | A=
[ Printer ;Smd To OneNote 2010

| Print Setup.

[V] Disk
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5. Select the folder where the text file will be saved and click Save.

e E
Date modiified

Mo items match your search.
Recent Places

Desktop

Libraries

PRO Extract [fTD HCPCS Report
Save as type: [_TudFlu

6. The file will be created in the folder identified.

Organize »  Includein library »  » = o
A - = Mame )
W Favorites
B Desktop ﬂ || PRO Extract ¥TD HCPCS Report
B Downloads
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7. Press Enter on your keyboard to keep the parameters at the DEVICE: 0;225;99999// prompt.

8. Once the running of the report has completed, to turn off the logging select Logging... on
the File menu. On the Logging popup, click to deselect Logging on.

2] Printes @sm To OneNote 2010

[ Disk

[] Setial device: NOME

9. Open a new Excel workbook. Click the Data tab and select From Text.

Homea Insert Pal;e Layout Formulas Review
(4] From Access = ) _\I 3] Connections Al E
g From Web S —U

o Properties |

From Other | Existing Refresh _ £} sort
FromText  Spurces»  Connedtions | an~= = Edit Lin
Get External Data Connections 5
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10. Navigate to the folder where the file was created. Select the text file that was created and click

Import.

Seorch D38 Exported Reports B2 |

-

Organize Mew fabder =~ [@ @
B Deskiop *  MName : Date modified Type Size 1'
Dewndoad
- pa || PRO Estract YTD HCPCS Report E/S/2013 219 BM I Test Document 52 K8
&, Recent Places
A Libraries
R * Documents
o Music |=
B videos
& Computer
File name: PRO Extract YTD HCPCS Repart v | TextFiles -
Teols impet |+ [ Cancel |

11. Chose Delimited as the data type on the Text Import Wizard — Step 1 of 3 screen. Click Next.

Text Import Wizard - Step 1 of 3

P J

|1

i

The Text Wizard has determined that your data is Delimited.
1f this is correct, choose Next, or choose the data type that best descoribes your data,
Original data type
Choose the file type that best describes your data:
Q{ﬁ- Delmited - Characters such as commas or tabs separate each field,
) Fixed width - Fields are abgned in columns with spaces between each field,

Srtimportation: [ [5] Feargn: | 65000 Uncode TP

Preview of fie
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12. Under delimiters, uncheck Tab, then check Other and type a caret () as your delimiter on the
Text Import Wizard — Step 2 of 3 screen. Click Next.

Text Import Wizard - Step 2 of 3 |9 o]
This screen lets you set the delimiters your data contains. You can see how your text is affected in the preview
below.

Delirribers

Tab
[7] semicolon [7] Treat consecutive delimiters as one
[T comma
Text fier: | "

A poce e =]

Viother: | 4

Data preview

-
L]

October 2013

Decision Support System V. 3.0 User Manual 127
Patch ECX*3.0%144



13. Text will be chosen as the format for each column on the Text Import Wizard — Step 3 of 3

screen. In the Data Preview section of the screen, click to highlight the column and select Text as

the data format. (Note: All columns can be selected at once if the first column is selected and
then hold the shift key and move the scroll bar to the far right and select the last column). Click
Finish after each column has been formatted.

Text Import Wizard - Step 3 of 3

P

1 General

Data preview

This screen lets you select each column and set the Data Format.

Column data format

‘General converts numeric values to numbers, date values to dates, and all
remaining values to text.

o [1

_) Do not import column (skip)

Note: When each column has been formatted, the
column heading changes from General to Text.

SR SRE

NEW R4300
MEW R4301
HEW PR4363
MEW Rd4des
MEW R44B1

CATH IMPL WASC RCCESS PORT
IMPLANTRBLE ARCCESS S5YST FE
O5TOMY CLAMP, REFLACEMENT
ELASTIC GRARMENT/COVERING
TRACHEOSTOM2 FILTER

14. Click OK when the Import Data screen appears.

-

Import Data

o S|

@ Existing

Where do you want to put the data?

! Mew worksheet

warksheet:

l Properties...

I[ ]9 ]I Cancel I
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15. The report will be created and displayed in Excel.

A
REPORT TYPE
MNEW
MNEW
MNEW
MNEW
MNEW
MNEW

October 2013

PSAS HCPCS

= D E F G H I
QTY COM TOTAL COM AVECOM QTY VA TOTALWVA AVEWA QTY LABE

A4265 PARAFFIN 63 145532 21.40 0 0 0 0
A4300 CATH IMPL VASC ACCESS PORT 1 310 310.00 0 0 0 0
A4301 IMPLANTABLE ACCESS SYST PE 22 9787 444.86 0 0 0 0
A4363 OSTOMY CLAMP, REPLACEMENT 21 a5 2.14 0 0 0 0
A4466 ELASTIC GARMENT/COVERING 85 1754.43  20.64 0 0 0 0
A44381 TRACHEOSTOMA FILTER 28 232 8.29 0 0 0 0
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